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Addresses
Change an Object's E-mail Address
Change an AFP Server's Network Address
Change a Computer's Network Address
Change a NetWare Server's Network Address
Change a Print Server's Network Address
Change a Printer's Network Address
Change a User's Network Address
Change an Object's Postal Address



Change an Object's E-mail Address

To add an address
1. Select the object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Identification" page button.
4. Type the E-mail address in the "E-mail Address" box.
5. (Optional) To add more than one address:

5a. Choose the "More" button.
5b. Choose "Add."
5c. Enter the address in the "E-mail Address" box.

Repeat Steps 5a through 5c for each address that you want to add.
6. Choose "OK."
To change an address
1. Select the object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Identification" page button.
4. Select the address you want to change in the "E-mail Address" box.

If the address you want to change isn't shown, choose the arrows next to this box until the address 
appears.

5. Choose "OK."
To delete an address
1. Select the object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Identification" page button.
4. In the "E-mail Address" box, delete the address you want.

If the address you want to delete isn't shown, choose the arrows next to the box until the address 
appears.



Change an AFP Server's Network Address

To add or change an address
Note: To change an AFP Server's address, you must first delete the address; then enter a new address.
1. Select the AFP Server object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Network Addresses" page button.
4. Choose a network protocol from the "Network Protocol" field.
5. Choose "Add."
6. Type the address in the "Network" field.
7. Choose "OK."
To delete an address
1. Select the AFP Server.
2. Choose "Details" from the "Object" menu.
3. Choose the "Network Addresses" page button.
4. Select the address you want to delete.
5. Choose "OK."



Change a Computer's Network Address

To add or change an address
Note: To change a Computer's address, you must first delete the address; then enter a new address.
1. Select the Computer object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Network Addresses" page button.
4. Choose the network protocol from the "Network Protocol" field.
5. Choose "Add."
6. Type the address in the "Network "field."
7. Choose "OK."
To delete a network address
1. Select the Computer object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Network Addresses" page button.
4. Select the address you want to delete.
5. Choose "Delete."



Change a NetWare Server's Network Address

To add or change an address
Note: To change a NetWare Server's address, you must first delete the address; then enter a new 
address.
1. Select the NetWare Server.
2. Choose "Details" from the "Object" menu.
3. Choose the "Network Addresses" page button.
4. Choose the network protocol from the "Network Protocol" field.
5. Choose "Add."
6. Enter the address in the "Address" box.
7. Choose "OK."
To delete an address
1. Select the NetWare Server.
2. Choose "Details" from the "Object" menu.
3. Choose the "Network Addresses" page button.
4. Select the address you want to delete.
5. Choose "Delete."



Change a Print Server's Network Address

To add an address
1. Select the Print Server object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Identification" page button.
4. Type the address in the "Network Address" box.
5. (Optional) To add more than one address:

5a. Choose the "More" button.
5b. Choose "Add."
5c. Enter the network address.
5d. Choose "OK."

Repeat Steps 5a through 5d for each address you want to add.
6. Choose "OK."
To change an address
1. Select the Print Server object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Identification" page button.
4. Select the address you want to change in the "Network Address" box.

If the address you want to change isn't shown, choose the arrows next to the box until the address 
appears.

5. Type the address.
Use the <Backspace> or <Delete> keys to delete the old address.

6. Choose "OK."
To delete an address
1. Select the Print Server object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Identification" page button.
4. Delete the address in the "Network Address" box.

If the address you want to delete isn't shown, choose the arrows next to the box until the address 
appears.



Change a Printer's Network Address

To add an address
1. Select the Printer object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Identification" page button.
4. Type the address in the "Network Address" box.
5. (Optional) To add more than one address:

5a. Choose the "More" button. 
5b. Choose "Add."
5c. Type the network address.
5d. Choose "OK."

Repeat Steps 5a through 5d for each address you want to add.
6. Choose "OK."
To change an address
1. Select the Printer object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Identification" page button.
4. Select the address in the "Network Address" box.

If the address you want to change isn't shown, choose the arrows next to the box until the address 
appears.

5. Type the address.
Use the <Backspace> or <Delete> keys to delete the old address.

6. Choose "OK."
To delete an address
1. Select the Printer object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Identification" page button.
4. Delete the address in the "Network Address" box.

If the address you want to delete isn't shown, choose the arrows next to the box until the address 
appears.



Change a User's Network Address

To add an address
1. Select the User object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Environment" page button.
4. Type the address in the "Network Address" box.
5. (Optional) To add more than one address:

5a. Choose the "More" button. 
5b. Choose "Add."
5c. Enter the network address.
5d. Choose "OK."

Repeat Steps 5a through 5d for each address you want to add.
6. Choose "OK."
To change an address
1. Select the User object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Environment" page button.
4. Select the address in the "Network Address" box.

If the address you want to change isn't shown, choose the arrows next to the box until the address 
appears.

5. Type the address.
Use the <Backspace> or <Delete> keys to delete the old address.

6. Choose "OK."
To delete a network address
1. Select the User object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Environment" page button.
4. Delete the address in the "Network Address" box.

If the address you want to delete isn't shown, choose the arrows next to the box until the address 
appears.



Change an Object's Postal Address

To add or change an address
1. Select the object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Postal Address" page button.
4. Type the appropriate information.
5. (Optional) If you want the postal address information to automatically appear in the "Mailing Label" 

field, choose "Set Address."
6. Choose "OK."



Attributes and Rights
Change the Attributes of a File or Directory
Change the IRF of a File or Directory
View an Object's Effective Property Rights to another Object
View an Object's Effective Rights to another Object
View an Object's Effective Rights to a File or Directory



Change the Attributes of a File or Directory

To change the attributes of a file
1. Select a file.
2. Choose "Details" from the "Object" menu.
3. Choose the "Attributes" page.
4. Select check boxes for attributes that you want to set for this file.
5. Choose "OK."
To change the attributes of a directory
1. Select a directory.
2. Choose "Details" from the "Object" menu.
3. Choose the "Attributes" page.
4. Select check boxes for attributes that you want to set for this directory.
5. Choose "OK."



Change the IRF of a File or Directory

To change the IRF of a file
1. Select a file.
2. Choose "Details" from the "Object" menu.
3. Choose the "Trustees of this File" page button.
4. In the "Inheritance Filter" field, select check boxes for rights that you want to allow to be inherited for 

that file.
Rights that are not checked cannot be inherited.

5. Choose "OK.
To change the IRF of a directory
1. Select a directory.
2. Choose "Details" from the "Object" menu.
3. Choose the "Trustees of this Directory" page button.
4. In the "Inheritance Filter" field, select check boxes for rights that you want to allow to be inherited for 

that directory.
Rights that are not checked cannot be inherited.

5. Choose "OK.



View an Object's Effective Property Rights to another Object
1. Select the object that you want to see another object's property rights to.

Example: If you want to see the property rights User ANDREW has to Printer LASER, choose 
LASER in this step. 

2. Choose "Trustees of this Object" from the "Object" menu.
3. Choose the "Effective Rights" button.

4. Choose the "Select object" icon. 
5. Select the object whose effective property rights to the object selected in Step 1 you want to see.
6. Choose "OK" in the "Select Object" dialog.

The effective rights of the selected object to all properties are shown in bold.
7. To see the effective property rights for a specific property, select the "Selected Properties" button; 

then choose a property from the list.
The effective property rights for that individual property are bold.

8. Choose "Close" in the "Effective Rights" dialog.
9. Choose "OK."



View an Object's Effective Rights to another Object
1. Select the object that you want to see another object's effective rights to.

Example: If you want to see the effective rights User ANDREW has to Printer LASER, choose 
LASER in this step. 

2. Choose "Trustees of this Object" from the "Object" menu.
3. Choose the "Effective Rights" button.

4. Choose the "Select object" icon. 
5. Choose the object whose effective rights to the object selected in Step 1 you want to see.
6. Choose "OK" in the "Select Object" dialog.

The effective rights of the selected object are shown in bold.
7. Choose "Close" in the "Effective Rights" dialog.
8. Choose "OK" in the "Trustees" dialog.



View an Object's Effective Rights to a Directory or File

To view an object's effective access rights to a directory
1. Select a directory.
2. Choose "Details" from the "Object" menu.
3. Choose the "Trustees of this Directory" page button.
4. Choose the "Effective Rights" button.

5. Choose the "Select object" icon. 
6. Select the object whose effective rights to this directory you want to see.
7. Choose "OK" in the "Select Object" dialog.
8. Choose "OK."
To view an object's effective access rights to a file
1. Select a file.
2. Choose "Details" from the "Object" menu.
3. Choose the "Trustees of this File" page button.
4. Choose the "Effective Rights" button.

5. Choose the "Select object" icon. 
6. Select the object whose effective rights to this file you want to see.
7. Choose "OK" in the "Select Object" dialog.
8. Choose "OK."



Directories and Files
Add or Delete a Trustee
Change the Attributes of a Directory or File
Change the Current Context
Change the IRF of a Directory or File
Change the Owner of a Directory or File
Create a Directory
Purge a File
Salvage a File
Set the Preferred Name Space
View an Object's Effective Rights to a Directory or File
View Information about a Directory
View Information about a File



Change the Owner of a File or Directory
1. Select a file or directory.
2. Choose "Details" from the "Object" menu.
3. Choose the "Facts" page button.

The owner is listed on the "Facts" page.

4. Choose the "Select Object" icon. 
5. Choose the object that you want to be the new owner of this file or directory.
6. When the correct object is displayed in the "Object name" field, choose "OK."

The new owner appears in the "Owner" field
7. Choose "OK."



Create a Directory
1. Choose the directory or volume that will be the parent of the directory you want to create.
2. Choose "Create" from the "Object" menu.
3. From the list of objects, select "Directory."
4. Choose "OK."
5. In the "Directory name" box, type the name for the new directory.
6. (Optional) To define additional information about this directory right now, select "Define Additional 

Properties."
You cannot select this if you select "Create Another Directory."

7. (Optional) To create another directory immediately after this one, select "Create Another Directory."
You cannot select this if you select "Define Additional Properties."

8. Choose "Create."
If you selected "Define Additional Properties," the directory object dialog appears.
If you selected "Create Another Directory," this dialog appears again.

9. Choose "Create."
The new directory is created.



Purge a File
1. Select the directory that contains the file that you want to purge.

If the directory containing the file was also deleted, select any directory.
2. Choose "Salvage" from the "Object" menu.
3. Select the file that you want to permanently delete.

If the file was in a directory that was deleted, choose "Deleted Directories" in the "Source Option" 
field. If the file does not appear, check that the "Include" field includes the file's pattern in its file 
specification.

4. Choose "Purge."
5. Choose "OK."



Salvage a File
1. Select the directory that contained the file that you want to salvage.

If the directory containing the file was also deleted, select any directory.
2. Choose "Salvage" from the "Object" menu.
3. Select the file that you want to salvage.

If the file was in a directory that was deleted, choose "Deleted Directory" in the "Source Option" field. 
If the file does not appear, check that the "Include" field includes the file's pattern in its file 
specification.

4. Choose "Salvage."
The file will now appear in regular directory searches and can be used by applications.

5. Choose "OK."



View Information about a Directory
1. Select a directory.
2. Choose "Details" from the "Object" menu.
3. Choose the page button for the information you want to see about this directory.



View Information about a File
1. Select a file.
2. Choose "Details" from the "Object" menu.
3. Choose the page button for the information you want to see about this file.



Logging In
Create or Change a Profile Login Script
Create or Change a System Login Script
Create or Change a User Login Script
Prevent a User from Logging In
Set Login Restrictions



Login Scripts
Create or Change a Profile Login Script
Create or Change a System Login Script
Create or Change a User Login Script



Create or Change a Profile Login Script
1. Select the Profile object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Login Script" page button.
4. Type the login script commands you want.
Note: When you have made all necessary changes to the pages of this dialog, choose "OK."



Create or Change a System Login Script
1. Select the Organizational Unit.
2. Choose "Details" from the "Object" menu.
3. Choose the "Login Script" page button.
4. Type the login script commands you want.
Note: When you have made all necessary changes to the pages of this dialog, choose "OK."



Create or Change a User Login Script
1. Select the User object.
2. Choose "Details" from the"Object" menu.
3. Choose the "Login Script" page button.
4. Type the login script commands you want.



Objects
To perform a task on an object, choose that object. The object dialog will appear. You can do most tasks 
in the object dialog. For help while using the object dialog, choose "Help."

Add or Delete a Trustee of an Object
Change an Object's IRF
Create an Object
Find Objects Associated with an Object
Include Certain Object Classes in the Browser
Rename an Object



Change an Object's IRF
1. Select an object.
2. Choose "Trustees of this Object" from the "Object" menu.
3. Choose the "Inherited Rights Filter" page button.
4. Select check boxes for rights that you want to allow to be inherited.

If the check box by a right is not marked, that right cannot be inherited. To change the Inherited Rights
Filter for specific property rights, you must also choose "Specific Property" and select a property from 
the "Properties" list.

5. Choose "OK."



Create an Object
1. Select the container that you want the object created under.
2. Choose "Create" from the "Object" menu.
3. Select the type of object you want to create from the list of objects.
4. Choose "OK."

Choose the Help button in the dialog for more information.



Find Objects Associated with an Object
1. Select the object.
2. Choose "Details" from the "Object" menu.
3. Choose the "See Also" page button.
4. Choose "Add . . ."
5. Choose the object you want associated with the object you selected in Step 1.
6. Choose "OK" to close the "Select Object" dialog.
7. Choose OK."



Rename an Object
1. Select the object you want to rename.
2. Choose "Rename" from the "Object" menu.
3. Type the new name for the object.
4. (Optional) To save the old name in the "Other name" field, select "Save old name."
5. Choose "OK."



Navigation
Move up a Level in the Browser
Move down a Level in the Browser
Open Additional Browser Windows



Partition
Create a Partition
Merge Partitions
Rebuild a Replica
View or Edit a Replica



Create a Partition
1. Choose "Partition Manager" from the "Tools" menu.
2. Select the container object that you want to be the root object of the new partition.
3. Choose "Create Partition."



Merge Partitions
1. Choose "Partition Manager" from the "Tools" menu.
2. Select the container object that is the root of the partition that you want to merge with its parent.

You must select a container that has a partition icon to the left. The [Root] partition cannot be merged,
because it is the top partition.

3. Choose "Merge."



Rebuild a Replica
1. Choose "Partition Manager" from the "Tools" menu.
2. Select the container that is the root object of the partition that you want to fix.
3. Choose "Rebuild Replicas."



View or Edit a Replica
1. Choose "Partition Manager" from the "Tools" menu.
2. Select the container that is the root object of the partition whose replicas you want to see.
3. Choose "Replicas."



Passwords
Allow Users to Change Passwords
Create or Change a Password
Set Password Restrictions



Allow Users to Change Passwords
1. Select a User object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Password Restrictions" page button.
4. Select the "Allow user to change password" check box.



Create or Change a Password
1. Select the User object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Password Restrictions" page button.
4. Choose "Change Password."
5. Type the old password in the "Old Password" box.
6. Type the new password in the "New Password" box.
7. Type the new password again in the "Retype Password" box.
8. Choose "OK."



Set Password Restrictions
1. Select the User object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Password Restrictions" page button.
4. Set the restrictions you want.

Note: For more information, choose the dialog's Help button.
5. Choose OK.



Printing
Assign Printers to Print Servers
Assign Queues to Printers
Create a Print Queue
Create a Print Server
Create a Printer
Control a Printer
Monitor Print Job Status



Assign Printers to Print Servers
1. Select a Printer.
2. Choose "Details" from the "Object" menu.
3. Choose the "Connections" page.
4.  When you have modified everything you want, choose "OK" to return to the Browser.



Assign Queues to Printers
1. Select a Printer object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Connections" page.
4.  When you have modified everything you want, choose "OK" to return to the Browser.



Monitor Print Job Status
1. Select a Printer object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Printer Status" button.



Control a Printer
1. Select a Printer object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Printer Status" button.
4.  When you have modified everything you want, choose "OK" to return to the Browser.



Create a Print Queue
1. Select a context from the Browser.
2. Choose "Create" from the "Object" menu.
3. Choose "Queue" from the "Object class" list.
4. Choose "OK."
5.  When you have modified everything you want, choose "OK" to return to the Browser.



Create a Print Server
1. Select a context from the Browser.
2. Choose "Create" from the "Object" menu.
3. Choose "Print Server" from the "Object class" list.
4. Choose "OK."
5.  When you have modified everything you want, choose "OK" to return to the Browser.



Create a Printer
1. Select a context from the Browser.
2. Choose "Create" from the "Object" menu.
3. Choose "Printer" from the "Object class" list.
4. Choose "OK."
5.  When you have modified everything you want, choose "OK" to return to the Browser.



Search
Search for an Object or Property
Search Object Classes



Security
Allow Users to Change Passwords
Change the IRF of a Directory or File
Change the Attributes of a Directory or File
Create or Change a Password
Limit the Number of Workstations a User Can Log In To
Prevent a User from Logging In
Set Login Restrictions
Set Password Restrictions
View an Intruder's Address



View an Intruder's Address
If a User's account is locked because an intruder attempted to access it, you can see the address of the 
intruder.
1. Select the User object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Intruder Lockout" page button.

The information is in the "Intruder Address" field.



Prevent a User from Logging In
1. Select the User object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Login Restrictions" page button.
4. Check the "Account Disabled" box.
5. Choose "OK."

The User won't be able to log in again until you reset the "Account Disabled" box.



Trustees
Add or Delete a Trustee of a File or Directory
Add or Delete a Trustee of an Object
Modify a Trustee's Rights to a File or Directory
Modify the Object Rights of a Trustee
Modify the Property Rights of a Trustee



Add or Delete a Trustee of a File or Directory

To add a trustee
1. Select the directory or file that you want to grant the trustee access to.
2. Choose "Trustees of this Object" from the "Object" menu.
3. Choose "Add Trustee."
4. Select an object to be the trustee.
5. Choose "OK."

The object that you chose is added as a trustee.
6. Grant rights to the new trustee by selecting the check boxes below the "Trustee" list.

Rights with a check in front of them are granted to the trustee.
To delete a trustee
1. Select the directory or file whose trustees you want to view.
2. Choose "Trustees of this Object" from the "Object" menu.
3. Select the trustee you want to delete.
4. Choose "Delete Trustee."

This trustee no longer has explicit rights to this object.



Add or Delete a Trustee of an Object

To add a trustee
1. Select the object that you want to give another object rights to.
2. Choose "Trustees of this Object" from the "Object" menu.
3. Choose "Add Trustee."
4. Select the object you want to add as a trustee.
5. Choose "OK."

The trustee appears in the "Trustees" list.
6. Select check boxes for the rights you want to grant to that object.
7. Choose "OK."
To delete a trustee
1. Select the object for which you want to delete a trustee.
2. Choose "Trustees of this Object" from the "Object" menu.
3. Select the trustee you want to delete.
4. Choose "Delete Trustee."

The deleted trustee no longer has explicit rights to this object.
5. Choose "OK."



Change a Trustee's Rights to a File or Directory

To change a trustee's rights to a file
1. Select the file for which you want to change a trustee's rights.
2. Choose "Details" from the "Object" menu.
3. Choose "Trustees of This File."
4. Select the trustee whose rights you want to change from the "Trustees" list.
5. To grant or revoke rights for this trustee, select the check boxes in the "Access Rights" field.

Boxes that are checked show rights that this trustee has to this file.
6. Choose "OK."

The new rights you assigned to the trustee now take effect.
To change a trustee's rights to a directory
1. Select the directory for which you want to change a trustee's rights.
2. Choose "Details" from the "Object" menu.
3. Choose "Trustees of This Directory."
4. Select the trustee whose rights you want to change from the "Trustees" list.
5. To grant or revoke rights for this trustee, select the check boxes in the "Access Rights" field.

Boxes that are checked show rights that this trustee has to this directory.
6. Choose "OK."

The new rights you assigned to the trustee now take effect.



Modify the Object Rights of a Trustee
1. Select the object for which you want to change the trustee's rights.
2. Choose "Trustees of this Object" from the "Object" menu.
3. Select the trustee whose rights you want to change from the "Trustees" list.
4. To grant or revoke rights for this trustee, select the check boxes in the "Object Rights" field.
5. Choose "OK."

The new rights you assigned to the trustee now take effect.



Modify the Property Rights of a Trustee
1. Select the object for which you want to change the trustee's rights.
2. Choose "Trustees of this Object" from the "Object" menu.
3. Select the trustee whose rights you want to change from the "Trustees" list.
4. To grant or revoke rights for this trustee, select the check boxes in the "Property Rights" field.

To change specific property rights of a trustee, choose the "Specific Property" button and then select 
a property from the "Properties" list.

5. Choose "OK."
The new rights you assigned to the trustee now take effect.



Users and Groups
Change a User's Account Balance
Change a User's Network Address
Create or Modify a User's Login Script
Prevent a User from Logging In
Find Objects Affiliated with a User
Limit the Number of Workstations a User Can Log In To
Add a User to a Group
Delete a User from a Group
Manage a User's Account
Set an Expiration for a User Account
Set Login Restrictions
Create a User Template



Change a User's Account Balance
1. Select the User object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Account Balance" page.
4. Enter information to change the account balance.

Note: For more information, choose the dialog's Help button.
5. Choose OK.



Create User Defaults
You can create User defaults in an Organization or Organizational Unit container object
1. Select the container object under which users will be created
2. Choose "User Template" from the "Object" menu.
3. Select "User" from the list of objects.
4. Choose "OK."
5. Complete the information that you want to apply to all users subsequently created in this container.
6. Choose "OK."

To apply this information to a User that you create in this container, select "Use User Template" in the 
"Create User" dialog.



Limit the Number of Workstations A User Can Log In To
1. Select the User object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Login Restrictions" page button.
4. Select "Limit Concurrent Connections."
5. Enter the number of workstations that a user can log in to simultaneously in "Maximum Connections."
6. Choose "OK."



Add a User to a Group
1. Select the User object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Group Membership" page.
4. Choose "Add. . ."
5. Select the Group that you want to add this User to.
6. Choose "OK" to close the "Select Object" dialog.
7. Choose "OK."



Delete a User From a Group
1. Select the User object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Group Membership" page button.
4. Select the Group from which you want to delete this User.
5. Choose "Delete."
6. Choose "OK."



Manage a User's Account
1. Select the User object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Account Balance" page button.
4. To change the account balance, enter a new number in the "Account Balance" box.
5. To allow the User unlimited credit, select "Allow Unlimited Credit."



Set Login Restrictions
1. Select the User object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Login Restrictions" page button.
4. To prevent a User from logging in, select "Account Disabled."
5. To make the account expire at a certain time, select "Account Has Expiration Date."

5a. To change the day the account expires, highlight the month, day, or year, then use the arrows 
next to the field to change that part of the date.

5b. To change the time the account expires, highlight the hour, minute, or second, then use the 
arrows next to the field to change that part of the time.

6. To limit the number of workstations a User can log in to simultaneously, select "Limit Maximum 
Connections," then enter the number in the "Maximum Connections" box.



Set an Expiration for a User Account
1. Select the User object.
2. Choose "Details" from the "Object" menu.
3. Choose the "Login Restrictions" page button.
4. Select "Account has expiration date."
5. To change the day the account expires, highlight the month, day, or year, then use the arrows next to 

the field to change that part of the date.
6. To change the time the account expires, highlight the hour, minute, or second, then use the arrows 

next to the field to change that part of the time.
7. Choose "OK."



Using Partition Manager
Partition Manager allows you to manage your partitions and their replicas
The Partition Manager main window is similar to a Browser window. Only container objects and NetWare 
Server objects are shown. Containers that are the root of a separate partition are red and show the 
partition icon to the left. NetWare Server objects are blue. Different buttons are active when different 
objects are selected in the main window.

Procedures
Create a New Partition
Merge Partitions
View or Modify Replicas
View Partitions on a Server
Delete a NetWare Server Object
Abort Partition Operation

Screen regions and buttons
"Context" shows your current context in the Directory tree.

"Partitions" lists partitions in the current context and allows you to view other partitions. Objects that 
are partition roots are marked with the partition icon.

"Create as New Partition" divides an existing partition to create a new partition. The selected object 
becomes the root of the new partition, and a Master replica of the new partition is created on the 
server where the Master replica of its parent partition is located.

"Merge Partitions" merges a partition with its parent partition, leaving a single partition. All replicas are
merged as well. You must select a partition below the [Root] of the tree to choose this option.

"Replicas" allows you to add, delete, view, or modify the existing replica types for the selected 
partition.

"Server Partitions" lists replicas stored on the selected NetWare Server. You must select a NetWare 
Server object before this option is available.

"Abort Partition Operation" stops the operation you have begun (you have either begun to create a 
new partition or merge a partition with its parent partition) and reverses any operations that have 
begun.

"Delete Server" deletes a NetWare Server object and all its associated information, including its 
partitions and replicas. 

"Close" closes this dialog and returns to the main window of the NetWare Administrator.



Create a New Partition
When you create a new partition, you divide an existing partition into two separate partitions. No object in 
the tree can be a part of more than one partition at the same time.

To create a new partition
1. Select a container object that is not already a partition root (shows no icon to the left) from the list 

box.
2. Choose "Create as New Partition." 

The container object is now the root object of a new partition and is marked with the partition icon. A 
Master replica of the new partition is created and stored on the same server as the Master replica of 
the parent partition.



View or Modify Replicas
This dialog box allows you to view existing replicas of the selected partition. You can change the type of 
any replica, add new replicas on other NetWare Servers, or delete replicas.

Procedures
Add a Replica
Delete a Replica
Change the Type of an Existing Replica
Rebuild Replicas
Send Updates
Receive Updates

Screen regions and buttons
"Partition" lists the current partition whose replicas you are viewing. If you are viewing replicas of the 

[Root] partition, no object is displayed here.

"Master Replica" lists the NetWare Server object where the Master replica of this partition is stored.

"Server" lists the other NetWare Servers where replicas of this partition are stored.

"Types" lists the replica type of each of the existing replicas of this partition.

"Add Replica" allows you to add a replica of this partition, storing it on a NetWare Server that does not
already have a replica of this partition.

"Delete Replica" deletes the selected replica. You cannot delete the replica that is of type "Master."

"Change Type" changes the replica type of the selected replica.

"Rebuild Replicas" replaces data in a replica with data from the Master replica of the same partition. 

"Send Updates" sends updated information from the replica you select to all the other replicas of the 
partition.

"Receive Updates" allows the replica you select to receive updated information from all the replicas of
the partition.

"Close" saves changes and returns to the list of partitions.



Add a Replica
1. Choose "Add replica."
2. Select the NetWare Server object that you want this replica to be stored on.

Only NetWare Servers that do not have a replica of this partition will be listed to choose from.
3. Select a Replica Type.

For most replicas, Read Write should be used. Read Write replicas can be written to. They send out 
information for synchronization when a change has been made. Read Only replicas cannot be written 
to. They are, however, updated when the replicas synchronize.

4. Choose "OK."
The new replica is created, and you return to the list of replicas of this partition.



Change the Replica Type
1. Select the replica whose type you want to change.

Note: You cannot change the type of the Master replica. To specify a new Master replica, change the 
type of an existing Read Write replica to Master, and the Master replica will automatically be changed 
to Read Write.

2. Choose "Change Type."
3. Select a Replica Type.

For most replicas, Read Write should be used. Read Write replicas can be written to. They send out 
information for synchronization when a change has been made. Read Only replicas cannot be written 
to. They are, however, updated when the replicas synchronize.

4. Choose "OK."
The replica type is changed as you specified. You return to the list of replicas of this partition.



Replica Types

Master
There can only be one Master replica per partition.    If the Master replica is lost or destroyed, you need to 
change one of the existing replicas to make it the Master.
The Master replica is accessed when 
- A replica is added or deleted
- A partition is merged
- A new partition is created
Note: If a valid Master replica exists, you cannot change the type of the Master replica. To specify a new 
Master replica, change the type of an existing Read Write partition to Master, and the Master replica will 
automatically be changed to Read Write.

Read Write
Read Write replicas can be written to.    They send out information for synchronization when any change 
is made to an object or its properties. The first replica created when you create a new partition is a Master
replica. By default, new replicas that you create after that are Read Write replicas.

Read Only
Read Only replicas cannot be written to.    They provide information to users and are updated with 
changes from Read Write and Master replicas when the replicas synchronize, but they do not accept 
changes. A user who was reading information from a Read Only replica and tried to make a change would
have to wait while a Read Write replica was located on another server.



Delete a Replica
Deleting a replica deletes a copy of part of the Directory database. The database can still be accessed on
other servers in the network, and the server that the replica was on still functions in NetWare Directory 
Services.
Deleting a NetWare Server deletes the replicas that were on that NetWare server and also removes the 
server from NetWare Directory Services so that Users cannot use the NetWare server or its Volumes.

To delete a replica
1. Select the replica that you want to delete.

Note: You cannot delete the Master replica. If you need to delete the Master replica because it is 
corrupted, first make a different replica the Master replica by selecting it and changing its type to 
Master. The Master replica will automatically be changed to Read Write.

2. Choose "Delete Replica."
The selected replica is deleted from the NetWare Server where it was stored. Users who are attached
to that NetWare Server and need information from objects in this partition will now have to cross the 
network to another NetWare Server that contains a replica of this partition.

3. Choose "OK."
You return to the list of partitions.



Merge a Partition
When you merge a partition, the selected partition is combined with its parent partition.
No object in the Directory tree can be a part of more than one partition at the same time.
You do not delete partitions. That would be like deleting objects from the Directory tree. You only merge 
and create partitions to define how the Directory tree is split into parts.

To merge a partition
1. Select the partition you want to merge with its parent.

You must select a container object that has the partition icon to the left and is red. [Root] cannot be 
merged because it is the top partition; it has no parent to merge with.

2. Choose "Merge Partitions."
All existing replicas of the selected partition are merged with the existing replicas of the parent 
partition. The selected container is no longer the root of a separate partition. This action make take a 
few minutes.



View Server Partitions
This dialog displays which partitions have replicas stored on the selected server. Each partition is 
specified by the complete name of its root object. 
This information allows you to see how many of this NetWare Server's resources are used by partition 
replicas, and how far across the network Users might need to go to find certain parts of the Directory 
database.
The data in this dialog cannot be changed. To change replicas, select a partition in the previous dialog, 
then choose "Replicas."
You cannot see the type of each replica from this dialog.



Delete a Server Object
Use this option to delete NetWare Server objects from the Directory tree.
You must use the Partition Manager to delete NetWare Server objects so that you can avoid deleting a 
NetWare Server where the only replica of a part of the Directory tree is stored.
A NetWare Server must be down or you cannot delete its object. If you delete a NetWare Server, the only 
way to get it back is to reinstall it using the INSTALL.NLM program at the server console, or create the 
object again using the menus after bringing the server back up.



Rebuild Replicas
Warning!
This operation may cause degraded network performance and loss of Directory Services information. This
operation forces a synchronization of all the replicas of the selected partition.
The synchronization operation creates substantial Directory Services network traffic until all replicas of the
partition are synchronized. Additionally, during synchronization, services provided by some replicas will be
unavailable.
You should only choose this operation if you are receiving (-659) or (FD6D) errors from DSTRACE.NLM 
and Partition Manager, respectively.
Please take the following precautions before synchronizing the replicas using the Rebuild Replicas option:
1. Reduce the number of total replicas, including the master, to two or three.
2. Make sure that the replicas you have selected are not located across a WAN.
3. Using the DSTRACE.NLM utility, verify that all previous synchronization operations are complete.

Rebuild Replicas allows you to rebuild corrupted replicas with Directory Services information from the 
Master replica, which is considered the source of the most correct and latest information.

To rebuild replicas
1. Select a partition.
4. Choose "Rebuild All Replicas."

You don't have to select any replicas. By default, the Read/Write and Read Only replicas of the 
partition are deleted and rebuilt with Directory Services information from the Master replica.

5. Choose "OK."
You return to the list of partitions.



Abort Partition Operation
If you select Yes, the operation you have begun (you have either begun to create a new partition or merge
a partition with its parent partition) will be aborted. If you are creating a new partition, it will be merged 
back in with its parent partition. If you are merging a partition with its parent partition, it will become a 
separate partition again.
If you select No, the operation you have begun (you have either begun to create a new partition or merge 
a partition with its parent partition) will continue and you will be returned to the Partition Management 
menu.



Send Updates
If    you select Yes, the selected replica will send updated information to all the other replicas of the 
partition. 
You would want to select Yes if one or more of the other replicas had lost information, or if you had 
updated the selected partition and wanted to transfer that information to all the other replicas.
Note:    This operation may create a lot of network traffic, so it is best to run this operation during a period 
of light network traffic.    
If you select No, your current replica will not send updated information to all the replicas of the partition 
and you will be returned to the Replica Management menu.



Receive Updates
If you select Yes, the selected replica will receive updated information from all the replicas of the partition. 
You would want to select Yes if the selected replica had lost information or had not received updated 
information for an extended period of time.
Note:    This operation may create a lot of network traffic, so it is best to run this operation during a period 
of light network traffic.
If you select No, the selected replica will not receive updated information from all the replicas of the 
partition and you will be returned to the Replica Management menu.



Dialog Index

Menu items
Browser
Partition Manager
Salvage
Search

Object dialogs
User Details
File Details
NetWare Server Details
Volume Details
Profile Details
Directory Map Details
Alias Details
Directory Details
Computer Details
Organizational Role Details
Group Details
Country Details

Create
Create User
Create Volume
Create NetWare Server
Create Directory Map
Create Alias
Create Profile
Create Directory
Create Computer
Create Organization
Create Organizational Role
Create Organizational Unit
Create Group
Create Country

Access Control (Trustees)
Trustees of Container Objects
Trustees of Leaf objects
Rights to Other Objects
Trustees of Files and Directories



View or Change Trustees of this Object
The "Trustees of this Object" option lists trustees of this container object and their rights. When you select
a trustee from the list, that trustee's rights to this object appear below the list.
Note: The "Trustees" list does not list Users who inherit rights to this object. To check for those objects, 
choose "Effective Rights."
To close the "Trustees of this Object" dialog and save changes, choose "OK."
To close the "Trustees of this Object" dialog without saving changes, choose "Cancel."

Procedures
Add a Trustee
Delete a Trustee
See the Effective Rights of an Object
View or Change the Inherited Rights Filter
Change the Object Rights of a Trustee
Change the Property Rights of a Trustee

Screen regions and buttons
"Trustees" lists all trustees of this object.

"Effective rights" are the actual rights that any object has to this object.

"Add trustee" adds a new trustee to the "Trustees" list.

"Delete trustee" deletes a trustee from the "Trustees" list.

"Object Rights" lets you view or change a trustee's object rights.

"Property Rights" lets you view or change a trustee's property rights.

"Clear" resets all rights in the list to undefined for the selected trustee.

"Inherited Rights Filter" lets you view or change this object's Inherited Rights Filter

"OK" saves changes and closes the dialog.

"Cancel" closes the dialog without saving changes.

Related topics
Trustees of this Object and Rights to Other Objects
Trustees of the Root Object in the Directory Tree



View or Change Trustees of this Object
The "Trustees of this Object" option lists trustees of this object and their rights. When you select a trustee 
from the list, that trustee's rights to this object appear below the list.
Note: The "Trustees" list does not list Users who inherit rights to this object. To check for those objects, 
choose "Effective Rights." 
To close the "Trustees of this Object" dialog and save changes, choose "OK."
To close the "Trustees of this Object" dialog without saving changes, choose "Cancel."

Procedures
Add a Trustee
Delete a Trustee
See the Effective Rights of an Object
View or Change the Inherited Rights Filter
Change the Object Rights of a Trustee
Change the Property Rights of a Trustee

Screen regions and buttons
"Trustees" lists all trustees of this object.

"Effective rights" are the actual rights that any object has to this object.

"Add trustee..." adds a new trustee to the "Trustees" list.

"Delete trustee" deletes a trustee from the "Trustees" list.

"Object Rights" lets you see or change a trustee's object rights.

"Property Rights" lets you see or change a trustee's property rights.

"Clear" resets all rights in the list to undefined for the selected trustee.

"Inherited Rights Filter" lets you view or change this object's Inherited Rights Filter.

"OK" saves changes and closes the dialog.

"Cancel" closes the dialog without saving changes.

Related topics
Trustees of this Object and Rights to Other Objects
Trustees of the Root Object in the Directory Tree



Add a Trustee to this Object
1. Choose "Add trustee...."

You need the Write property right to the ACL property of an object to add trustees.
2. Select the objects you want to add to the list of trustees for this object.

If you have only the Add Self property right to the ACL property, your User object will be added as a 
trustee; the "Select Object" dialog will not appear.

3. Choose "OK."
The objects that you selected are added to the "Trustees" list.

Note: To grant rights to the trustee to work with this object , select the check boxes below the "Trustees" 
list.



Delete a Trustee of this Object
1. Select the trustee that you want to delete from the "Trustees" list.
2. Choose "Delete trustee."

You need the Write property right to the ACL property of an object to delete trustees.
If you have only the Add Self property right to the ACL property of this object, "Delete trustee" will only
be available when your User object is selected from the list of trustees.

3. Choose "Yes."
The User that you deleted from the "Trustees" list will have rights to this object only by inheriting them
from other objects that are trustees, such as by membership in a Group that is a trustee of this object.

You cannot delete a trustee from the list if
- It is the only trustee of this object with Supervisor object right, and
- The object's Inherited Rights Filter blocks the Supervisor object right.
You must first grant another trustee the Supervisor object right, or make sure the Inherited Rights Filter 
doesn't block the Supervisor object right. This attempts to prevent you from cutting off Supervisor-level 
access to part of the Directory tree.
Note: You can delete the User object that is the only trustee listed as supervisor for an area. This will 
effectively cut off Supervisor-level access to that part of the Directory tree. Be careful when deleting User 
objects.



View or Change the Inherited Rights Filter of this Object
1. To change the Inherited Rights Filter for certain properties only, select "Selected Properties" and then 

the individual property to modify.
You need the Write property right to the ACL property of an object to change its Inherited Rights Filter.

2. To remove the Inherited Rights Filter so that all rights can be inherited, choose "Clear."
3. To change the Inherited Rights Filter for all properties of this container object, select "All Properties."

You can also set an IRF for a specific property. Properties in the list that have an IRF set are black; 
others are gray.

4. Select the check box next to any object right or property right that you want to change.
If the boxes are grey, no Inherited Rights Filter exists for this object or the selected set of property 
rights. All rights can be inherited by any trustee.
If a box is white (not checked), that right cannot be inherited by a trustee with a trustee assignment 

above this point.
If a box is marked (X), that right can be inherited.
Note: You cannot leave the Supervisor object right unmarked unless a trustee of this object has the 
Supervisor right.

5. Choose "OK."
You return to the "Trustees of this Object" dialog.

More about the Inherited Rights Filter



View or Change the Inherited Rights Filter of this Object
1. To change the Inherited Rights Filter for certain properties only, select "Selected Properties" and then 

the individual property to modify.
You must have at least the Write property right to the ACL property of an object to change its Inherited
Rights Filter.

2. To change the Inherited Rights Filter for all properties of this object, select "All Properties."
You can also set an IRF for a specific property. Properties in the list that have an IRF set are black; 
others are gray.

3. To remove the Inherited Rights Filter so that all rights can be inherited, choose "Clear Filter."
4. Select the check box next to any object or property right that you want to change.

If the boxes are grey, no Inherited Rights Filter exists for this object or the selected set of property 
rights. All rights can be inherited by any trustee.
If a box is white (not checked), that right cannot be inherited by a trustee with a trustee assignment 

above this point.
If a box is marked (X), that right can be inherited.
Note: You cannot leave the Supervisor object right unmarked unless a trustee of this object has the 
Supervisor right.

5. Choose "OK."
You return to the "Trustees of this Object" dialog.

More about the Inherited Rights Filter



See Another Object's Effective Rights to this Object

For another object that is a trustee of this container object
1. From the "Trustees" list, select one trustee.
2. Choose "Effective rights..."

The effective rights of the trustee are shown below the "Object name" field. Effective rights are bold. 
Non-effective rights are grayed.

3. (Optional) To see effective rights to specific properties, choose "Selected Properties" and select a 
property from the list.

4. Choose "Close."
You return to the "Trustees of this Object" dialog.

For another object that is not a trustee of this container object
1. Choose "Effective rights..."

2. Choose the "Browser" icon.
3. Select an object.

Note: To see a User's effective rights to this object, you must manage that User (have rights to that 
User's ACL property.)
The effective rights of the object you selected are shown below the "Object name" field. Effective 
rights are bold. Non-effective rights are grayed.

4. (Optional) To see effective rights to specific properties, choose "Selected Properties" and select a 
property from the list.

5. Choose "Close."
You return to the "Trustees of this Object" dialog.

Note: If you make changes to the "Trustees of this Object" dialog, they will not be reflected in "Effective 
Rights" until you have exited the "Trustees of this Object" dialog with "OK." When you return to the 
"Trustees of this Object" dialog, any previous changes are reflected in "Effective Rights."
More about Effective Rights



See another Object's Effective Rights to this Object

For another object that is a trustee of this leaf object
1. Select a trustee in the "Trustees" list.
2. Choose "Effective rights..."

The effective rights of the trustee are shown below the "Object name" field. Effective rights are bold. 
Non-effective rights are grayed.

3. (Optional) To see effective rights to specific properties, choose "Selected Properties" and select a 
property from the list.

4. Choose "Close."
You return to the "Trustees of this Object" dialog.

For another object that is not a trustee of this leaf object
1. Choose "Effective rights..."

2. Choose the "Browser" icon.
3. Select an object.

Note: To see a User's effective rights to this object, you must manage that User (have rights to that 
User's Access Control List property.)
The effective rights of the object you selected are shown below the "Object name" field. Effective 
rights are bold. Non-effective rights are grayed.

4. (Optional) To see effective rights to specific properties, choose "Selected Properties" and select a 
property from the list.

5. Choose "Close."
You return to the "Trustees of this Object" dialog.

Note: If you make changes to the "Trustees of this Object" dialog, they will not be reflected in "Effective 
Rights" until you have exited the "Trustees of this Object" dialog with "OK." When you return to the 
"Trustees of this Object" dialog, any previous changes are reflected in "Effective Rights."

More about Effective Rights



Change A Trustee's Object Rights to this Object
1. Select a trustee from the "Trustees" list.

Note: You can select multiple trustees by holding down the <Ctrl> or <Shift> keys; any rights that you 
change will affect all selected trustees.
Object Rights with a checkmark (X) denote rights that are granted to the trustee.

2. Select the check box next to any object right that you want to change.
If a box is grayed, see possible reasons below.
If a box is not checked, that right is not granted to the selected trustee.
If a box is marked (X), that right is granted to the selected trustee.
Note: If this trustee has the Supervisor object right, you cannot remove it unless another trustee also 
has the Supervisor object right to this object, or the Inherited Rights Filter allows other objects to 
inherit the Supervisor object right.

3. To reset all object rights to undefined (not granted), choose "Clear."
If you clear these rights, and no other rights are granted, the selected trustee is deleted from the list of
trustees.
Note: No rights in the list are granted, but they can be inherited if the Inherited Rights Filter allows 
them.

4. Choose "OK."
You return to the Browser.

If a check box is grayed, one of the following conditions exists:
- No trustee is selected. Select a trustee from the list.
- Rights are undefined. No rights are granted.
- Two or more trustees with different rights have been selected. Select only one trustee or change the 

check box to change that right for all selected trustees.



Change A Trustee's Object Rights to this Object
1. Select a trustee from the "Trustees" list.

Note: You can select multiple trustees by holding down the <Ctrl> or <Shift> keys; any rights that you 
change will affect all selected trustees.
Object Rights with a checkmark (X) denote rights that are granted to the trustee.

2. Select the check box next to any object right that you want to change.
If a box is grayed, see possible reasons below.
If a box is not checked, that right is not granted to the selected trustee.
If a box is marked (X), that right is granted to the selected trustee.
Note: If this trustee has the Supervisor object right, you cannot remove it unless another trustee also 
has the Supervisor object right to this object, or the Inherited Rights Filter allows other objects to 
inherit the Supervisor object right.

3. To reset all object rights to undefined, choose "Clear."
If you clear these rights, and no other rights are granted, the selected trustee is deleted from the list of
trustees.
Note: No rights in the list are granted, but they can be inherited if the Inherited Rights Filter allows 
them.

4. Choose "OK."
You return to the Browser.

If a check box is grayed, one of the following conditions exists:
- No trustee is selected. Select a trustee from the list.
- Rights are undefined. No rights are granted.
- Two or more trustees with different rights have been selected. Select only one trustee or change the 

check box to change that right for all selected trustees.



Change A Trustee's Property Rights to this Object
You can define property rights for a trustee in two ways:
All Property rights define rights for this trustee that are the same for every property of this object. These 
rights control all properties unless rights are granted for a specific property as well.
Specific     Property   rights define rights for this trustee for one property of an object. These rights, if 
assigned, override the "All Property" rights of the trustee for only that specific property.
Example: All the properties of a Printer object are Read only, but Users need to update the Cartridges 
property. To allow Users to update the Cartridges property, select "Selected Properties;" then grant the 
Read right and the Write right for the Cartridges property.

Property rights
Supervisor
Compare
Read
Write
Add (or Delete) Self



Change A Trustee's All Property Rights to this Object
1. Select a trustee from the "Trustees" list.

Note: You can select multiple trustees by holding down the <Ctrl> or <Shift> keys.
Property Rights with a checkmark (X) denote rights that are granted to the trustee.

2. Choose "All Properties."
The properties listed in the "Properties" list box become grayed.
The rights you choose apply to all properties that do not have specific rights defined 
(see Change Specific Property Rights).

3. Select the check box next to any property right that you want to change.
These rights apply to every property of this object that does not have specific rights defined.
If a box is grayed, see possible reasons below.
If a box is not checked, that right is not granted to the selected trustee.
If a box is marked (X), that right is granted to the selected trustee.

4. To reset All Property rights to undefined, choose "Clear."
No    rights in the list are granted, but they can be inherited if the Inherited Rights Filter allows them.
If you clear these rights, and no other rights are granted, the selected trustee is deleted from the list of
trustees.

5. Choose "OK."
You return to the Browser.

Note: In most cases, a trustee will be granted the Read right to all properties. This allows the trustee to 
see the values in all properties of an object. 

If a check box is grayed, one of the following conditions exists:
- No trustee is selected. Select a trustee from the list.
- Rights are undefined. No rights are granted.
- Two or more trustees with different rights have been selected. Select only one trustee or change the 

check box to change that right for all selected trustees.



Change a Trustee's Specific Property Rights to this Object
1. Select a trustee from the "Trustees" list.

Note: You can select multiple trustees by holding down the <Ctrl> or <Shift> key.
2. Choose "Selected Properties."
3. Select a property from the "Properties" box.

Properties in the list that have rights granted are black; others are gray.
The Property Rights show rights granted to the selected trustee for this property.

4. Select the check box next to a property right that you want to change.
If a box is grayed, see possible reasons below.
If a box is not checked, that right is not granted to the selected trustee.
If a box is marked (X), that right is granted to the selected trustee.

5. To reset selected property rights for the selected property to undefined, choose "Clear."
Rights will not be granted to the specific property that you have selected; the "All Properties" rights of 
this trustee will apply to the selected property.
If you clear these rights and no other rights are granted, the selected trustee is deleted from the list of 
trustees.

6. Choose "OK."
You return to the Browser.

Example: A User has Read rights to all properties of a Directory Map object that points to an application. 
The User needs to change the location of the application in the Directory Map, so the User is also granted
the Supervisor property right to the Path property of the Directory Map.
If a check box is grayed, one of the following conditions exists:
- No property is selected. Select a property from the list.
- Rights are undefined. No rights are granted.
- Two or more properties with different rights have been selected. Select only one property or change 

the check box to change that right for all selected properties.



Trustees List box
Lists all trustees that have rights granted to this object.
Objects that are not listed in the "Trustees" list can still have effective rights to this object through
- Inheritance
- Equivalence to another object
- Membership in a Group that is a trustee of this object
You see what rights make up a trustee's trustee assignment by selecting that trustee in the list. You can 
select the check boxes to change that trustee's rights.
If an object does not have a trustee with the Supervisor object right listed in the Trustees list, that object's 
Inherited Rights Filter cannot block the Supervisor object right.
Note: You can select multiple trustees by holding down the <Ctrl> or <Shift> key. Changes you make 
affect all selected trustees.

More about Effective Rights
More about the Inherited Rights Filter

Example: Organizational Units SALES and RESEARCH are subordinate to Organization BOSTON. 
SALES is a trustee of BOSTON and has Browse and Create object rights to BOSTON. SALES inherits 
these rights for every object below BOSTON, including RESEARCH.
RESEARCH doesn't want anyone to create objects in their part of the Directory tree. RESEARCH adds 
an Inherited Rights Filter that includes only the Browse right. This means that no one (including SALES) 
can inherit the Create right in RESEARCH, but SALES still inherits the Browse right.
User ANDREW is a trustee of server CentralStation under RESEARCH and has the Supervisor right. This
trustee assignment bypasses the Inherited Rights Filter and gives ANDREW the Create right.



Add Trustee button
Adds a new trustee to the "Trustees" list for this object. The new trustee is chosen from the Select Object 
dialog and given specific rights that override the Inherited Rights Filter.
Note: If you have only the Add Self property right to the ACL property, your User object will be added as a
trustee when you choose "Add Trustee;" the "Select Object" dialog will not appear.
You can add as many trustees as you need. You must have at least the Write property right on the 
object's ACL property to add trustees to it.
Define trustees as high as possible in the Directory tree. The fewer trustee assignments you use, the 
easier it is to determine where an object's inherited rights came from.
Example: Users in the SEATTLE Organizational Unit need rights to a Profile. Rather than make each 
User a trustee of the Profile, make SEATTLE a trustee of the Profile. Each User will have the same rights 
as SEATTLE. (If a User needs more rights to manage the Profile, that User can be listed as a separate 
trustee of the Profile.)
To grant a set of rights to a group of Users who don't share a common container, use a Group object.



Delete Trustee Button
Deletes a trustee from the "Trustees" list.You must have at least the Write property right on the object's 
ACL property to delete its trustees.
An object that does not appear in the "Trustees" list will only have rights to this object by inheriting them 
from objects higher in the Directory tree, by security equivalence (for User objects only), or by 
membership in a Group object that is a trustee of this object.
Note: If you have only the Add Self property right to the ACL property of this object, "Delete trustee" will 
only be available when your User object is selected from the list of trustees.
If a trustee is the only trustee of this object with the Supervisor object right and the Inherited Rights Filter 
blocks the Supervisor object right, the trustee cannot be deleted. This attempts to prevent cutting off 
supervisor-level access to part of the Directory tree.



Object Rights of a Container Object
Object rights determine what a trustee can do to an object. They affect the object as a whole in the 
Browser. They do not grant any rights to see or change the properties of the object.
Example: With the Delete Object right, a User can remove an object from the Directory database so that 
it no longer exists.

Object rights of container objects
Supervisor
Browse
Create
Delete
Rename



Object Rights of a Leaf Object
Object rights determine what a trustee can do to an object. They affect the object as a whole in the 
Browser. They do not grant any rights to see or change the properties of the object.
Note: The Create object right is not used for leaf objects because you cannot create an object under a 
leaf object.
Example: With the Delete object right, a User can remove an object from the Directory database so that it
no longer exists.

Object rights of leaf objects
Supervisor
Browse
Delete
Rename



Property rights
Property rights determine what a trustee can do with the properties of an object.
There are two ways to assign property rights:
All Properties rights define rights for this trustee that are the same for every property of the selected 
object. These rights control all properties unless rights are granted for a specific property as well.
Selected Property rights define rights for this trustee for one property of an object. These rights, if 
assigned, override the "All Properties" rights of the object for only that specific property.
Example: A User has the Read right to all properties of a Directory Map object that points to an 
application. The User needs to change the location of the application in the Directory Map. Therefore the 
User is granted the Supervisor property right to the Path property of the Directory Map.

Property rights
Supervisor
Compare
Read
Write
Add (or Delete) Self



Trustees of this File or Directory
Important: If you are viewing the "Trustees of the Root Directory" for a Volume object, you are seeing the
trustees of the top level of the file system for the selected volume. You are changing directory rights here. 
To change object rights for the Volume object, choose "Trustees of this Object" from the "Object" menu.
The "Trustees of this File" and "Trustees of this Directory" pages list trustees of this file or directory and 
their rights. When you select a trustee from the list, that trustee's rights to this file or directory appear 
below.
Note: The "Trustees" list does not list objects who are trustees of directories above this point who inherit 
rights to this file or directory. To check for those objects, choose "Effective Rights."
To close the "Trustees of this File [Directory]" dialog and save changes, choose "OK."
To close the "Trustees of this File [Directory]" dialog without saving changes, choose "Cancel."

Procedures
Add a Trustee
Delete a Trustee
View or Change the File and Directory Rights of a Trustee
See the Effective Rights of a Trustee
View or Change the Inherited Rights Filter

Screen regions and buttons
"Trustees" lists all trustees for the file or directory.

"Add Trustee..."  allows you to add a new trustee.

"Delete Trustee" deletes the selected trustee.

"Access rights" allows you to see and change a trustee's access rights.

"Effective rights..." shows the rights that any object can use to access this file or directory.

"Inherited Rights Filter" allows you to see and change the Inherited Rights Filter of this file or 
directory.

"OK" saves changes and closes the dialog.

"Cancel" closes the dialog without saving changes.

Related topic
Trustees of this Object and Rights to Other Objects



Trustees of this File or Directory
The "Trustees of this File" and "Trustees of this Directory" pages show trustees of the file or directory you 
selected. You can
- See who is a trustee of this file or directory
- Change a trustee's rights to this file or directory
Note: The "Trustees" list does not show Users who are trustees of directories above this point who inherit
rights to this file or directory. To check for those objects, choose "Effective Rights."
Do not choose "Cancel" unless you want to lose all changes to every page of the dialog.

Procedures
Using this Dialog
Add a Trustee
Delete a Trustee
View or Change the File and Directory Rights of a Trustee
See the Effective Rights of a Trustee
View or Change the Inherited Rights Filter

Screen regions and buttons
"Trustees" lists all trustees for the file or directory.

"Add Trustee..."  allows you to add a new trustee.

"Delete Trustee" deletes a trustee.

"Access rights" allows you to see and change a trustee's access rights.

"Effective rights..." shows the rights that any object can use to access this file or directory.

"Inherited Rights Filter" allows you to view or change the Inherited Rights Filter of this file or directory.

"OK" saves changes and closes the dialog.

"Cancel" closes the dialog without saving changes.



Add a Trustee to a File or Directory
1. Choose "Add Trustee...."

You must have the Access Control right to the file or directory to add a trustee.
2. Specify the objects you want to add to the list of trustees for this file or directory. 
3. Choose "OK."

The objects that you selected are added to the "Trustees" list.
Note: To grant rights to the trustee to work with this file or directory, use the "Access Rights" check boxes 
below the "Trustees" list.



Delete a Trustee of a File or Directory
1. From the "Trustees" list, select the trustee you want to delete.
2. Choose "Delete Trustee."

You must have the Access Control right to the file or directory to delete a trustee.
3. Choose "Yes."
Note: The object that you deleted from the "Trustees" list will only have rights to this directory or file by 
inheriting them from a directory above this directory or file, or by membership in a group that is a trustee 
of this directory or file.



View or Change the Inherited Rights Filter of a File or Directory
1. Select the check box next to each right that you want to change in the "Inheritance Filter" list.

If the boxes are grayed, no Inherited Rights Filter exists for this file or directory. All rights can be 
inherited.

If a box is not marked, that right cannot be inherited.
If a box is marked (X), that right can be inherited.

2. Choose "OK."
You return to the Browser.

Related topic
More about the Inherited Rights Filter



View or Change a Trustee's File or Directory Rights
1. Select a trustee from the "Trustees" list.

Note: You can select multiple trustees by holding down the <Ctrl> or <Shift> key while selecting 
trustees.
Access rights with a checkmark (X) denote rights that have been granted to the trustee.

2. Choose the box next to any access right that you want to change.
3. Choose "OK."

You return to the Browser.

If any check boxes are gray, one of the following conditions exists:
- No trustee is selected. Select a trustee from the list.
- Rights are undefined. No rights are granted.
- Two or more trustees with different rights have been selected. Select only one trustee or change the 

check box to change that right for all selected trustees.



See an Object's Effective Rights to this File or Directory
You can see an object's effective rights to this file or directory only if:
- You have the Access Control right on the file or directory
- The file or directory is on a volume that uses NetWare v4.0

For an object that is a trustee of this directory or file
1. From the "Trustees" list, select a trustee.
2. Choose "Effective Rights..."
3. The effective rights of the trustee that you selected are shown below the "Trustee" field.

Effective rights are bold. Non-effective rights are grayed.
4. Choose "Close."

You return to the "Trustees of this File [Directory]" dialog.
For an object that is not a trustee of this directory or file
1. Choose "Effective Rights..."

2. Choose the "Browser" icon. 
3. Select an object.

Note: To see a User's effective rights, you must manage that User (have at least the Write property 
right to that User's ACL property.)

4. The effective rights of the object that you selected are shown below the "Trustee" field.
Effective rights are bold. Non-effective rights are grayed.

5. Choose "Close."
You return to the "Trustees of this File [Directory]" dialog.

Note: If you make changes to the "Trustees of this File [Directory]" dialog, they will not be effective until 
you return to the Browser. When you return to the "Trustees of this File [Directory]" dialog, any previous 
changes are reflected in "Effective Rights."

Related topic
More about Effective Rights



Trustees List Box for File and Directories
Lists all objects that have rights granted to this file or directory.
Objects that are not listed in the "Trustees" list can still have effective rights to this file or directory. They 
must get rights through
- Inheritance
- Equivalence to another object (such as a Group) that is a trustee

Related topic
More about the Inherited Rights Filter
More about Effective Rights



Add Trustee Button
Adds a new trustee to the "Trustees" list for this file or directory. The new trustee is given specific rights 
that override the Inherited Rights Filter.
You can add as many trustees as you need. You must have the Access Control right to a file or directory 
to add trustees.
Define trustees as close to the root directory as possible. The fewer trustee assignments you use, the 
easier it is to determine where someone's inherited rights come from.
Example: Users in the SEATTLE Organizational Unit need rights to the REPORTS directory. Rather than 
make each User a trustee of REPORTS, make SEATTLE a trustee of it. Each User will have the same 
rights as SEATTLE. (If a User needs more rights to work in REPORTS, that User can be listed as a 
separate trustee of the directory.)
To grant a set of rights to a group of Users who don't share a common container, use a Group object.



Delete a File or Directory Trustee Button
Deletes a trustee from the "Trustees" list. An object that does not appear on the "Trustees" list will only 
have rights to this file or directory by inheriting them from a parent directory, or through group 
membership.
You must have the Access Control right to a file or directory to delete its trustees.
Note: To determine if you have Access Control rights, select the file or directory and choose Details from 
the Object menu. Choose "Trustees of this File" and then "Effective Rights." Select your User object to 
see your effective rights to the file or directory.



File and Directory Rights
File and Directory rights determine what a trustee can do with a file or directory. Each right can be 
assigned separately to each trustee.

Supervisor
Read
Write
Create
Erase
Modify
File Scan
Access Control



Rights to Other Objects
The "Rights to Other Objects" option shows
- Objects that this object is a trustee of, and 
- Rights this object has to those objects.
When you select an object from the "Assigned Objects" list, the rights included in the trustee assignment 
to that object appear below the list box.
Note: The "Assigned Objects" list only lists objects for which an explicit trustee assignment exists for the 
object you selected. It does not list all objects that the object inherits rights to. To see rights to other 
objects, choose "Effective Rights."
To close the "Rights to Other Objects" dialog and save changes, choose "OK."
To close the "Rights to Other Objects" dialog without saving changes, choose "Cancel."

Procedures
Add a Trustee Assignment
Delete a Trustee Assignment
See the Effective Rights to Any Object
Change the Object Rights to an Object
Change the Property Rights to an Object

Screen regions and buttons
"Assigned Objects" lists all objects that this object has a trustee assignment to.

"Effective rights" are the actual rights that this object has to any object. You can also use this button to
view the effective rights of other objects on the current object.

"Add Assignment..." grants this object a new trustee assignment to another object.

"Delete Assignment" deletes a trustee assignment to another object from the "Assigned Objects" list.

"Object Rights" let you see and change the object rights to the object selected in the "Assigned 
Objects" list.

"Property Rights" let you see and change the property rights to the object selected in the "Assigned 
Objects" list.

"Clear" resets all rights in the list to undefined (gray) for the selected object. Checked boxes show 
rights that are granted; Unchecked boxes show rights that are not granted.

"OK" saves changes and closes the dialog.

"Cancel" closes the dialog without saving changes.

Related Topics
Trustees of this Object and Rights to Other Objects

Trustees of the Root Object in the Directory Tree



Set the Context for this "Rights to Other Objects" Dialog
Use this dialog to limit the part of the Directory tree for which this object's trustee assignments are shown.
Every object under the container that you select will be searched for this object's rights to other objects 
(trustee assignments). The smaller a section of the Directory tree you select, the quicker the dialog will 
appear.



Add a Trustee Assignment
1. Choose "Add Assignment...."

You must have at least the Write property right to the ACL property of the object that you want to add 
to the "Assigned Objects" list.

2. Select which objects you want to grant this object rights to.
Example: To allow User John to use a Profile during login, view the "Rights to Other Objects" for User
John, and add Profile to the "Assigned Objects" list. Then grant Browse object right and Read All 
Properties right. John can now use the Profile.

3. Choose "OK."
The objects that you selected are added to the "Assigned Objects" list.
To grant rights to the new Assigned Object, select the check boxes below the "Assigned Objects" list.



Delete a Trustee Assignment
1. Select the object that you want to delete from the "Assigned Objects" list.
2. Choose "Delete assignment."

You must have at least the Write property right to the ACL property of the object that you want to 
remove from the "Assigned Objects" list.

3. Choose "Yes."
This object will only have rights to the object that you delete from the list by inheriting rights from other
objects that are trustees, such as through membership in a Group that is a trustee of the deleted 
object.

You cannot delete a trustee assignment to an object if
- It is the only trustee of this object with Supervisor object right, and
- The object's Inherited Rights Filter blocks the Supervisor object right.
You must first grant another trustee the Supervisor object right, or make sure the Inherited Rights Filter 
doesn't block the Supervisor object right. This prevents you from cutting off Supervisor-level access to 
part of the Directory tree.



See this Object's Effective Rights to another Object

To an object that is listed in the "Assigned Objects" list box
1. Select one object from the "Assigned Objects" list.
2. Choose "Effective rights..."

This object's effective rights to the object you selected are shown below the "Object name" field.
Effective rights are bold. Non-effective rights are grayed.
Choose a property from the "Properties" list to see effective rights to specific properties.

3. Choose "Close."
You return to the "Rights to Other Objects" dialog.

To an object that is not listed in the "Assigned Objects" list box
1. Choose "Effective rights..."

2. Choose the "Browser" icon.
3. Select an object.
4. Choose "OK."

This object's effective rights to the object you selected are shown below the "Object name" field.
Effective rights are bold. Non-effective rights are grayed.
Choose a property from the "Properties" list to see effective rights to specific properties.

5. Choose "Close."
You return to the "Rights to Other Objects" dialog.

Note: If you make changes to the "Rights to Other Objects" dialog, they are not reflected in "Effective 
Rights" until you have exited the "Rights to Other Objects" dialog with "OK." When you return to the 
"Rights to Other Objects" dialog, any previous changes are reflected in "Effective Rights."

More about Effective Rights



Change this Object's Rights to an Object
1. Select an object from the "Assigned Objects" list.

Note: You can select multiple objects by holding down the <Ctrl> or <Shift> keys. If an object is 
grayed, you do not have rights to change the trustee assignment.
Object Rights with a checkmark (X) denote rights that are granted to the objects.

2. Select the check box next to any object right that you want to change.
Note: If the Supervisor right is granted to this object, you cannot remove it unless some other trustee 
also has the Supervisor right to this object, or the Inherited Rights Filter allows other objects to inherit 
the Supervisor right.

3. To reset all object rights to undefined, choose "Clear".
If you clear these rights, and no other rights are granted, the selected trustee is deleted from the list of
trustees.
Note: No rights in that list are granted, but they can be inherited if the Inherited Rights Filter of the 
object you selected in the list allows them.

4. Choose "OK."
You return to the Browser.

If any check boxes are gray, one of the following conditions exists:
- No object is selected. Select an object from the list.
- Rights are undefined. These rights are not granted to this object.
- Two or more objects have been selected, and this object has different rights to each. Select only one 

object or change the check box to change that right to all selected objects.



Change this Object's Property Rights to an Object
You can define property rights to an object in two ways:
All Property rights define rights to the assigned object that are the same for every property of the object. 
These rights control all properties unless rights are granted for a specific property as well.
Selected     Properties   rights define rights to the assigned object for one property of an object. These rights, 
if granted, override the All Property rights to the object for only that specific property.
Example: All the properties of a Printer object are Read only, but this object needs to update the 
Cartridges property. To allow this object to update the Cartridges property, select "Selected Properties;" 
then grant the Write right for the Cartridge property.

Property Rights
Supervisor
Compare
Read
Write
Add (or Delete) Self



Change All Property Rights to an Object
1. Select an object from the "Assigned Objects" list.

Note: You can select multiple objects by holding down the <Ctrl> or <Shift> keys.
Property Rights with a checkmark (X) denote rights that the object selected in the Browser is granted 
to the object in the "Assigned objects" list.

2. Choose "All Properties."
The properties listed in the "Properties" list box are grayed. The rights you choose apply to all 
properties that do not have specific rights defined (see Change Specific Property Rights).

3. Select the check box next to any property right that you want to change.
These rights apply to every property of this object that does not have specific rights defined as well.

4. To reset All Property rights to undefined, choose "Clear".
Rights can still be inherited if the Inherited Rights Filter of the object allows them.
If you clear these rights, and no other rights are granted, the selected trustee is deleted from the list of
trustees.

5. Choose "OK."
You return to the Browser.

Note: In most cases, this object will have the All Property Read right to the Assigned Object. This allows 
this object to see the values in all properties of the assigned object.

If any check boxes are gray, one of the following conditions exists:
- No Assigned object is selected. Select an object from the list.
- Rights are undefined. No rights are granted.
- Two or more objects have been selected, and this object has different rights granted for each. Select 

only one object or change the check box to change that right for the trustee assignment to all selected
objects.



Change Selected Property Rights to an Object
1. Select an object from the "Assigned Object" list.

Note: You can select multiple objects by holding down the <Ctrl> or <Shift> key.
2. Choose the "Selected Properties" radio button.
3. Select a property from "Properties" list.

The list box shows all possible properties. Properties in the list that have rights granted are black; 
others are gray.
If you select a property that is not a part of the assigned object, the rights shown have no meaning.
The Property Rights show rights granted to the assigned object for this property.

4. Select the check box next to any property right that you want to change.
5. To reset Selected Property rights for the selected property to undefined, choose "Clear".

Rights will not be granted to the selected property. All Property rights to the assigned object will apply 
to the selected property.
If you clear these rights, and no other rights are granted, the selected trustee is deleted from the list of
trustees.

6. Choose "OK."
You return to the Browser.

Example: A User has Read rights to all properties of a Directory Map object that points to an application. 
The User needs to change the location of the application in the Directory Map, and is granted the 
Supervisor property right to the Path property of the Directory Map.

If any check boxes are gray, one of the following conditions exists:
- No property is selected. Select a property from the list.
- Rights are undefined. No rights are granted.
- Two or more properties with different rights have been selected. Select only one property or change 

the check box to change that right for all selected properties.



Assigned Objects List Box
Lists all objects that this object has a trustee assignment to. If an object is grayed, you do not have rights 
to change the trustee assignment.
This object can still have effective rights to objects that are not listed in the "Assigned Objects" list. These 
rights come from
- Inheritance
- Equivalence to another object (such as a Group) that is a trustee of this object.
To see what rights make up this object's trustee assignment to the assigned object, select that object in 
the list. You can change the check boxes to change the rights to that object.
More about Effective Rights

Example: SALES, an Organizational Unit (under Organization BOSTON), has been added to the Trustee 
list of BOSTON and granted Browse and Create rights. SALES inherits these two rights for every object 
below BOSTON in the Directory tree.
But RESEARCH, another Organizational Unit in the same tree as SALES (under BOSTON), doesn't want 
anyone creating objects in their part of the Directory tree: So RESEARCH adds an Inherited Rights Filter 
with only the Browse right checked. Now no one can inherit the Create right in RESEARCH, but SALES 
still inherits the Browse right.
But, User JOHN, who is under SALES, services one particular server under RESEARCH, so the 
administrator of RESEARCH adds JOHN to the Trustee List of server CentralStation with Supervisor right.
Now he can do anything he needs to on that server. (This explicit trustee assignment to the server object 
bypasses the Inherited Rights Filter.)



Add Assignment Button
Grants a new trustee assignment to an object and adds that object to the "Assigned Objects" list.
You can add as many trustee assignments as you need. You must have at least the Write property right to
the ACL property of any object that you want to add to the "Assigned Objects" list.
Define trustee assignments as high as possible in the Directory tree. The fewer trustee assignments you 
use, the easier it is to determine where an object's inherited rights came from.
Example: Users in the SEATTLE Organizational Unit need rights to the printer. Rather than make each 
user a trustee of the printer, make SEATTLE a trustee of the printer. Each User will have the same rights 
as SEATTLE. (If a User needs more rights to manage the printer, that User can be listed as a separate 
trustee of the printer.)
To grant a set of rights to a group of Users who don't share a common container, use a Group object.



Delete Assignment Button
Deletes an object from the "Assigned Objects" list.You must have at least the Write property right to the 
ACL property of any object that you want to remove from the "Assigned Objects" list.
If this object is the only trustee of the assigned object with the Supervisor object right and the Inherited 
Rights Filter of the assigned object blocks the Supervisor object right, the trustee cannot be deleted. This 
prevents cutting off Supervisor-level access to part of the Directory tree.
This object can still have rights to an object that does not appear in the "Assigned Object" list, by
- Inheriting them from objects higher in the Directory tree,
- Security equivalence (for User objects only), or
- Membership in a Group object that is a trustee of this object.



Object Rights to an Object in the Assigned Objects List
Object rights determine what a trustee can do to an object. They do not grant any rights to see or change 
the properties of the object.
When you select an object in the "Assigned Objects" list, this object's rights to the object that you selected
are shown as checked in the list of object rights.
Example: With the Delete object right, a User can remove an object from the Directory tree so that it no 
longer exists.

Object rights to container objects
Browse
Create
Delete
Rename
Supervisor

Object rights to leaf objects
Browse
Delete
Rename
Supervisor



Property Rights to an Object
Property rights determine what a trustee can do with the properties of an object.
When you select an object in the "Assigned Objects" list, this object's property rights are shown as 
checked in the list of property rights.
Example: With the Write right for All Properties, a User can add or change the values of any property.
There are two ways to assign property rights
All Property rights define this object's rights to the assigned object that are the same for every property of 
the object. These rights control all properties unless rights are granted for a specific property as well.
Selected Property rights define this object's rights to the assigned object for one property of the object. 
These rights, if assigned, override the All Property rights to the object for only that specific property.
Example: A User has Read rights to all properties of a Directory Map object that points to an application. 
The User needs to change the location of the application in the Directory Map, and is granted the 
Supervisor property right to the Path property of the Directory Map.

Property rights
Supervisor
Compare
Read
Write
Add (or Delete) Self



Manage a Bindery Object
This object was created in the Directory tree by an upgrade or migration utility. It can't be converted to a 
standard NetWare Directory Services object.
You can't view or change information about this object. To manage this object, refer to the utility that 
created it.
If this object was upgraded from a previous version of NetWare, you may be able to manage this object 
using utilities from that version of NetWare by setting the Bindery Emulation Context to include this object.
You can delete this object from the Directory tree.



View or Change a User Object 
The "Identification" page describes this User object. You can use this page to store information such as
- Additional names for this User
- Where the User is located
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Enter a Title for this User
Enter a Fax or Telephone Number for this User
Enter a Description of this User

Screen regions and buttons
"Login name" shows the name the User enters to log in to the network.

 opens a dialog where you can enter more values for a field.
"Given Name" 
"Last Name" shows the User's last name.
"Generational Qualifier" 
"Initials" 
"Other name" lists other names associated with this User. (Maximum length of each is 60 characters.)
"Title" shows the position or function of the User. (Maximum length of each is 60 characters.)
"Description" describes the function the User performs. (Up to 30 lines of 37 characters each can be 
entered.)
"Location" shows the User's physical location (such as a mail stop).
"Department" shows the User's department or division.
"Telephone" lists the User's telephone numbers.
"Fax Number" lists the telephone numbers of fax machines available to the User.
"OK" saves changes in all pages of this dialog.
"Cancel" closes this dialog without saving changes in any page.



Using Other Names for a User
The "Other name" field can contain identification information that helps you search for and identify specific
Users.
Example: You frequently need to search for employees who have been hired after a certain date. To 
facilitate the search, Include the employee's date of hire in the "Other name" field.



View or Change Security Equivalences
The "Security Equivalences" page shows objects that this User is security equivalent to. This means that 
any rights granted to the objects listed on this page are also granted to this User. For example, you can
- See which objects this User is security equivalent to
- Add or delete objects from the list of security equivalent objects
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add an Object to the List of Security Equivalences
Delete an Object from the List of Security Equivalences
See which Objects This User is Security Equivalent to That Are Not Listed

Screen regions and buttons
"Security Equivalences" shows all objects that this User is security equivalent to.

"Add" lets you add an object to the list of security equivalent objects.

"Delete" lets you delete an object from the list of security equivalent objects.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Add an Object to the List of Security Equivalences
Note: Some objects are added to the Security equivalences list of a User by NetWare when you perform 
other actions. For example, when you make a User a member of a Group, the Group is added to the 
Security equivalences list of the User, to give the User the same effective rights as the Group.

To add an object to the list of security equivalences
1. Choose "Add."

You must have the Write property right to the ACL property of the object that you want to add to the 
list. You do not need any rights to the Security Equivalences property of the User.

2. Select an object that you want to add to the list of security equivalent objects.
The object is added to the list. This object will have the same effective rights as any object listed in 
the "Security Equivalences" page.
Note: Every object is security equivalent to all of the objects in its complete name, that is, all of the 
objects directly above it to the root of the Directory tree. This security equivalence cannot be 
changed, but none of those objects are listed in the Security Equivalences list.



Delete an Object from the List of Security Equivalences
1. Select an object from the "Security Equivalences" list.
2. Choose "Delete."

The object is deleted from the list of security equivalent objects.
Note: This User no longer automatically has the same effective rights as the object that was deleted. The 
User might still have the same rights, but they must come from the User's own trustee assignments or 
from a security equivalent object that was not deleted.
Note: Every object is security equivalent to all of the objects in its complete name, that is, all of the 
objects directly above it to the root of the Directory tree. This security equivalence cannot be changed, but
none of those objects are listed in the Security Equivalences list.



See Which Objects this User Is Security Equivalent to that Are Not Listed
Every User is security equivalent to every container that is directly above it in the Directory tree, even 
though these objects are not listed in the Security Equivalences list. 
To see a User's complete name, which shows all of the containers that the User is security equivalent to 
that are not listed on the Security Equivalences page, complete the following steps:
1. From the "Security Equivalences" page, choose "Add."
2. Use the "Select Object" dialog to locate the User object in the Directory tree.

The context of the User appears at the top of the "Select Object" dialog. The User is security 
equivalent to every container listed.



Security Equivalences List
This lists objects that this User is security equivalent to.
Note: Every object is security equivalent to all of the objects in its complete name, that is, all of the 
objects directly above it to the root of the Directory tree. This security equivalence cannot be changed, but
none of those objects are listed in the "Security Equivalences" list.
The "Security Equivalences" list can contain objects of different types. A User might be security equivalent
to 
- A Group object as part of a group 
- A server for access to a certain print queue
- Another User
Some objects are automatically placed in the "Security Equivalences" list because of other operations that
you perform.
Example: When you add a User to the membership list of a Group object, the name of that Group is 
automatically put in the "Security Equivalences" list of that User.



Add Button
Choose this button to add an object to the "Security Equivalences" list. All effective rights for every object 
in the "Security Equivalences" list are added to the effective rights of this User.
You can use this feature to temporarily access another User's files.
Note: You must have the Write or Supervisor right to the Security Equals property of a User object (even 
your own) to add objects to the "Security Equivalences" list.
Some objects are automatically placed in this list because of other actions that you perform.
Example: When you add a User to the membership list of a Group object, the name of that Group is 
automatically placed in the "Security Equivalences" list of that User.



Delete Button
Use this button to delete an object from the "Security Equivalences" list.
This User will no longer automatically have the rights that the deleted object had. This User might still 
have all of the same rights, but they must come from the User's own trustee assignments or from other 
objects that are still in the "Security Equivalences" list.



Set a User's Network Address Restrictions
The "Net Address Restrictions" page determines which workstations a User can log in from by specifying 
the network addresses of those workstations. If no addresses are listed, there are no restrictions and the 
User can log in from any workstation. For example, you can
- Specify addresses the User can log in from
- Add or delete addresses from the list
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Network Address
Delete a Network Address

Screen regions and buttons
"Network Protocol" lists the protocol you selected for the new address. Complete the fields with 

values appropriate for the protocol you use.

"Add" lets you add another network address to the list. If you leave the protocol fields filled with F's or 
255's, this User can log in from any address using that protocol.

"Delete" removes the network address from the list.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Set Login Restrictions
The "Login Restrictions" page allows you to restrict how this User can use the network. For example, you 
can
- Disable this User's account
- Set a date for this User's account to expire
- Limit the number of workstations that the User can log in from simultaneously
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Disable this User's Account
Set an Expiration Date for this User's Account
See when this User Last Logged In
Limit this User's Concurrent Connections (Logins)

Screen regions and buttons
"Account disabled" prevents the User from logging in.

"Account has expiration date" allows you to set an expiration date for this account.

"Expiration date and time" sets the date and time this User's account expires.

"Limit concurrent connections" allows you to limit the number of workstations that the User can log in 
from simultaneously.

"Maximum connections" defines the maximum number of workstations that this User can be logged 
in.

"Last login" shows the date and time the User last logged in.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Disable this User's Account

To disable this User's account, select the "Account Disabled" check box.
This User cannot log in until the check box has been cleared.
Note: Some network conditions will cause the User's account to be disabled without you specifically 
selecting the check box. Examples include when the account expires, when an intruder is detected, or 
when the User's account balance drops below the allowable credit limit.



Set an Expiration Date for this User's Account
1. Select the check box "Account has expiration date."

You will not be able to modify the other fields until you select this check box. You can deselect this 
check box at any time to remove the expiration date from a User's account.

2. Use the arrows next to the date and time sections of the "Expiration Date and Time" fields to set the 
date and time that this User's account expires.
When that date and time are reached, the User will be logged out, and the account will be locked. The
User will not be able to log in again until a network administrator unlocks the account and resets the 
expiration date.



Limit this User's Concurrent Connections (Logins)
1. Select the check box "Limit Concurrent Connections."

The "Maximum Connections" field can not be modified until you select this check box. You can 
deselect this check box at any time to allow unlimited concurrent connections to this User.

2. Enter the maximum number of workstations that you want this User to be able to log in from at the 
same time in the "Maximum Connections" field.

3. Choose "OK."
The information is not saved to NetWare Directory Services until you choose "OK."



See When this User Last Logged In
To see when this User logged in last, look at the "Last login" field. 
This field cannot be modified; it is for information only.



Set Password Restrictions
The "Password Restrictions" page controls how passwords for this User are handled. For example, you 
can specify 
- Whether the User can change his or her own password
- How many grace logins are allowed after the User's password expires
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Change this User's Password
Require a Password for this User
Limit this User's Grace Logins
Set a Minimum Password Length
Force Periodic Password Changes

Screen regions and buttons
"Allow user to change password" lets this User change his or her own password.

"Require a password" requires a User to enter a password.

"Minimum password length" specifies the minimum number of characters required for the password.

"Force Periodic Password Changes" requires that passwords be changed at regular intervals.

"Days Between Forced Changes" specifies the number of days a password can be used.

"Date Password Expires" displays the password expiration.

"Require Unique Passwords" requires passwords to be unique. NetWare stores this User's previous 
eight passwords and does not allow them to be used again until eight password changes have 
occurred.

"Limit Grace Logins" allows you to limit the number of times an expired password can be used.

"Grace Logins Allowed" specifies the number of times an expired password can be used.

"Remaining Grace Logins" shows how many grace logins are left.

"Change password" changes this User's password.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Change a Password
Make sure a password exists for objects like Users and Print Servers. Security could be compromised if 
someone gains unauthorized access as a User or Print Server and takes advantage of their security 
equivalences.
The following are suggestions for password use to improve network security:

Don't use common dictionary words
Don't use the names of family members or pets
Use combinations of words
Combine alpha and numeric characters in the password

To change a password
1. Type the old password in the "Old password" field.
2. Type the new password in the "New password" field.

Only alphanumeric characters and underscores (_) are valid. The password is not case-sensitive.
3. Type the new password again in the "Retype new password" field.
Screen regions and buttons

"Old password" is where you enter the current password.

"New password" is where you enter the new password.

"Retype new password" is where you enter the new password a second time.

"OK" changes the password.

"Cancel" closes this dialog without changing the password.



Require a Password for this User
To require that this User use a password, select the "Require a Password" check box.
All of the password restriction options below the check box turn from gray to black. A password must be 
entered by this User when logging in.



Limit this User's Grace Logins
1. Select the "Limit Grace Logins" check box.

The "Require a Password"    and "Force Periodic Password Changes" check boxes must be selected, 
or the other options described here will be grayed.

2. Enter the number of grace logins in the "Grace Logins Allowed."
This should be a number from zero to 50. One grace login is used each time that the User logs in 
using a password that has expired without accepting the prompt to enter a new password. If all grace 
logins are used without changing the expired password, the User's account is locked until a network 
administrator unlocks it.

3. If the User's password has expired and the User is using grace logins and has not changed the 
password, the number of grace logins remaining is shown in the "Remaining grace logins" field.
You cannot change this field.



Set a Minimum Password Length for this User
1. Enter a value in the "Minimum Password Length" field.

The "Require a Password" check box must be selected, or the other fields will be grayed.
You can enter values from 0 to 999 in the "Minimum Password Length" field. If you enter a value 
above 11, Users cannot log in from Macintosh workstations.

Note: To improve network security, set minimum password length to no less than 5.



Force Periodic Password Changes for this User
1. Select the "Force Periodic Password Changes" check box.

The "Require a Password" check box must be selected, or the other fields described will be grayed.
2. Enter the number of days that each new password should last in the "Days Between Forced 

Changes" field.
After this many days, a new password must be entered or the account will be disabled (after any 
grace logins are used.)
If you have previously selected "Force Periodic Password Changes," the "Expiration Date and Time" 
field shows when the current password must be changed because it expires.

3. (Optional) Select the "Require Unique Password" check box so each newly-entered password must 
be unique. This User's previous passwords are saved and cannot be used again. This can improve 
network security.



Restrict a User's Login Times
The "Time Restrictions" page allows you to limit the times when this User can log in.
You can restrict times in half-hour segments. White cells indicate times that this User can log in. Dark 
cells indicate times that this User can't log in. The default is no restrictions (all white cells).
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Restrict Login Times Using a Mouse
Restrict Login Times Using the Keyboard

Screen regions and buttons
"Login Time Restrictions" shows the times the User can log in.

"Reset" resets the grid to the default (no login restrictions).

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Restrict Login Times Using a Mouse

To restrict times a User can log in
1. Move the mouse pointer to the cell that represents the beginning of the time period you want to 

restrict.
The day and time that the pointer is on is displayed above the Reset button.

2. Click the left mouse button and drag the pointer to select the times you want to restrict.
You can select rectangular regions only. You may need to repeat these steps several times to select 
the times that you want to restrict.
Dark cells represent times this User can't log in. If you select an area that is already restricted, it will 
become unrestricted.

3. Release the mouse button.



Restrict Login Times Using the Keyboard

To restrict times a User can log in
1. Hold down the <Shift> key and press <Tab> until the cursor appears in the grid.
2. Use the arrow keys to move the cursor to the cell that represents the beginning of the time period that

you want to restrict.
3. While holding down the <Shift> key, use the arrow keys to select the times that you want to restrict.

You can select rectangular regions only. You may need to repeat these steps several times to select 
the times that you want to restrict.
Dark cells represent the times the User can't log in. If you select an area that is already restricted, it 
will become unrestricted.

4. Release the <Shift> key.



Create or Change a User's Login Script
The "Login Script" page lists commands that are executed when this User logs in to the network. For 
example, you can set commands to
- Map drives
- Assign printers to this User
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Copy a Login Script from another Location
Edit the Login Script
Select a Profile Object To Be Used by this User

Screen regions and buttons
"Edit" holds login script commands.

"Profile" accepts the complete name of a Profile object The login script in this Profile object is 
executed before this User's login script.

 lets you select a Profile object.
"OK" saves changes in all pages of this dialog.
"Cancel" closes this dialog without saving changes in any page.
Related topics

Login Script Commands



Select a Profile Script to be Used by this User
Each User object can list one Profile object with its login script. 
If a Profile object is listed, the login script in the Profile object is executed before the User's login script. 
This provides a method for several Users to share common login commands that are not included in the 
container system login script.

To select a Profile object for this User:
1. Select the Login Script page in a User's object dialog.
2. Select the Browser icon to the right of the "Profile" field below the User's login script commands.

The "Select Object" dialog appears.
3. Select the Profile object whose script you want to be executed when this User logs in.

The Profile object can be anywhere in the Directory tree.
4. Choose "OK."

The Profile object is listed in the "Profile" field of the User's Login Script page.
Only one Profile can be specified for each User.



Copy a Login Script from another Location
This procedure allows you to use commands entered for another login script or in any Windows text editor
in this login script without typing them again.

To copy a login script
1. While editing any login script with the NetWare Administrator, or in any Windows text editor, such as 

"Notepad," use the mouse or hold down the <Shift> key and use the arrow keys to select the area of 
text that you want to copy into this login script.

2. When the text you want is selected, hold down the <Ctrl> key and press the <Insert> key.
3. Return to the "Login Script" page where you want to insert the commands that you selected in Step 1.
4. Place the cursor within the login script at the location where you want the commands inserted.
5. Hold down the <Shift> key and press the <Insert> key.

The text that you selected is copied into the login script.
6. Make any other changes as needed to the commands, as if you had typed them in at this point.
7. Choose "OK."

The login script is not saved to NetWare Directory Services until you choose "OK."



Edit a Login Script
1. Place the cursor in the login script at the point where you want to make changes to the login script 

commands.
2. Use the arrow keys, the <Delete> and <Insert> keys, and other keys to move and erase text.
3. Type new text wherever it is needed. Existing text will move to make room for it.
4. Choose "OK."

Changes are not saved to NetWare Directory Services until you choose "OK."



View or Reset Intruder Lockout
The "Intruder Lockout" page displays the status of a User's account after the maximum number of login 
attempts is exceeded. If someone enters the wrong password too many times, the User's account is 
locked. For example, this page shows
- When a User's account was locked
- The network address of the workstation used when a person exceeded the allowed login attempts
Check the information on this page if a User can't log in. If the "Account locked" field isn't checked, the 
login problem is caused by something else.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Unlock this User's Account
View When and Why this User's Account was Locked

Screen regions and buttons
"Account locked" indicates that the account is locked because an incorrect password was used too 

many times.

"Incorrect login count" shows the number of incorrect passwords entered.

"Account reset time" shows the time when the account will be reactivated if this account is locked. If it 
is not locked, this field shows when the "Incorrect login count" will be reset.

"Time until reset" shows the time remaining to reset this account if it is locked. If it is not locked, this 
field shows the time remaining until the "Incorrect login count" is reset.

"Intruder address" shows the network address of the last person who entered a wrong password.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Unlock this User's Account
To reset the Intruder Alert lockout for this User, deselect the "Account locked" check box. 
The User can now log in normally.
Note: The account lock will reset automatically after the time specified in the "Intruder Lockout Reset 
Interval," which you can set in the object dialog for the container above this object.



View When and Why this User's Account Was Locked
1. See the "Incorrect login count" field.

This is the number of times that someone entered the wrong password for this User before being 
locked out.

2. See the "Intruder address" field.
This is the network node address of the workstation that the person was using who entered the 
incorrect passwords when trying to log in as this User.

3. See the "Account reset time" field.
This is the time of day when the account will be unlocked by NetWare. It is calculated from the 
"Intruder Lockout Reset Interval" that you set for the container of this object.
The "Time until reset" field is the length of time from now until the "Account reset time."



List the Group Memberships of a User
The "Group Membership" page shows the Groups that this User is a member of.
You can change the Groups a User is a member of in the
- "Group Membership" page of the User object dialog
- "Members" page of the Group object dialog
Changes to Group memberships that you make in either dialog appear automatically in both dialogs. You 
need appropriate property rights in both dialogs to view or change Group memberships.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Add this User as a Member of a Group
Delete this User as a Member of a Group

Screen regions and buttons
"Memberships" shows the Groups that this User is a member of.

"Add" lets you select a Group object that you want this User to be a member of.

"Delete" removes this User from the Groups listed in the "Memberships" list box.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Add this User as a Member of a Group
1. Choose "Add."

To add this User as a    member of a Group, you must have the Write property right to the Membership
property of the Group, and the Write property right to the ACL property of the Group. If you have the 
Supervisor object right to the Group, these requirements are filled.

2. Select the Group that you want to make this User a member of.
3. Choose "OK."

The Group is added to the list of Groups that this User is a member of. This User will have the same 
rights that are assigned to the Group object.
Note: The Group object is automatically listed in the Security Equivalences list of each User object 
that you add to the membership list.



Delete this User as a Member of a Group
1. Select a Group from the "Membership" list.
2. Choose "Delete."

The Group object is deleted from the list of Groups that this User belongs to.
Note: When you delete a Group from the Group memberships list of a User, the Group is 
automatically removed from the Security Equivalence property of the User.



Set a User's Account Balance
Use the "Account Balance" page to manage the credit on a User's account. For example, you can
- See how much credit this User has
- Allow unlimited credit for this User
To install or remove accounting, or to change the rate charged for particular services, go to the NetWare 
Server object dialog and choose "Accounting."
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Set this User's Account Balance
Set a Lower Limit on this User's Credit Balance

Screen regions and buttons
"Account balance" shows the credit that this User has remaining.

"Allow unlimited credit" allows this User unlimited use of network services. "Account balance" is 
ignored.

"Low balance limit" shows the balance at which this User is denied access to network services.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Set this User's Account Balance
1. Enter a value in the "Account Balance" field.

This balance will be depleted each time this User uses a network resource for which an accounting 
charge has been established. If "Allow unlimited credit" is not selected, the User's account will be 
locked when the "Account Balance" drops below the "Low balance limit."

2. Choose "OK."
The change is not recorded until you choose "OK."



Set a Lower Limit on this User's Credit Balance
1. Deselect the "Allow unlimited credit" check box, if it is selected.

If this check box is selected, the "Account balance" and "Low balance limit" fields have no effect.
2. Enter a value in the "Low balance limit" field.

The User's account will be locked when the "Account Balance" drops below the "Low balance limit." 
The "Account balance is depleted each time this User uses a network resource for which an 
accounting charge has been established.



View Environment Information about a User Object
Use the "Environment" page to see other properties of this User object. For example, you can
- View property information not included in other pages of this dialog such as Bindery property and 

Network Address
- See which properties did not migrate when this User was upgraded to NetWare v4.0
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Set this User's Language
See Which Workstations this User is Logged in From
Set this User's Default Server
Set Up a Home Directory for this User

Screen regions and buttons
"Language" determines the language that messages are displayed in.

"Network Address" lists the addresses of the network workstations that the User is currently logged in 
from.

"Default Server" is the NetWare Server that this User will try to connect to when logging in.

"Home Directory" shows the volume object and directory path of this User's home directory. You can 
change this directory, but you cannot create a new directory from here.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Set this User's Language
1. Enter a language in the "Language" field.

This is the language that all NetWare utilities and prompts will appear in when this User is logged in 
and runs a NetWare utility.
The language that you choose must be installed on the network.

2. Choose "OK."
Your entry is not recorded until you choose "OK."



See Which Workstations this User is Logged in From
To see which workstations this User is logged in to, see the "Network Addresses" field.
The network addresses of all workstations that this User is currently logged in from are listed. If you have 
a Computer object in NetWare Directory Services for each workstation, you can see each workstation's 
address to determine where the User is logged in.



Set this User's Default Server
1. Select the Browser button to the right of the "Default Server" field.
2. Select a NetWare server from the "Select Object" dialog.
3. Choose "OK."

The NetWare Server that you choose is inserted into the "Default Server" field.
This is the server where this User's information will be stored by default.



Set Up a Home Directory for this User
1. Select the Browser button to the right of the "Home Directory" field.
2. Select a volume and path from the "Select Object" dialog where this User's home directory should be 

located.
3. Choose "OK."

The path that you selected is inserted into the "Home Directory" field.



View or Change a Computer Object 
The "Identification" page describes a Computer object. For example, you can
- Keep a record of the department and person responsible (owner) for the Computer object
- Record information such as the computer's serial number and location
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Enter a Description for this Computer
Enter a Serial Number for this Computer
Enter Another Name for this Computer
Specify One or More Servers for this Computer

Screen regions and buttons
"Name" displays the name of this Computer object.

"Other Names" lists other names of this Computer object (such as names previously used for this 
Computer).

"Owner" shows the name of the person who uses this Computer.

"Description" contains information that helps identify this Computer.

"Serial number" shows this Computer's serial number.

"Location" shows the physical location of the computer.

"Department" shows the group the Computer belongs to.

"Organization" shows the organization that the Computer belongs to.

"Server" shows the NetWare Server most commonly used by this Computer.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Specify One or More Servers for this Computer
1. Select the Browser button to the right of the field.
2. Select one or more NetWare Server objects from the "Select Object" dialog.
3. Choose "OK."

The NetWare Servers that you selected are listed as servers that this computer regularly accessed to 
retrieve data about logins and NetWare Directory Services.



View or Change a Country Object 
The "Identification" page describes a Country object. You can enter the full name and descriptive 
information about this Country object in the "Description" field.

Procedures
How to Use the Object Dialog
Enter a Description for this Country

Screen regions and buttons
"Name" displays the two-letter country code for this country.

"Description" shows information such as the full name of the country and a description of your 
organization in that country.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Enter a Description for this Country
The Description field of a Country object can be used like the Description field of any other object to 
record any pertinent information about the object.
You should include the complete name of the Country in the Description field. This name is a two-letter 
country code. Placing the complete name in the Description field will help avoid confusion.

To enter a description for this Country
1. Select the "Description" field.
2. Type the information that you want recorded for this object.

The information scrolls as you type. Use the scroll bar to the right of the field to scroll through the text 
that you have entered.

3. Choose "OK."
The information is not saved to NetWare Directory Services until you choose "OK."



View or Change a Group Object    
The "Identification" page describes this Group object. For example, you can you store information such as
- Other names this Group is known by
- The person responsible for this Group
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Enter a Description for this Group
Add another Name for this Group
Enter an Owner for this Group

Screen regions and buttons
"Name" displays the name of this Group.

"Other name" specifies other names this Group is known by.

"Owner" specifies the person who is responsible for this Group.

"Description" contains information that helps identify this Group.

"Location" shows where the Group is located.

"Department" displays the department this Group reports to.

"Organization" lists the company or other organization that this Group reports to.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Enter an Owner for this Group
The "Owner" field records the name of the person that is responsible for maintaining this group of Users 
on the network.
For example, if a Group is created to list all Users of an accounting package, the Owner might be the 
network administrator in the Accounting department.

To set an owner for this Group
1. Select the "Owner" field.
2. Type the name of the person that you want recorded as the owner of this Group object.
3. Choose "OK."

The information is not saved to NetWare Directory Services until you choose "OK."



View or Change the Members of a Group Object
The "Members" page lists the Users who are members of this Group.
This Group appears in the "Group Membership" page of each User that is listed on this page.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Member to this Group
Delete a Member from this Group

Screen regions and buttons
"Group Members" lists the complete context of each User that is a member of this Group.

"Add" lets you select User objects to add as members of this Group.

"Delete" removes the selected Users from the "Group Members" list.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Add a Member to this Group
1. Choose "Add."

To add a member to a Group, you must have the Write property right to the Membership property of 
the Group, and the Write property right to the ACL property of the Group. If you have the Supervisor 
object right to the Group, these requirements are filled.

2. Select Users that you want to add to the list of members.
3. Choose "OK."

The User is added to the membership list. This User will have the same rights that are assigned to the
Group object.
Note: The Group object is automatically listed in the "Security Equivalences" list of each User that 
you add to the membership list.



Delete a Member from this Group
1. Select a User from the "Membership" list.
2. Choose "Delete."

The User is deleted from the list of members.
Note: When you delete a User from the membership list of a Group, the Group is automatically 
removed from the "Security Equivalence" property of the User.



View or Change an Organizational Role Object 
The "Identification" page describes this Organizational Role object. For example, you can
- Specify which Users currently occupy the role named by this object
- Record information about the occupants of this position, such as their telephone and fax numbers
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Enter a Description for this Organizational Role
Add Another Name for this Organizational Role
Add a Fax or Phone Number for this Organizational Role

Screen regions and buttons
"Name" displays the name of this Organizational Role.

"Other Name" lists other names that this Organizational Role is known by.

"Role" shows the User objects that currently fill this role.

"Description" describes this Organizational Role.

"Location" describes the location of this occupant (such as room number or office).

"Department" shows the department or division that the occupant belongs to.

"Telephone" lists the occupant's telephone numbers.

"Fax Number" lists fax numbers of this occupant.

"E-mail address" lists the occupant's MHS address or other electronic mail ID.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



View or Change an Organizational Unit Object 
The "Identification" page describes this Organizational Unit object. For example, you can
- Record other names this Organizational Unit is known by
- Add a description of the Organization
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Enter a Description for this Organizational Unit
Enter another Name for this Organizational Unit

Screen regions and buttons
"Name" displays the name of this Organizational Unit.

"Other Name" shows other names of this Organizational Unit.

"Description" describes this Organizational Unit.

"Location" gives the location of this Organizational Unit.

"Telephone" lists telephone numbers of people in this Organizational Unit.

"Fax Number" stores the fax numbers of people responsible for this Organizational Unit.

"E-mail Address" lists the Organizational Unit's MHS address or other electronic mail ID.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



View or Change Intruder Detection
The "Intruder Detection" page allows you to set tolerance limits and intruder protection for this container 
object. If a specified number of incorrect login attempts are detected, NetWare assumes that an intruder 
is trying to log in as that User and locks the User's account.
For example, you can set
- The number of consecutive invalid logins that will be accepted before activating intruder detection
- Whether to lock a User's account after detecting an intruder
These limits apply to all User objects in this container. 
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Detect Intruders for Users in this Container
Lock a User's Account When an Intruder Is Detected
Set How Many Incorrect Login Attempts Are Allowed

Screen regions and buttons
"Detect intruders" allows you to track intruder login attempts and lock a User's account.

"Incorrect login attempts" sets the number of incorrect login attempts allowed for all User objects in 
this container.

"Intruder attempt reset interval" allows you to set the length of time you want to record incorrect login 
attempts before resetting the counter back to zero.

"Days, Hour, Minutes" shows the specific length of time that a series of incorrect login attempts are 
tracked.

"Lock account after detection" locks the User's account when the specified number of incorrect login 
attempts occurs in the time designated in the "Days, Hours, Minutes" field.

"Intruder lockout reset interval" allows you to set how long a User's account remains locked after an 
intruder is detected (the incorrect login attempts number is exceeded).

"Days, Hour, Minutes" lets you set a specific length of time that the User's account remains locked 
after an intruder is detected.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Detect Intruders for Users in this Container
1. Select the "Detect Intruders" check box.

All Users who log in to this context will now have the Intruder Detection feature, meaning that if too 
many incorrect login attempts are made, the account can be locked.

2. Set the number of incorrect login attempts allowed and set the length of time to track the number of 
incorrect login attempts.
Example: If the length of time is set for 30 minutes, and the "Incorrect Login Attempts" value is 
reached within that time period, and if the "Lock Account After Detection" box is checked, the account 
will be locked for the duration specified in the "Intruder Lockout Reset Interval" time fields.
The other fields will be grayed until you select the check box in Step 1.

3. Choose "OK."
The changes are not recorded until you choose "OK."



Lock a User's Account When an Intruder Is Detected
1. Select the "Lock Account After Detection" check box.

You must select the "Detect Intruders" check box before you can select this check box.
If too many incorrect login attempts are made for any User in this container, the User's account will be
locked.

2. Set the "Intruder Lockout Reset Interval" for the length of time that you want the User's account to 
remain locked.
The other fields will be grayed until you select the check box in Step 1.

3. Choose "OK."
The changes are not recorded until you choose "OK."



Set How Many Incorrect Login Attempts are Allowed
1. Select the "Detect Intruders" check box.

All Users who log in to this context will now have the Intruder Detection feature, meaning that if too 
many incorrect login attempts are made, the account can be locked.

2. Enter a number in the "Number of incorrect login attempts" field.
The default value is seven. You can allow any number of incorrect attempts.

3. Choose "OK."
The changes are not recorded until you choose "OK."



View or Change an Organization Object 
The "Identification" page describes this Organization object. For example you can
- Record other names of this Organization
- Describe what other objects this Organization contains
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Enter a Description for this Organization
Enter another Name for this Organization

Screen regions and buttons
"Name" displays the name of this Organization.

"Other name" lists other names of this object.

"Description" describes this Organization.

"Location" specifies the location of this Organization.

"Telephone" lists telephone numbers of people in this Organization.

"Fax Number" stores the Fax numbers of people in this Organization.

"E-mail Address" lists E-mail addresses of people in this Organization.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



View or Change a Profile Object 
A Profile object contains a login script that several Users use who are not in the same container, and 
therefore cannot use the container login script to execute a common set of commands. The 
"Identification" page describes the Profile object. 
For example, you can
- List other names that this Profile is called
- View or change the description of this Profile
- View or change the company name where this Profile is used
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Enter a Description for this Profile
Enter another Name for this Profile

Screen regions and buttons
"Name" displays the name of this Profile.

"Other name" lists other names of this Profile.

"Description" describes how this Profile is used.

"Location" specifies the location of the department or Users of this Profile.

"Department" shows the department or Group that uses this Profile.

"Company" shows the company that uses this Profile.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.

Related topics
The Root Object



Profile Object - Other Names
Shows all names by which this Profile is known. These names are for your use only and will not appear 
anywhere but in this dialog.
Use the scroll arrows to see the contents of the list.
Use the "Other name" field to list names that you can use to search for the Profile.

To add or remove names from the list, choose the "More" button. 



View or Change an Alias Object 
The only information stored in an Alias is the name of the object that the Alias refers to.
You can't change information about an Alias object after it has been created. You must delete the Alias 
and create it again if you need to make any changes.



View or Change a Directory Map Object 
The "Identification" page describes the Directory Map object. For example, you can
- View or change the description of what this Directory Map is used for
- View or change the volume and path that this Directory Map contains
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
How to Use a Directory Map with the MAP Command
Change the Path of this Directory Map Object

Screen regions and buttons
"Name" displays the name of this Directory Map.

"Other name" lists other names of this Directory Map.

"Path" shows the complete path that this Directory Map refers to.

"Description" describes how this Directory Map is used.

"Location" shows the physical location of the volume referred to in the "Path" field.

"Department" shows the department that uses this Directory Map.

"Organization" shows the company or organization that uses this Directory Map.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.

Related topic
The Root Object



How to Use a Directory Map with the MAP Command
A Directory Map object can be used with the MAP command in 
- Container login scripts
- Profile login scripts
- User login scripts
Instead of mapping to a specific volume and path on the network where an application is located, you can
map to a Directory Map. The Directory Map contains the specific volume and path to the application.
When the application is moved to a new location on the network, the network supervisor only has to 
change the volume and path in the Directory Map object. Every User will still reference the Directory Map 
and find the application. No login scripts need to be changed.
If the User is not in the same context as the Directory Map, use the complete name of the Directory Map 
in the MAP command.
Example: To reference a Directory Map for a word processing application in the login script, type the 
following command: MAP s16:=.WordPerfMap.Accounting.Novell



Change the Path of this Directory Map Object 

1. Choose the Browser button  to select a Volume name.
Use the Browser button to search the Directory tree for the correct volume if you need to.
Any Volume object in the Directory tree can be used.

2. Enter a path name.
Enter the directory and subdirectories on the selected Volume that contain the desired application.
You can select a path name at the same time that you select a Volume if you wish. The volume and 
path fields will both be filled in.

3. Choose the correct name space.
This should be the correct computer format of the path name you just chose.

4. Choose "OK."
The path of this Directory Map object is updated.
You return to the page showing information about this Directory Map object.



Directory Map - Other Names
Shows all names of this Directory Map. These names are for your convenience and will not appear in the 
Browser. You can use these other names to search for this Directory Map.
To see the list, use the scroll arrows.

To add or remove names from the list, choose the "More" button. 



Directory Map Path 
The "Path" dialog shows the location of the directory path of this Directory Map.

Procedures
Change the Path of this Directory Map Object

Screen regions and buttons
"Volume" shows the Volume that this Directory Map points to. This field is required.

"Path" shows the path that this Directory Map points to. This field is required.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



View or Change a NetWare Server 
The "Identification" page describes the NetWare Server object you selected. For example, you can
- View or change the description of what this NetWare Server is used for.
- View the version of NetWare that this NetWare Server uses.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
See What Operating System this Server Is Using
See the Network Addresses Used by this Server
Enter a Description for this NetWare Server
Enter another Name for this NetWare Server
Enter a Location for this NetWare Server

Screen regions and buttons
"Name" shows the name of this NetWare Server.

"Other name" lists other ways of referring to this NetWare Server. 

"Description" describes this NetWare Server.

"Location" specifies the physical location of this NetWare Server.

"Department" shows the department or group that use this NetWare Server.

"Organization" shows the company or organization that uses this NetWare Server.

"Version" shows the version of NetWare that is installed on this NetWare Server.

"Accounting" installs or removes the accounting function from this NetWare Server.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.

Related topic
The Root Object



See What Operating System this Server Is Using
The "Version" field on the "Identification" page shows which version of the NetWare network operating 
system is being run on this server.
You cannot change this field. NetWare Directory Services determined the value of this field by examining 
the server when the object was created.



See the Network Addresses Used by this Server
The different network addresses that may be used by this server allow it to function as a router between 
different networking systems, such as TCP/IP and IPX/SPX. 
NetWare Directory Services can only access the server on network addresses that are included in this 
list.
To see the network addresses used by this server, scroll through the "Network Addresses" field on the 
"Identification" page.
The network addresses used by this server are listed, each with the appropriate protocol before its 
address.
You cannot change these addresses; they are determined from the network routers.



View or Change an AFP Server    
The "Identification" page describes the AFP Server you selected. For example, you can
- View or change the description of what this AFP Server is used for.
- View the version of AppleTalk that this AFP Server uses.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Enter a Serial Number for this AFP Server
See the Number of Connections Allowed on this AFP Server
Enter a Description for this AFP Server
Enter another Name for this AFP Server

Screen regions and buttons
"Name" shows the name of this AFP Server.

"Other name" lists other ways of referring to this AFP Server.

"Description" describes this AFP Server.

"Location" specifies the physical location of this AFP Server.

"Department" shows the department that uses this AFP Server.

"Organization" shows the company that uses this AFP Server.

"Version" shows the version of the Apple Operating System that is installed on this AFP Server.

"Serial #" shows the serial number of the NetWare product that the AFP Server is using.

"Connections" shows the number of connections allowed by NetWare on this AFP Server.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.

Related topic
The Root Object



See the Number of Connections Allowed on this AFP Server
The number of connections allowed on this AFP server is shown in the "Connections" field on the 
"Identification" page of the object dialog.
You cannot modify the value in this field; it is determined by the software that you are running on the AFP 
server.



NetWare, AFP, or Messaging Server Object - Other Names
This field shows all names by which this Server object is known. These names are for your information 
only and don't appear in the Browser. You can do a search on these names.

To add or remove names from the list, choose the "More" button. 



Accounting for NetWare Servers
If accounting is not active on this NetWare Server and you choose "Accounting," you will be asked if you 
want to install or activate accounting.
If accounting is already active on this NetWare server and you choose "Accounting," you will be asked if 
you want to deactivate accounting.
Accounting lets you define charge rates for five services:
- Disk block reads
- Disk block writes
- Time connected to the server
- Amount of disk storage used
- Requests for actions
The charge rate for each service can be set separately.
When accounting is active, any service that a User uses is charged to that User's account. If the User's 
account balance is depleted, the User may not be able to log into the network.



View or Change the List of Supported Services of a Server
The "Supported Services" page lists services provided by the NetWare Server you selected, such as print 
services or bindery emulation. Administrators can use this page to track the services that are available. 
For example, you can
- View which services this server supports.
- Add or delete from the list of services.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add a New Service
Delete an Existing Service

Screen regions and buttons
"Supported Services" lists all services available on this server. Since the server doesn't automatically 

update this property, this list has no operational effect on the network.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Add a Supported Service
1. Choose the "Add..." button below the "Services" box.
2. Enter the name of the service.
3. Choose "OK."

You return to the "Supported Services" page, and the new service is added to the list.



Delete A Supported Service
1. Select a service from the list in the "Services" list box.
2. Choose "Delete."

The selected service is deleted from the list.



View or Change the List of Resources of a Server
The "Resources" page describes resources available on this server, such as volumes or printers. For 
example, you can
- View which resources this server provides
- Add or delete a resource
This list has no operational effect on the network, but can be used by a network supervisor to record 
information about this server.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add a New Resource
Delete an Existing Resource

Screen regions and buttons
"Resources" lists the complete name of all objects that are resources supported by this server.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Add a Resource
1. Choose the "Add..." button below the "Resources" box.
2. Choose the object that you want to add as a resource.

Because this list is for your information only, you can add any object to the list.
3. Choose "OK."

You return to the "Resources" page, and the new object is listed as a resource.



Delete A Resource
1. Select a resource from the "Resources" list box.
2. Choose "Delete."

The resource is deleted from the list.



View or Change the List of Users for a Server
The "Users" page lists Users of this resource. This list is created and maintained by the network 
supervisor. For example, you can
- View Users who access this resource
- Add or delete a User of this resource
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add a New User
Delete an Existing User

Screen regions and buttons
"Users" lists all User objects that have accounts on this NetWare Server. This list has no operational 

effect on the network, but can be used by a supervisor to record information about this network 
resource.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Add a User
1. Choose the "Add" button below the "Users" list box.

To add a User to a Messaging Server, you must have the Write property right to the User property of 
the Messaging Server. If you have the Supervisor object right to the Messaging Server, this 
requirement is filled.

2. Select any Users that you want to add to the Messaging Server.
3. Choose "OK."

You return to the "Users" page, and the new object is displayed.



Delete a User
1. Select a User from the "Users" list box.
2. Choose "Delete."

The User is deleted from the list.
To delete a User from a Messaging Server, you must have the Write property right to the User 
property of the Messaging Server. If you have the Supervisor object right to the Messaging Server, 
this requirement is filled.



Server Error Log
This page lets you view the error log that is maintained by this NetWare Server. All error conditions that 
occur during this server's operations are recorded here, and remain here until the error log is cleared.
Errors in the error log can include:
- A file cannot be migrated
- An NLM requested memory but none was available
- A section of a mirrored hard disk becomes inoperable
Many errors are automatically fixed by NetWare. Study this error log to see where problems are 
occurring, and check or modify your network so that future problems will not become more serious.

Procedures
How to Use the Object Dialog
Clear the Error Log
View the Error Log



Clear the Server Error Log
The server error log is displayed in the edit window as soon as you select the Error Log page. It is a 
record of activity on the server. You can use the scroll bars on the right side and bottom of the edit window
to view different sections of the error log.
To clear the Error Log, choose "Clear Error Log."
The error log is erased and a new log is begun with the next error encountered by the server.
Because the error log is created by the server from its own operations, you cannot change the server 
error log, you can only clear it.
Note: You can use the Copy (<Ctrl><Insert>) and Paste (<Shift><Insert>) functions of Windows to copy 
any portion of the error log to another Windows application before clearing it.



View the Server Error Log
The server error log is displayed in the edit window as soon as you select the Error Log page. It is a 
record of activity on the server. You can use the scroll bars on the right side and bottom of the edit window
to view different sections of the error log.
Because the error log is created by the server from its own operations, you cannot change the server 
error log; you can only erase or clear it.
Note: You can use the Copy (<Ctrl><Insert>) and Paste (<Shift><Insert>) functions of Windows to copy 
any portion of the error log to another Windows application.



Accounting for Blocks Read
The "Blocks Read" page lists rates charged by accounting services for resources of this NetWare Server. 
For example, you can
- View times when each charge rate is in effect
- Change the formula used to calculate any charge rate
 Each block that is read from the hard disk by a User during a certain day and hour is charged the 
corresponding rate shown on this page.
No reports can be generated.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Charge Rate
Delete a Charge Rate
Change a Charge Rate
Find What Rate Is Charged on a Certain Day and Time
Change What Rate Is Charged on a Certain Day and Time

Screen regions and buttons
Day and Time Grid
Undo Button
Time and Charge Rate Text
Charge Rates List Box
Add Charge Rate Button
Delete Charge Rate Button

Related topics
Determining Charge Rate Multipliers and Divisors
What to Charge For
How Charge Rates Affect a User's Account Balance



Accounting for Blocks Written
The "Blocks Written" page lists rates charged for resources used on this server. For example, you can
- View times when each charge rate is in effect
- Change the formula used to calculate any charge rate
Each block that is written to the hard disk by a User is charged the corresponding rate shown on this 
page.
No reports can be generated.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Charge Rate
Delete a Charge Rate
Change a Charge Rate
Find What Rate Is Charged on a Certain Day and Time
Change What Rate Is Charged on a Certain Day and Time

Screen regions and buttons
Day and Time Grid
Undo Button
Time and Charge Rate Text
Charge Rates List Box
Add Charge Rate Button
Delete Charge Rate Button

Related topics
Determining Charge Rate Multipliers and Divisors
What to Charge For
How Charge Rates Affect a User's Account Balance



Accounting for Connect Time
The "Connect Time" page lists rates charged for connecting to this NetWare Server. For example, you can
- View times when each charge rate is in effect
- Change the formula used to calculate any charge rate
For each minute that a User is connected to this NetWare Server, the User is charged the corresponding 
rate shown on this page.
No reports can be generated.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Charge Rate
Delete a Charge Rate
Change a Charge Rate
Find the Charge Rate for a Certain Day and Time
Change the Charge Rate for a Certain Day and Time

Screen regions and buttons
Day and Time Grid
Undo Button
Time and Charge Rate Text
Charge Rates List Box
Add Charge Rate Button
Delete Charge Rate Button

Related topics
Determining Charge Rate Multipliers and Divisors
What to Charge For
How Charge Rates Affect a User's Account Balance



Accounting for Disk Storage
The "Disk Storage" page lists rates charged by accounting services for storing data on this server. For 
example, you can
- View times when each charge rate is in effect
- Change the formula used to calculate any charge rate
Users are charged for each block on the hard disk for which they are listed as the owner of the file or 
directory occupying that block.The rates charged correspond to the rates shown on this page.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Charge Rate
Delete a Charge Rate
Change a Charge Rate
Find the Charge Rate for a Certain Day and Time
Change the Charge Rate for a Certain Day and Time

Screen regions and buttons
Day and Time Grid
Undo Button
Time and Charge Rate Text
Charge Rates List Box
Add Charge Rate Button
Delete Charge Rate Button

Related topics
Determining Charge Rate Multipliers and Divisors
What to Charge For
How Charge Rates Affect a User's Account Balance



Accounting for Service Requests
The "Service Requests" page lists rates charged for requesting services on this NetWare Server. For 
example, you can
- View times when each charge rate is in effect
- Change the formula used to calculate any charge rate
Each time a workstation requests a service, that User is charged the corresponding rate shown on this 
page.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Charge Rate
Delete a Charge Rate
Change a Charge Rate
Find the Charge Rate for a Certain Day and Time
Change the Charge Rate for a Certain Day and Time

Screen regions and buttons
Day and Time Grid
Undo Button
Time and Charge Rate Text
Charge Rates List Box
Add Charge Rate Button
Delete Charge Rate Button

Related topics
Determine Charge Rate Multipliers and Divisors
What to Charge For
How Charge Rates Affect a User's Account Balance



Add a Charge Rate
You can have up to 20 different charge rates on this NetWare Server (4 for each of the 5 accounting 
categories that you can charge for). If you enter a new charge rate, but do not use it in the day and time 
grid, it will not be saved in the list of charge rates when you close the object dialog.
Before you begin, you must determine the multiplier and divisor used to compute charges for each User 
who uses this resource on this server.

To add a charge rate
1. Choose "Add Charge Rate."
2. Enter a value in    the "Multiplier" field.
3. Enter a value in the "Divisor" field.
4. Choose "OK."

You return to the page showing the grid of charges for each day and time.



Delete a Charge Rate
1. Select a charge rate from the box in the middle of the page that lists all charge rates.

You can't delete a charge rate if it still appears in the day and time grid. You must change the rate 
charged at those times so that the charge rate you want to delete is no longer in use.

2. Choose "Delete Charge Rate."
The selected charge rate is deleted from the list



Change a Charge Rate
To change a charge rate, you must delete it and re-enter it with new values. You must also change all 
days and times that use the rate.

To change a charge rate
1. Select the charge rate that you want to change from the list of charge rates in the middle of the page.

You can't delete a charge rate if it still appears in the day and time grid. You must change the rate 
charged at those times so that the charge rate you want to delete is no longer in use.

2. Choose "Delete Charge Rate."
3. Choose "Add Charge Rate."
4. Enter values for the new charge rate.

Note: You must determine the multiplier and divisor for the new rate.
5. Choose "OK" to return to the page showing all charge rates.
6. Select the new charge rate in the "Charge rate" box.
7. Block out the days and times that the charge rate should apply to.



Find the Charge Rate for a Certain Day and Time

If you use a mouse
Put the pointer on the cell that represents the day and time for which you want to know the charge rate 
(the day and time that you are pointing to are shown below the day and time grid after "Time").
The number of the charge rate is shown after "Charge rate." Look at the line corresponding to the number
shown here to see the amount charged at that time.

If you use a keyboard
Use the <Tab> key to move on the screens. Then use the arrow keys to move the cursor in the day and 
time grid to the cell that represents the day and time for which you want to know the effective charge rate 
(the day and time that you are pointing to are shown below the day and time grid after "Time").
The number of the charge rate is shown after "Charge rate." Look at the line corresponding to the number
shown here to see the amount charged at that time.



Change the Charge Rate for a Certain Day and Time

If you use a mouse
1. Select the charge rate that you want to use from the list of charge rates
2. Select the cell representing the day and time that you want that charge rate to apply to.

You can click and drag to cover a larger area of the grid.
The "Time" indication under the grid changes as you move the pointer around.

If you use a keyboard
1. Select the charge rate that you want to use from the list of charge rates by using the <Tab> key and 

the <Spacebar>.
2. Use <Tab> to move to the day and time grid. Then use the arrow keys to move the cursor in the grid 

to the cell representing the day and time that you want that charge rate to apply to.
3. Select that cell by pressing the <Spacebar>.

The cell changes to the color representing the selected charge rate.
4. Repeat this process for each cell that you want the selected charge rate to apply to.



Day and Time Grid
You can specify a different charge rate for each half hour of each day of the week. Each cell in the Day 
and Time grid represents one half hour of the week.
Each row of cells from left to right is one 24-hour day.The seven days of the week are listed to the left of 
the grid. The "Time" indicator below the grid shows the day of the week and the time of day that you are 
pointing to.
Example: To set a charge rate for work hours, select all cells from Monday at 8 a.m. to Friday at 5 p.m. 
and fill it with one charge rate (shown by that charge rate's color).
You can have up to a total of 20 charge rates among the five accounting categories.
If you enter a new charge rate, but do not use it in the day and time grid, it will not be saved in the list of 
charge rates when you close the object dialog.



Undo Button
If you accidentally change the charge rate in an area of the Day and Time grid, choosing "Undo" returns 
the grid to its previous state.
"Undo" does not undo a deletion of a charge rate after you choose "Delete Charge Rate."



Time and Charge Rate Fields
Two fields are under the Day and Time grid to help you assign charge rates:

"Time" shows the cell you are pointing at, indicated by the day of week and time

"Charge rate" shows the charge rate in effect for that day and time.

Watch these fields when you work in the grid to make sure you are assigning charge rates for the correct 
days and hours.



Charge Rates List Box
This box lists all charge rates that can be assigned to this resource on this server. Each charge rate is 
made up of a multiplier and a divisor.
You can have a total of 20 charge rates for all five accounting categories.
A color is assigned to each charge rate and is used to display squares in the day and time grid for which 
that charge rate is assigned.
If you enter a new charge rate, but do not use it in the day and time grid, it will not be saved in the list of 
charge rates when you close the object dialog.



Add Charge Rate Button
When you choose "Add Charge Rate" you see a dialog where you enter a multiplier and a divisor as a 
new charge rate. The new charge rate is added to the list of charge rates that can be assigned to any 
square of the day and time grid.
You must use no more than four or five charge rates for each accounting category. (The total number of 
charge rates for all five categories together is 20.)
If you enter a new charge rate, but do not use it in the day and time grid, it will not be saved in the list of 
charge rates when you close the object dialog.



Delete Charge Rate Button
This button deletes the selected charge rate from the list of charge rates.
You can delete only charge rates that are not used in the Day and Time grid. To delete a charge rate that 
is still in use, you must change the charge rate for those days and times.
This deletion can't be undone. You must reenter the deleted values with "Add Charge Rate" and select the
days and times again.



Determine Charge Rates
Charge rates are not defined with units such as dollars. We recommend that you use cents or an 
equivalent value.
There are two ways to determine charge rates.

If you know how much to charge per resource unit
If you know how much you want to charge for the entire resource



Determine a Charge Rate
You can set a charge rate for the amount you want. For example, you know that you want to charge 1 
cent for each block read.
Note: A User's balance is defined as cents.
1. Convert the amount you want to charge into a fraction.

If the amount is a whole cent amount, like 2 or 3 cents, then the fraction is that number over 1; for 
example, 2/1.
If the amount is a fraction, like 1.75 cents, then multiply it by 10 enough times to get rid of the decimal
(this is the value for the multiplier field), then put a 10 underneath the multiplier (this is the value for 
the divisor field). For example, 1.75 times 10 equals 17.5, with one 10 underneath. So our first 
fraction is 17.5/10. Since the number is still a fraction, repeat the process: 17.5 times 10 equals 175. 
with another 10 underneath.So the new fraction is 175 over 10 times 10, or 175/100.

2. Enter the top number as the multiplier. (175 in our example.)
3. Enter the bottom number as the divisor. (100 in our example.)



Charge for a Resource
You can charge for an entire resource used. For example, you know that you want to charge $200 per 
month for disk storage to cover your costs, and there are usually 100,000 blocks used on your 500 MB 
hard disk.
The fraction created by dollars per disk block is $200 over 100,000, or in cents, 20,000 over 100,000. This
reduces to 2 over 10.
1. Enter the cents amount as the multiplier (the top number).

This is 2 in our example.
2. Enter the disk block amount (or other resource used) as the divisor (the bottom number).

This is 10 in our example.
This fraction comes out to two tenths of one cent per disk block used to store data. So if a User had 1 
MB of word processing and spreadsheet files stored on the hard disk, he or she would be charged 
about 51 cents per month.



What to Charge For
As a general rule, charge Users for server resources that are scarce or that you want to limit use of. For 
example,
- If disk storage space is scarce or you want to encourage Users not to keep old files on the hard disk, 

charge for disk storage space.
- If network traffic is heavy and you want Users to limit their overall use of the network, charge for 

service requests.
- If you run out of NetWare connections regularly, charge for connect time so that Users log in only 

when they really need the network.
You can also charge for more than one resource. If no charge rates are entered in the Day and Time grid 
for a resource, then no Users are charged for that resource.



How Charge Rates Affect a User's Account Balance
Each User can have an account balance that determines the amount of network resources that the User 
can use. If you set "No Limit" in the User's object dialog "Account Balance" page, then accounting and 
charge rates have no effect.
If a User does have an account limit and uses a service for which an accounting charge rate has been 
specified, the amount of that service is deducted from the User's account balance. 
When the User's credit limit is reached or the account balance is zero, the User can no longer log in to the
network until the account balance is changed.
Example: User GINA pays $50 to use the network, so her account balance is set to 5000. You charge 2 
cents for each block read and 1 cent for each minute of connect time. Each time GINA reads a block of 
information from a volume attached to that NetWare Server, her account balance is reduced by 2 cents. 
Each minute that GINA is attached to that NetWare Server, her account balance is reduced by 1 cent. 
After several weeks, GINA's account balance is zero. She is logged out and can't log in again until the 
network supervisor updates her account balance.



View or Change a Volume Object 
A Volume object provides a place in the Directory database to record and view information about a 
physical volume that was installed on a NetWare Server.
By "pointing" a Volume object to a physical volume, you can see the directories and files on the volume. 
The Volume object is like a link between NetWare Directory Services and the file system of a physical 
volume. Information about both appears when you view a Volume object.
Volume is a leaf object. Directories and files (the file system of the physical volume) are shown under it, 
however, like leaf objects are shown under container objects.
The "Identification" page describes this Volume object. For example, you can
- View the name of the physical volume
- View or change the department that this volume is used in.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
List the Files on this Volume
See the Physical Name of this Volume
See Which Server this Volume is Attached To
Enter another Name for this Volume
Enter a Location for this Volume

Screen regions and buttons
"Name" shows the name of this Volume object.

"Host Server" shows the name of the NetWare Server on which this volume is physically located. This
field can't be changed.

"Host Volume" shows the physical volume name. This field can't be changed.

"Other name" lists other ways of referring to this object.

"Location" shows the physical location of the NetWare Server that contains this Volume.

"Department" shows the department that uses this Volume.

"Organization" shows the company that uses this Volume.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.

Related topics
The Root Object
Trustees and Trustee Paths
The Root Directory of a Volume - Assigning Rights



List the Files on This Volume
In the NetWare Administrator, you can manage files and directories on a NetWare volume. Files and 
directories are displayed below the Volume object as a continuation of the Directory structure, even 
though they are actually a part of a file system and not the NetWare Directory Services database.
You can select and expand a Volume object like any container object, provided that you have these rights:
- Browse object right to the Volume object
- Read property right to the Host Server and Host Volume properties of the Volume object (these were 

granted to every object by default when the Volume object was created)
- File Scan directory right to the root directory of the volume
Remember that you must have rights to the ACL property to change object or property rights, and you 
must have the Access Control directory right to change rights to the root directory.
Also, remember that Supervisor rights to the file system on the volume are granted through the NetWare 
Server object on which this volume is installed.



See the Physical Name of this Volume
The physical volume name of the volume that this Volume object refers to is shown in the "Host Volume" 
field on the "Identification" page of the Volume object dialog. The physical volume name is also referred to
as the host resource name.
The physical volume name is assigned when a volume is installed. Volume SYS: must exist for every 
NetWare server, but other volumes on the server can have any name that follows volume naming 
conventions. 
The physical volume name cannot be changed by NetWare Directory Services. You can use the NetWare 
Console INSTALL.NLM to change the physical volume name, but INSTALL.NLM does not change the old 
volume object.



See Which Server this Volume is Attached To
The physical NetWare Server that this volume is attached to is shown in the "Host Server" field of the 
"Identification" page of the object dialog for this Volume. The Host Server was specified when the Volume 
object was created and cannot be changed. 
The Host Server provides NetWare Directory Services an address to find the Volume on the network.
You can view the object dialog for the NetWare Server object representing the Host Server in order to find
out more about that server.



Volume Object - Other Names
This field shows all names by which this Volume object is known. These names are for your convenience 
only and will not appear in the Browser. 
Use "Other Name" to record information that you want to use to search for this Volume.
To see the list, use the scroll arrows.

To add or delete names, choose the "More" button. 



View Statistics About a Volume Object 
The "Statistics" page describes the use of the Volume object you selected. For example, you can
- View how space on this Volume is used
- See which name spaces and features are installed on this Volume
You can't change the information on this page.
A Volume object provides a place in the Directory database to record and view information about a 
physical volume that was installed on a NetWare Server.
By creating a Volume object and "pointing it" to a physical volume, you can see the directories and files 
on the volume from within the NetWare Administrator and other utilities. 
Volume is a leaf object. Directories and files (the file system of the physical volume) are shown under it 
like leaf objects are shown under container objects.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
See How Much Disk Space Is Available
See How Many Directory Entries Are Available
See the Block Size Used on this Volume
See if this Volume is Removeable or Not
See How Much Space is Used by Deleted Files
See How Much Space is Saved by Compression
See How Many Files Have Been Migrated
See Which Name Spaces Are Installed on this Volume
See Which Features Are Installed on this Volume
List the Files on this Volume

Screen regions and buttons
"Block size" shows the block size used by files on this volume.

"[Non-]removeable volume" indicates if this is a permanent or a removeable volume.

"Disk Space" shows the percentage of the volume used.

"Directory entries"shows how many directory entries are used.

"Deleted Files" shows the number and size of files that have been deleted but not purged from the 
volume.

"Migrated Files" shows the number and size of files that have been migrated to a secondary storage 
device.

"Compressed Files" shows the number and size of files that have been compressed.

"Name spaces" lists which name spaces are loaded on this volume.

"Installable features" lists features installed on this volume, such as compression or auditing.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Block Size
This field indicates the block size used by this volume. The block size was determined when the volume 
was installed. Block size can't be changed without re-installing the volume.
Space on a volume is allocated to files in blocks. The minimum amount of disk space that a file can use is
one disk block, and subsequent space allocations are also a multiple of the block size. 
Example: If the block size is 4 KB, a file with only one line of text will still use 4 KB of disk space because
that is the smallest amount of disk space that can be allocated to any file.
A smaller block size will save disk space for smaller files, but make access to larger files less efficient. A 
larger block size will make access to very large files much quicker, but will waste disk space for each 
small file.
Block suballocation allows several files to share one disk block. This eliminates most of the wasted space 
caused by large block sizes. See Concepts for more information.



[Non-]Removeable Volume Flag
This flag is set automatically. When a volume is installed, NetWare determines the type of storage device 
it is and sets this flag.
Non-removeable volumes include hard drives.
Removeable volumes contain cartridges or optical disks that can be taken out of the drive.



Disk Space Chart
This chart shows how much of this volume is in use. The total size of the volume and the remaining free 
space are shown numerically below the graphic representation.
You can't change this information here. To change the amount of space used, you must create or delete 
files, add or remove name spaces, or perform similar actions.
Colored areas indicate the space that is used. This is also shown by the percentage at the right of the 
chart.

Screen regions and buttons
"Total" shows the total size of the volume in bytes.

"Available" shows the amount of space available on the volume in bytes. (This is indicated by white 
areas.)



Directory Entries Chart
This chart shows how many directory entries are used on this volume. The total number of directory 
entries and the entries that are still available are shown numerically below the graphic.
A directory entry is used by each file and directory for each name space on a volume, as well as by 
multiple trustee assignments to a file or directory. See Concepts for more information.
Note: You can't change this information. The number of directory entries available on each volume is 
determined by the block size used on the volume, which must be set when the volume is installed. Each 
directory entry uses 128 bytes, and a maximum of 65,536 disk blocks can be used for directory entries. 
So the maximum number of directory entries on a volume is the block size (in KB) times 524,288.

Screen regions and buttons
"Total" shows the total number of directory entries that can be on the volume.

"Available" shows the number of directory entries still available on the volume. It is indicated by white 
areas.



Migrated Files
This box shows how many files on this volume have been migrated to a secondary storage device, and 
how much disk space was saved by migrating them.
Note: If this box is grayed, you do not have data migration installed as a feature on this volume.

Screen regions and buttons
"Count" shows the number of files on this volume that are currently migrated to a secondary storage 

device.

"Actual size" shows the total size of all files that have been migrated to a secondary storage device. 
To bring all migrated files back to the volume, you would need this much disk space. This number 
can be larger than your entire volume since the secondary storage device can be larger than the 
volume from which files are migrated.



Compressed Files
This box shows how many files on this volume have been compressed by NetWare, and how much disk 
space was saved by compressing them.
Note: If this box is grayed, you do not have compression installed as a feature on this volume.

Screen regions and buttons
"Count" shows the number of files on this volume that have been compressed.

"Uncompressed size" shows the space that all files in the "Count" field would use on the volume if 
they were not compressed.

"Compressed size" shows the space that all of the files in the "Count" field are actually using while 
they are compressed.

"Average compression" shows the average amount of space saved by compressing a file, as a 
percentage of its original size. The formula used to calculate this for each file is (Uncompressed 
size minus Compressed size) divided by Uncompressed size.



Name Spaces Box
This box lists name spaces that are installed on this physical volume.
Name spaces can be added to the volume at any time by the network supervisor using the LOAD 
command at the server console prompt. Each name space uses another directory entry for every file or 
directory on the volume.
See Concepts for more information.



Installed Features Box
This lists features that are installed on the volume. A feature must be installed on a volume for the files on 
that volume to be able to use it.
Some features can be installed or removed at the server console. Other features must be chosen when 
the volume is installed and can't be changed.
Possible features are:
- Block suballocation: allows disk blocks to be shared by several files to prevent wasted disk space
- Compression: compresses files that have not been used recently to conserve disk space
- Data migration: moves files that have not been used recently to a secondary storage device until they 

are requested
- Auditing: allows a network auditor to track file and NetWare Directory Services transactions
- Read Only: indicates that this volume is Read Only (can be read but not written to, such as a CD-

ROM drive).



Deleted Files
This lists the space used on this volume by files that have been deleted but are still stored on the volume.
NetWare saves all deleted files for a time in case they need to be salvaged and reused after they have 
been deleted.
You can set the amount of time to wait before purging deleted files (permanently erasing them), or have 
them purged immediately when they are deleted. If a volume is full, the oldest deleted files are purged 
first to make space for current files to be stored.

Screen regions and buttons
"Count" shows how many deleted files are stored on this volume. All deleted files referred to in this 

number are listed as "unpurgeable" or "purgeable" in the two fields below.

"Unpurgeable size" indicates the total size of all deleted files that can't be purged yet. This refers to 
the "Minimum delay to purge files" parameter in the NetWare Server console. Files that have 
been deleted less than that amount of time can't be purged.

"Purgeable size" indicates the total size of all deleted files that can be purged. These files have been 
deleted at least the "Minimum delay to purge files," but they have not been purged yet.



View or Change Dates and Times Related to a Volume 
The "Dates and Times" page describes the way this Volume object has been used. You can
- View the owner of this Volume
- View the last user to archive the Volume
- View the date of creation or archive for this Volume
A Volume object provides a place in the Directory database to record and view information about a 
physical volume that was installed on a NetWare Server.
By creating a Volume object and "pointing it" to a physical volume, you can see the directories and files 
on the volume from within the NetWare Administrator and other utilities.
Volume is a leaf object. Directories and files (the file system of the physical volume) are shown under it 
like leaf objects are shown under container objects.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
List the Files on this Volume
Change the Creation Date or Time
Change the Owner
Change the Archived Last Date or Time
Change the Archived Last By

Screen regions and buttons
"Created on" shows the date and time that this Volume was installed.

"Owner" shows the User object that installed this volume.

"Modified last on" shows the date and time when the information on this screen was last updated by 
NetWare. You cannot change this information.

"Archived last on" shows the date and time when this Volume was partially or completely backed up. 
This field is set when the Archive attribute of the Volume's root directory is reset by a backup 
application.

"Archived last by" shows the User object that was operating the backup application that most recently 
backed up (all or part of) this volume. This field is set when the Archive attribute of the Volume's 
root directory is reset by a backup application.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.

Related topics
The Root Object
Trustees and Trustee Paths
The Root Directory of a Volume - Assigning Rights



Change the Creation Date and Time of a Volume
1. Select the section of the "creation date or time" field that you want to change.
2. Choose the arrow to the right of the field that you selected.

2a. The Up arrow advances the date or time.
2b. The Down arrow decreases the date or time.

3. To return to the Browser, choose "OK."



Change the Owner of a Volume
1. Select the "Owner" field.
2. Enter the name of the User that should be the owner of this volume. You can do this by choosing the 

icon to the right of the field  to choose a User object from the "Select Object" dialog.
3. To return to the object dialog, choose "OK."



Change the Modified Date and Time of a Volume
1. Select the section of the "Modified date or time" field that you want to change.
2. Choose the arrow to the right of the field that you selected.

2a. The Up arrow advances the date or time.
2b. The Down arrow decreases the date or time.

3. To return to the Browser, choose "OK."



Change the Archived Date and Time of a Volume
1. Select the section of the "Archived date or time" field    that you want to change.
2. Choose the arrow to the right of the field that you selected.

2a. The Up arrow advances the date or time.
2b. The Down arrow decreases the date or time.

3. To return to the Browser, choose "OK."



Change Who Archived a Volume
1. Select the "Archived Last by" field.
2. Enter the name of the User that last archived (backed up) this volume. You can do this by choosing 

the icon to the right of the field  to choose a User object from the Browser.
3. To return to the object dialog, choose "OK."



View or Change User Space Limits on a Volume 
This Volume is located on a NetWare v2.x or v3.x server, or is being viewed on a different Directory tree 
through bindery emulation. The "User Space Limits" page describes all users' space limitations on this 
Volume object. For example, you can
- View a User's space restrictions
- Change a User's space restriction for this volume
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
List the Files on this Volume
See a User's Space Restrictions on this Volume
Change a User's Space Restrictions on this Volume

Screen regions and buttons
"User list" shows all Users who are using space on this volume, and details about their usage.

"Display number of files and directories" allows you to see how many files and directories on this 
Volume this User is the owner of.

"Modify button" opens a dialog for the selected User that lets you change or remove its space limits 
for this volume.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.

Related topics
The Root Object
Trustees and Trustee Paths
The Root Directory of a Volume - Assigning Rights



View or Change User Space Limits on a Volume 
The "User Space Limits" page describes all Users' space limitations on this Volume object. For example, 
you can
- Select which area of the Directory tree you want to see Users from
- View a User's space restrictions
- Change a User's space restriction for this Volume
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
List Files on This Volume
Select Which Part of the Directory Tree You See Users From
See a User's Space Restrictions on this Volume
Change a User's Space Restrictions on this Volume

Screen regions and buttons
"Context" tells which container to begin searching for Users to list here. Listing Users from only part of

the Directory tree is much faster and only lists Users that you are interested in.

"Search Entire Subtree" determines whether everything below the "Context" is searched for Users, or 
only those leaf objects directly below the container object listed in "Context."

"User list" shows all Users who are using space on this Volume and details about their usage.

"Display number of files and directories" allows you to see how many files and directories on this 
Volume this User is the owner of.

"Modify button" opens a dialog for the selected User that lets you change or remove its space limits 
for this Volume.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.

Related topics
The Root Object
Trustees and Trustee Paths
The Root Directory of a Volume - Assigning Rights



Select Which part of the Directory Tree You See Users From
Use this dialog to limit the part of the Directory tree where Users are searched for to display their space 
limitations to this Volume. 
The smaller a section of the Directory tree you select, the more quickly the dialog will appear.

To select a section of the Directory tree
1. Select the Browser button to the right of the "Context" field.
2. Select a container object.

This page will list the space limitations for all Users under this container.
3. Select the "Search Entire Subtree" check box.

If you do not select this check box, only leaf objects directly below the container that you selected will 
be included in the list of Users. This is faster if you know exactly where the User that you want is 
located.



See a User's Space Limits
1. Select the User whose limits you want to view.
2. Look in the "Limit" field to see how much space this User is allowed on this Volume.

A User is using space when that User is the owner of a file or directory.
Access will be denied if the User tries to create new files or increase the size of files when the space 
limit is exceeded.



Change a User's Space Limits
1. Select the User whose space restrictions you want to change.
2. Choose "Modify."

The "User" field shows the name of the User.
The amount of space (in thousands of bytes) that the User is now using is shown in "Volume space 
used by user."

3. To remove the User's space restrictions, select the "Limit Volume Space" check box.
When the "Limit Volume Space" check box is not selected, the User can use any free space on the 
Volume.

4. To change the User's space restrictions:
4a. Make certain that the "Limit Volume Space" check box is selected.
4b. Enter a value in the "Volume space limit" field.
This value is in KB. If you enter 5000, the user can use a maximum of 5,000,000 bytes, or 5 
megabytes of volume space.
A user is using space when that user is the owner of a file or directory.
Access will be denied if the user tries to create new files or increase the size of files when the space 
limit is exceeded.

5. Choose "OK" to return to the "User Space Limits" page.



Volume User Space Limits - User List Box
The "User" list box lists all Users who are listed as the owners of any file or directory on this volume.

Screen regions and buttons
"User's name" is the username listed as the owner for one or more files or directories.

"Limit" is the maximum amount of volume space that this User can use. Access will be denied if the 
User exceeds this limit and then tries to create new files or increase the size of existing files. If 
the User has no space restriction on this volume, this field is labeled "Unlimited."

"Space used" shows how much space the User is currently using on the volume. It is the sum of the 
sizes of all files and directories that list this User as their owner.

"Available" is the difference between the space limit and the space used if there is a space restriction,
or the amount of free space on the volume if there is no space restriction for this User.



Volume User Space Limits - Modify Button
The "Modify" button opens a dialog that lets you change a User's volume space restriction. You can also 
remove the space restriction so that the User has no space restrictions.
The dialog that appears shows the User that you selected and lets you enter a new value for the space 
restriction or check a box to indicate that this User has no space restriction.



View a Directory Name 
Note: Use the "Rename" option on the "Object" menu to rename this directory.
The "Identification" page describes the directory you selected. For example, you can
- View    the name of the directory
- View which name spaces are available on the Volume where this directory is located
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
See What Name Spaces Are Used on this Volume
See What this Directory Is Called in Each Available Name Space

Description of name space formats
"DOS" is used by IBM PC and compatibles, including Windows.

"Macintosh" is used by all Apple Macintosh computers.

"FTAM" is a standard file system used by many mainframe and minicomputers.

"NFS" (Network Filing System) is used by Unix and RISC workstations.

"OS/2" is used by the IBM OS/2 Operating System on IBM PC and compatibles for OS/2 High 
Performance File System. Files and directories can have long names and properties similar to 
those used by NetWare Directory Services objects.

Related topics
Trustees and Trustee Paths
The Root Directory of a Volume - Assigning Rights



View or Change a File or Directory Name
The "Identification" page describes the file or directory that you selected. This file is located on a volume 
with a version of NetWare previous to v3.11. This volume does not support name spaces for different file 
formats. 
For example, you can 
- View the name of the file or directory
- Rename a file or directory
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Rename a File or Directory

Related topics
Trustees and Trustee Paths
The Root Directory of a Volume - Assigning Rights



Rename a File or Directory
1. Select the "New name" field.
2. Enter a new name for the file or directory.
3. Choose "OK."



Directory Facts 
The "Facts" page shows statistical information about this directory. For example, you can
- View the date and time this directory was created
- Change the owner of the directory
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Restrict the Size of a Directory
Change the Size Restriction of a Directory
Change the Creation Date and Time of a Directory
Change the Owner of the Directory
Change the Date or Time the Directory Was Last Modified
Change the Date or Time the Directory Was Last Archived
Change Who Last Archived the Directory

Screen regions and buttons
"KB available to directory" shows the number of kilobytes available to the directory.

"Restrict size" shows whether the directory is restricted in size.

"Limit" shows the directory's maximum number of 4K blocks (if directory size is restricted).

"Created date and time" shows when the directory was first created.

"Owner field" shows the owner of this directory.

"Last Modified date and time" shows the last time the directory was modified.

"Last Archived date and time" shows the last time the directory was archived. This field and the 
"Archiver" field are set when the Archive attribute of this directory is reset by a backup application.

"Archiver" field shows who last archived the directory.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.

Related topics
Trustees and Trustee Paths
The Root Directory of a Volume - Assigning Rights



Restrict the Size of a Directory
1. Select the "Restrict size" check box.
2. Select the "Limit" field.
3. Enter the number of 4 KB blocks to limit this directory to.

Any value up to the number of free blocks on the Volume can be entered.
4. Choose "OK."

You return to the Browser.



Change the Size Restriction of a Directory
1. Select the "Limit" field.
2. Enter the new number of 4 KB blocks to limit this directory to.

Any value up to the number of free blocks on the volume can be entered.
3. Choose "OK."

You return to the Browser.



Change the Creation Date and Time of a Directory
1. Select the section of the "Creation date or time" field that you want to change.
2. Choose the arrow to the right of the field that you selected.

2a. The Up arrow advances the date or time.
2b. The Down arrow decreases the date or time.

3. Choose "OK."
You return to the Browser.



Change the Owner of a Directory
1. Select the "Owner" field.
2. Enter the name of the User that should be the owner of this directory. You can do this by choosing the

icon to the right of the field  to choose a User object from the Browser.
3. Choose "OK."

You return to the object dialog.



Change the Last Modified Date or Time of a Directory
1. Select the section of the "Modified date or time" field that you want to change.
2. Choose the arrow to the right of the field that you selected.

2a. The Up arrow advances the date or time.
2b. The Down arrow decreases the date or time.

3. Choose "OK."
You return to the object dialog.



Change the Last Archived Date or Time of a Directory
1. Select the section of the "Archived date or time" field that you want to change.
2. Choose the arrow to the right of the field that you selected.

2a. The Up arrow advances the date or time.
2b. The Down arrow decreases the date or time.

3. Choose "OK."
You return to the object dialog.



Change Who Last Archived a Directory
1. Select the "Archiver" field.
2. Enter the name of the User that last archived (backed up) this directory. You can do this by choosing 

the icon to the right of the field  to choose a User object from the Browser.
3. Choose "OK."

You return to the object dialog.



Directory Attributes - v2.x and v3.x Directories    
The "Attributes" page shows attribute information about this directory or volume. Any attribute that is 
checked is in effect for this directory. For example, you can
- See which attributes are assigned to this directory
- Change attributes of this directory
If you select a volume, the attributes are for the root directory of that volume.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Change the Directory Attributes

Screen regions and buttons
"Directory Attributes" shows the attributes of this directory.



Directory Attributes 
The "Attributes" page shows attribute information about this directory or volume. Any attribute that is 
checked is in effect for this directory. For example, you can
- See which attributes are assigned to this directory
- Change attributes of this directory
If you selected a volume, the attributes are for the root directory of that volume.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Change the Directory Attributes

Screen regions and buttons
"Directory Attributes" shows the attributes of this directory.



Change the Directory Attributes
Directory attributes describe how users and NetWare can use a directory. You can set the attributes to suit
your working environment.

To change the directory attributes
1. Select the check box for the attribute you want to change.

If the attribute was checked, it will be cleared. If the attribute was clear, it will be checked. Any 
attribute that is checked is in effect for this directory.

2. Choose "OK."



Directory Attributes List

Directory attributes
Delete Inhibit
Hidden
Purge
Rename Inhibit
System
Don't Migrate
Immediate Compress
Don't Compress



Directory Attributes List - v2.x and v3.x directories

Directory Attributes
Delete Inhibit
Hidden
Purge
Rename Inhibit
System



View a Filename 
Note: Use the "Rename" option on the "Object" menu to rename this file.
The "Identification" page describes this file. For example, you can
- View the name of the file
- View which name spaces are available on the volume where this file is located
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
See What Name Spaces Are Used on this Volume
See What this File is Called in Each Available Name Space

Description of name space formats
"DOS" is used by IBM PC and compatibles, including Windows.

"Macintosh" is used by all Apple Macintosh computers.

"FTAM" is a standard file system used by many mainframe and minicomputers.

"NFS" (Network Filing System) is used by Unix and RISC workstations.

"OS/2" is used by the IBM OS/2 Operating System on IBM PC and compatibles for OS/2 High 
Performance File System. Files and directories can have long names and properties similar to 
those used by NetWare Directory Services objects.

Related topics
Trustees and Trustee Paths



File Facts 
The "Facts" page shows statistical information about this file. For example, you can
- View the date and time this file was created
- Change the owner of this file
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Change the Creation Date and Time
Change the Owner of a File
Change the Date or Time a File Was Last Modified
Change the Date or Time a File Was Last Archived
Change Who Last Archived a File
Change the Search Mode for a File

Screen regions and buttons
"Size" shows the space used by this file in bytes.

"Created date and time" shows when the file was first created.

"Owner" shows the owner of this file.

"Last Modified date and time" shows when the file was last modified.

"Modifier" shows who last modified the file.

"Last Accessed date and time" shows when the file was last accessed.

"Last Archived date and time" shows when the this file was last archived. This field and the "Archiver" 
field are set whenever the Archive attribute of this file is reset by a backup application.

"Archiver" field shows who last archived the file.

"Search Mode" shows how this file will be treated when using the Search feature. This field only 
appears if you are viewing information for an executable (.EXE) file.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Search Mode
Note: The "Search Mode" field only appears on "Facts" if you are viewing information for an executable 
(.EXE) file.
A search mode determines how NetWare looks for files that it needs, such as data files or auxiliary 
program files. A search mode can be defined for any file, but only application files (files with an .EXE 
or .COM extension in DOS) really use them.
A NET.CFG file can contain a search mode that applies to all files unless a different search mode is 
specified for a particular file
When an application requests a file, it can include a path with the filename, or just the filename. It can 
also specify that the file is to be read, but not written to. This is called a Read Only open.

Screen regions and buttons
"Shell default" uses the search mode defined in the user's NET.CFG file. (Equivalent to value 0 in the 

text utilities.)

"Search on all opens with no path" looks for the desired file first in the default directory, and then in 
each search drive. (Equivalent to value 5 in the text utilities.)

"Do not search" looks for the desired file only in the path included with the filename and in the default 
directory. Search drives are not checked. (Equivalent to value 2 in the text utilities.)

"Search on read only with no path" looks for the desired file first in the default directory, and then, if 
the file is to be opened for Read Only, in each search drive. (Equivalent to value 7 in the text 
utilities.)

"Search on all opens" looks for the desired file first in the path specified with the file, then in the 
default directory, and then in each search drive. (Equivalent to value 1 in the text utilities.)

"Search on all read only opens" looks for the desired file first in the path specified with the file, then in 
the default directory, and then, if the file is to be opened for Read Only, in each search drive. 
(Equivalent to value 3 in the text utilities.)



Change the Creation Date and Time of a File
1. Select the section of the "Creation date or time" field that you want to change.
2. Choose the arrow to the right of the field that you selected.

2a. The Up arrow advances the date or time.
2b. The Down arrow decreases the date or time.

3. Choose "OK."
You return to the Browser.



Change the Owner of a File
1. Select the "Owner" field.
2. Enter the name of the User that should be the owner of this file. You can do this by choosing the icon 

to the right of the field  to choose a User object.
3. Choose "OK."

You return to the Browser.



Change the Last Modified Date of a File
1. Select the section of the "Modified date or time" field that you want to change.
2. Choose the arrow to the right of the field that you selected.

2a. The Up arrow advances the date or time.
2b. The Down arrow turns back the date or time.

3. Choose "OK."
You return to the Browser.



Change the Last Archived Date and Time of a File
1. Select the section of the "Archived date or time" field that you want to change.
2. Choose the arrow to the right of the field that you selected.

2a. The Up arrow advances the date or time.
2b. The Down arrow decreases the date or time.

3. Choose "OK."
You return to the Browser.



Change Who Last Archived a File
1. Select the "Archiver" field.
2. Enter the name of the User that last archived this file. You can do this by choosing the icon to the right

of the field  to choose a User object from the Browser.
3. Choose "OK."

You return to the Browser.



Change the Search Mode of a File
Note: The "Search Mode" field only appears on "Facts" if you are viewing information for an executable 
(.EXE) file.
1. Select the Down arrow on the right side of the "Search Mode" field.

A drop box appears listing the options that you can choose from.
2. Select a search mode option.

The drop box closes and the option you selected is displayed.



File Attributes for NetWare v2.x and v3.x Files    
The "Attributes" page shows attribute information about this file. Any attribute that is checked is in effect 
for this file. For example, you can
- See which attributes are assigned to this file
- Change attributes of this file
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Change the File Attributes

Screen regions and buttons
File Attributes Shows the attributes of this file.



File Attributes 
The "Attributes" page shows attribute information about this file you selected. Any attribute that is checked
is in effect for this file. For example, you can
- See which attributes are assigned to this file
- Change attributes of this file
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Change the File Attributes

Screen regions and buttons
File Attributes shows the attributes of this file.
File Flags shows the flags that NetWare has set for this file.



Change the File Attributes
File attributes describe how users and NetWare use a file. You can set the attributes to suit your working 
environment.

To change the file attributes
1. Choose the attribute you want to change.

If the attribute was checked, it will be cleared. If the attribute was clear, it will be checked. Any 
attribute that is checked is in effect for this file. 

2. Choose "OK."



File Attributes List

File attributes
Archive Needed
Execute Only
Read Only
Shareable
Hidden
System
Transactional
Purge [Immediate]
Read Audit
Write Audit
Copy Inhibit
Delete Inhibit
Rename Inhibit
Don't Migrate
Immediate Compress
Don't Compress



File Flags List
File flags are like file attributes, but you cannot set them. They are set by NetWare to indicate the current 
state of the file.

File flags
Can't Compress
File Compressed
File Migrated



File Attributes List - v2.x and v3.x files

File attributes
Archive Needed
Execute Only
Read Only
Shareable
Hidden
System
Transactional
Purge [Immediate]
Read Audit
Write Audit
Copy Inhibit
Delete Inhibit
Rename Inhibit



View or Change a Distribution List Object    
The "Identification" page describes this Distribution List object. From this page you can
- Enter the full name of this Distribution List
- Specify the person responsible for this Distribution List
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Add another Name for this Distribution List
Enter an Owner for this Distribution List
Enter a Description for this Distribution List

Screen regions and buttons
"Name" displays the context name of this Distribution List.

"Full Name" displays another name (a common name) this Distribution List is known by.

"Owner" displays the person who is responsible for administrating this Distribution List.

"Description" displays information that helps identify this Distribution List.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



View or Change an External Entity Object    
The "Identification" page describes this External Entity object. From this page you can
- Specify the External name this External Entity is known by
- Enter a description of this External Entity
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Add an External Name for this External Entity
Enter a Description for this External Entity

Screen regions and buttons
"Name" displays the context name of this External Entity.

"External Name" displays the native name this External Entity is known by in its native messaging 
environment.

"Description" displays information that helps identify this External Entity.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



View or Change a Message Routing Group Object    
The "Identification" page describes this Message Routing Group object. From this page you can
- Add another name this Message Routing Group is known by
- Specify the person responsible for this Message Routing Group
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Enter a Description for this Message Routing Group
Add another Name for this Message Routing Group
Enter a Postmaster General for this Message Routing Group
Enter a Location for this Message Routing Group
Enter a Department for this Message Routing Group
Enter an Organization for this Message Routing Group

Screen regions and buttons
"Name" displays the context name of this Message Routing Group.

"Other name" displays other names this Message Routing Group is known by.

"Postmaster General" displays the person who is responsible for this Message Routing Group.

"Description" displays information that helps identify this Message Routing Group.

"Location" displays where this Message Routing Group is located.

"Department" displays the department this Message Routing Group reports to.

"Organization" displays the company or other organization that this Message Routing Group reports 
to.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



View or Change a Messaging Server Object 
The "Identification" page describes this Messaging Server object. From this page you can
- View the name of the NetWare Server that this Messaging Server resides on
- View the MHS Database Location of this Messaging Server
- View or change the description of what this Messaging Server is used for
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Add another Name for this Messaging Server
Enter a Description for this Messaging Server
Enter a Location for this Messaging Server
Enter a Department for this Messaging Server
Enter an Organization for this Messaging Server

Screen regions and buttons
"Name" displays the context name of this Messaging Server.

"NCP Server Name" displays the path to the NetWare Server where this Messaging Server resides.

"MHS Database Location" displays the location where the MHS Database directory was installed and 
currently resides.

"Other name" displays other names that refer to this Messaging Server. One reason you may want to 
assign a Messaging Server another name is if you have renamed it but want users to be able to 
locate the previous name in a search, in which case you could enter the previous name in the 
"Other Name" text box.

"Description" displays information that helps identify this Messaging Server.

"Location" displays the physical location of this Messaging Server.

"Department" displays the department that uses this Messaging Server.

"Organization" displays the company that uses this Messaging Server.

"Status" displays the current status of your Messaging Server. If you have a messaging application 
installed, the "Status" field will display "Up," which means the Messaging Server is able to handle 
messages. If you have no messaging application installed, the "Status" field will display "Down."

"Version" displays the version of MHS (Messaging Handling System) Services installed on this 
Messaging Server.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Enter an External Name for this External Entity
The "External Name" text box's purpose is to record the native name that this object is known by in its 
native messaging environment. This name would be the object's common E-mail name, not a context 
name like the one displayed in the "Name" text box 
"External Name" is a property unique to an External Entity object.

To enter an External Name
1. Select the "External Name" text box.
2. Type the native name that this object is known by in its native messaging environment. The 

information scrolls to the right if you continue to type once you've reached the right margin of the text 
box. You can enter up to 256 characters.

3. Choose "OK.
"The information is not saved to NetWare Directory Services until you choose "OK."



View or Change the Messaging Servers
The "Messaging Servers" page displays the Messaging Servers that are members of the selected 

Message Routing Group. The Messaging Servers in a Message Routing Group can send and receive 
messages directly among each other.

From this page you can add or delete Messaging Servers.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Add a New Messaging Server
Delete an Existing Messaging Server

Screen regions and buttons
"Add" lets you add Messaging Servers to the selected Message Routing Group.

"Delete" removes (from the Message Routing Group) the Messaging Server that you select.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



View or Change the Message Routing Groups
The "Message Routing Groups" page displays the Message Routing Groups that the selected Messaging 
Server belongs to. From this page you can
- Add a Message Routing Group that the selected Messaging Server belongs to.
- Delete a Message Routing Group that the selected Messaging Server currently belongs to.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Add a New Message Routing Group
Delete an Existing Message Routing Group

Screen regions and buttons
"Add" lets you add Message Routing Groups that the selected Messaging Server belongs to.

"Delete" removes Message Routing Groups that the selected Messaging Server currently belongs to.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



View or Change the List of Supported Gateways
The "Supported Gateways" page displays the protocols that are supported by the selected Messaging 
Server. From this page you can
- Add or delete Supported Gateways
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Add a New Supported Gateway
Delete an Existing Supported Gateway

Screen regions and buttons
"Add" lets you add a Supported Gateway to this Messaging Server.

"Delete" removes (from the Messaging Server) the Supported Gateway that you select.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Add a Message Routing Group to this Messaging Server
1. Choose "Add" from the "Message Routing Groups" page.
2. Select Message Routing Groups that you want to add to the Messaging Server.
3. Choose "OK."

Any Message Routing Group you selected is added to the Messaging Server's "Message Routing 
Groups" list.
Note: The Messaging Server object is automatically placed in the "Messaging Servers" list of each 
Message Routing Group that you add.



Delete a Message Routing Group from this Messaging Server
1. Select a Message Routing Group from the "Message Routing Groups" list.
2. Choose "Delete."

The Message Routing Group is deleted from the list.



Add a Supported Gateway to this Messaging Server
1. Choose "Add" on the "Supported Gateways" page.
2. Type the name of Supported Gateway in the "Name" text box.
3. Type the name of the messaging protocol in the "Protocol" text box, or, select the drop-down combo 

box to the right of the "Protocol" text box and then select the appropriate messaging protocol from the
list.
The Supported Gateway provides messaging connectivity between the messaging protocol you select
and your MHS messaging system.

4. Choose "OK."
A Supported Gateway is added to the "Supported Gateways" list.

5. (Optional) To add another Supported Gateway, repeat this procedure.



Delete a Supported Gateway from this Messaging Server
1. Select a Supported Gateway from the "Supported Gateways" list.
2. Choose "Delete."

The Supported Gateway is deleted from the list. The selected Messaging Server can no longer send 
mail to or receive mail from an entity that is using the messaging protocol of the deleted Supported 
Gateway.



View or Change the List of Postmasters
The "Postmasters" page displays the Postmasters of this Messaging Server. Postmasters have the right 
to manage the Messaging Server they reside on. For example, they can add or delete users (whose 
mailboxes reside on the Messaging Server) from the Messaging Server. From this page you can
- View the current Postmasters of this Messaging Server
- Add or delete Postmasters
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Add a New Postmaster
Delete an Existing Postmaster

Screen regions and buttons
"Postmasters" lists the context name of each object that has rights to manage this Messaging Server.

"Add" lets you add a Postmaster to this Messaging Server.

"Delete" removes (from this Messaging Server) the Postmaster that you select.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



View or Change the List of Users
The "Users" page displays the list of Users whose mailboxes reside on this Messaging Server. From this 
page you can
- Add or delete Users
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Add a New User
Delete an Existing User

Screen regions and buttons
"Add" lets you add a User to this Messaging Server.

"Delete" removes (from this Messaging Server) the User that you select.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Add a Postmaster to this Messaging Server
1. Choose "Add" from the "Postmasters" Page

To add a Postmaster to a Messaging Server, you must have the Write property right to the Postmaster
property of the Messaging Server. If you have the Supervisor object right to the Messaging Server, 
this requirement is filled.

2. Select each object that you want to add as a Postmaster on this Messaging Server.
3. Choose "OK."

Any object you selected is added as a Postmaster on this Messaging Server and appears on the 
Messaging Server's "Postmasters" list.



Delete a Postmaster from this Messaging Server
1. Select a Postmaster from the "Postmasters" list.
2. Choose "Delete."

The Postmaster you selected is deleted from the list.
To delete a Postmaster from a Messaging Server, you must have the Delete object right to the Messaging
Server. If you have the Supervisor object right to the Messaging Server, this requirement is filled.



View or Change an Object's Foreign EMail Address and Aliases
The "Foreign EMail Address" page allows you to view or change address information about the selected 
object, which you might do if the object uses a messaging service besides MHS. From this page you can
- View the foreign EMail address and foreign EMail aliases of the object
- Set or clear a foreign EMail address
- Add or delete foreign EMail aliases
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
How to Use the Object Dialog
Set a Foreign EMail Address
Add a Foreign EMail Alias
Delete a Foreign EMail Alias

Screen regions and buttons
"Foreign EMail Address" specifies a NetWare Directory Services object's mailbox that resides in a 

foreign EMail system. For example, an NDS user can choose to have his/her EMail delivered to a
UNIX machine which supports SMTP messaging protocol. This user's SMTP address in the UNIX
machine--the SMTP native name--is his/her foreign EMail address. An NDS object can have only 
one foreign Email address.

"Set" lets you add a Foreign EMail Address for this object.

"Clear" deletes the Foreign EMail Address in the "Foreign EMail Adress" text box.

"Foreign EMail Aliases" specifies an object's aliases as known in a foreign messaging system. For 
example, an MHS user (a user whose mailbox is in an MHS messaging server) can have an 
X400 alias--with an X400 native name--so that X400 users can use this alias to send mail to the 
MHS user. An object can have several Foreign Email Aliases, one for each type of foreign EMail 
system.

"Add" lets you add a Foreign EMail Alias.

"Delete" removes the Foreign EMail Aliases that you select.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Set a Foreign EMail Address
1. Choose "Set" in the "Foreign EMail Address" text box.
2. Type the name of the foreign address in the "Name" text box. Use the native naming conventions for 

whatever messaging protocol the selected object will use to receive mail.
3. Type the name of the messaging protocol that the selected object will use to receive mail in the 

"Type" text box, or, select the drop-down combo box to the right of the "Type" text box and then select
the appropriate messaging protocol from the list.

4. Choose "OK."
A Foreign EMail Address is added to the "Foreign EMail Address" text box.



Add a Foreign EMail Alias
1. Choose "Add" in the "Foreign EMail Aliases" text box.
2. Type the name of a foreign address in the "Name" text box. Use the native naming conventions for 

whatever messaging protocols the selected object will use to receive mail.
3. Type the name of the messaging protocol that the selected object will use to receive mail in the 

"Type" text box, or, select the drop-down combo box to the right of the "Type" text box and then select
the appropriate messaging protocol from the list.

4. Choose "OK."
A Foreign EMail Alias is added to the "Foreign EMail Address" text box.

5. (Optional) To add another Foreign EMail Alias, repeat this procedure.



Delete a Foreign EMail Alias
1. Select a Foreign EMail Alias from the "Foreign EMail Aliases" list.
2. Choose "Delete."

The Foreign EMail Alias is deleted from the list. The selected object can no longer receive mail from a
sender who is using the messaging protocol of the deleted alias.



Add a Messaging Server
1. Choose "Add" from the "Messaging Servers" page.
2. Select any Messaging Servers that you want to add to the Message Routing Group.
3. Choose "OK."

Any Messaging Server you selected is added to the Message Routing Group and appears in the 
"Messaging Servers" list.
Note: The Messaging Server object is automatically placed in the "Message Routing Groups" list of 
each Messaging Server that you add.



Delete a Messaging Server
1. Select a Messaging Server from the "Messaging Servers" list.
2. Choose "Delete."

The Messaging Server is deleted from the list.



Enter a Full Name for this Distribution List Object
The "Full Name" text box can record any common name that you think will be useful for this Distrubution 
List object. You can add only one alternative name for this object. This name can be referred to in a 
search to locate this object.

To enter a full name for this object
1. Select the "Full Name" text box.
2. Type the common name that you want recorded as a property of this object.
3. Choose "OK."

The information is not saved to NetWare Directory Services until you choose "OK."



View or Change the Members of a Distribution List Object
The "Members" page lists all of the members of the Distribution List. When the Distribution List is used as 
a recipient in a message, each object in this list will receive a copy of the message. Objects may be 
added to or deleted from the list using this dialog.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Member to this Group
Delete a Member from this Group

Screen regions and buttons
"List Members" lists the context name of each object that is a member of this Distribution List.

"Add" lets you select objects to add as members of this Distribution List.

"Delete" removes (from this Distribution List) the objects you select.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Add a Member to this Distribution List Object
1. Choose "Add" from the "List Members" Page

To add a member to a Distribution List, you must have the Write property right to the Members 
property of the Distribution List. If you have the Supervisor object right to the Distribution List, this 
requirement is filled.

2. Select each object that you want to add as a member of this Distribution List.
3. Choose "OK."

Any object you selected is added as a member of this Distribution List and appears on the "List 
Members" list.



Delete a Member from this Distribution List Object
1. Select an object from the "List Members" list.
2. Choose "Delete."

The object you selected is deleted from the list.
To delete an object from the Distribution List, you must have the Delete object right to the Distribution List.
If you have the Supervisor object right to the Distribution List, this requirement is filled.



View Mailbox Information about an Object
Use the "Mailbox" page to see Mailbox Location and Mailbox ID for Organization, Organizational Role, 
Organizational Unit, Group, and User objects.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedure
Set a Mailbox Location
Set a Mailbox ID

Screen regions and buttons
"Mailbox Location" specifies the Messaging Server where this object's mailbox resides.

"Mailbox ID" displays a unique name that allows this object's mailbox to be located in the Messaging 
Database.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Set a Mailbox Location for this Object
The "Mailbox Location" text box can record the name of the Messaging Server where this object's mailbox
is physically located.
"Mailbox Location" is a property of Organization, Organizational Role, Organizational Unit, Distribution 
List, Group, and User objects in NetWare Directory Services.

To set a mailbox location
1. Select the "Mailbox Location" text box.
2. Select the Messaging Server where this object's mailbox resides.
3. Choose "OK."

The full context name of Messaging Server object you selected from the Browser appears in the 
"Mailbox Location" text box. 
The information is not saved to NetWare Directory Services until you choose "OK."



Set a Mailbox ID for this Object
The "Mailbox ID" text box automatically displays the ID of this object after the "Mailbox Location" text box 
is filled in. The assigned "Mailbox ID" is the name of the directory in which all of the object's inbound mail 
will be placed.
This means that usually you don't have to manually set a "Mailbox ID." It's done for you when you choose 
a "Mailbox Location."
However, you can change the default name of the "Mailbox ID." You would want to change the ID if, for 
example, you rename an object.
You can enter from 1 to 8 characters each, using the alphabet letters (lower and uppercase), numbers (0-
9), the hyphen (-), the dollar sign ($), and the pound sign (#).
"Mailbox ID" is a property of Organization, Organizational Role, Organizational Unit, Distribution List, 
Group, and User objects in NetWare Directory Services.

To set a mailbox ID
1. Select the "Mailbox ID" text box.
2. Type the common name of this object, up to eight characters.
3. Choose "OK."

The information is not saved to NetWare Directory Services until you choose "OK."



Create a User Object 
A User object represents a user on the network. A User object must exist for every user who will log in to 
the network.
Users on NetWare v4.0 workstations can be created anywhere in the Directory tree, though they must 
know where they are to log in. Users on NetWare v2.x and v3.x workstations must be located in the same
container as the server that runs bindery emulation for them.

To create a user
1. Type the user's name in "Login Name."

This is the name that the User will use to log in to the network (this name appears in the Directory 
tree).
You must follow the user naming conventions.
Use use the <Tab> key or the mouse to move to the next field. The <Enter> key will not move the 
cursor to the next field.

2. Type the User's surname in "Last Name."
3. (Optional) To complete the fields of this new User with the information entered in the 

USER_TEMPLATE for this container, select "Use User Template."
If this container does not have a USER_TEMPLATE object, this selection is grayed.

4. (Optional) To define additional information about this User immediately after creating it, select "Define 
Additional Properties."
You cannot select this if you select "Create Another User."

5. (Optional) To create another User immediately after this one, select "Create Another User."
You cannot select this if you select "Define Additional Properties."

6. (Optional) To automatically create a home directory for this User when it is created, select "Create 
Home Directory."
If you select this option, you must also define a path and directory name for the User's home 
directory.
If you select this option, this User is granted all rights to this directory.

7. Define a directory for this User's home directory.

7a. Choose the Browser icon  to the right of the "Path" field to select a volume (root directory) 
or other subdirectory that will hold this user's home directory.

7b. Type a directory name in the "Home Directory" field.
The User's login name is generally used as the directory name.

8. Choose "Create."
If you selected "Define Additional Properties," the User object dialog appears.
If you selected "Create another User," this "Create User Object" dialog appears again.
If you selected "Create Home Directory," a directory is created on the selected volume. You see no 
evidence of this new directory on the screen.

Screen regions and buttons
"Login name" is the name of this User object and the name the User enters to log in to the network.

"Last name" shows the User's last name or other identification information that you have chosen to 
store in this field.

"Use User Template" applies default values to properties for this User.

"Define Additional Properties" lets you define more information about this User immediately after 
creating it, such as a password or login script commands.

"Create another User" repeats this dialog rather than returning to the Browser.

"Create Home Directory" creates the directory described in "Path" and "Home Directory" and grants 
this user a trustee assignment to that directory. This gives the new User a place to work 



immediately.

"Path" lets you choose a path on a volume where you want to create the home directory for this User. 
A path such as \USERS or \HOME is often used to hold all Users' home directories. This field is 
only used if "Create Home Directory" is selected.

"Home Directory" is the name of the directory that is created for this User, and to which this User is 
granted rights, if "Create Home Directory" is selected.

"Create" creates the new User.

"Cancel" returns to the Browser without creating a User.



Use the User Template when Creating a User Object
User defaults are the information contained in the USER_TEMPLATE object. This object can be created 
in two ways:
- Select "Define User Defaults." When creating an Organizational Unit object, select "Define User 

Defaults."
- Choose "User Template" from the "Object" menu after creating an Organizational Unit object.
You cannot apply user defaults to existing Users. If you change the user defaults, the changes apply only 
to the Users created after that; they do not apply to Users that were previously created using user 
defaults.
You can use defaults to complete general user information, then make changes to some fields in the User
object dialog. The USER_TEMPLATE object includes information for the following pages:

Identification
Environment
Login Restrictions
Password Restrictions
Login Time Restrictions
Login Script
Network Address Restrictions
Print Job Configuration
Group Membership
Security Equivalences
Postal Address
Account Balance
See Also

Procedures
View or Change the User Defaults of a Container



View or Change the User Defaults of a Container
1. Choose the Organizational Unit object that will contain new Users that these defaults will be applied 

to.
2. Choose "User Template" from the "Object" menu.

If "Define User Defaults" was selected when this Organizational Unit was created, you can edit the 
existing user defaults. If "Define User Defaults" was not selected, the programs creates a new object 
called USER_TEMPLATE which you can edit.

3. Enter or change information in the appropriate pages.
4. Choose "OK."
Related topics

Using User Defaults When Creating a User Object
Using the Pages of the Object Dialog



Login Name of a User
The login name is the name that the User enters to log in to the network (this name appears in the 
Directory tree). Your organization should standardize how new login names are entered. For example, 
everyone should use first initial and last name, or first name (a small organization), or last name, or first 
and last name with an underscore.
Other identification information can be stored in the "Last Name" field in the "Create User" dialog, or in the
"Other Names" field. Both of these fields can contain multiple values and can be edited in the 
"Identification" page of the User Object dialog.

Login Name Restrictions
- The login name must be unique in the branch (container) of the Directory tree where the User is 

located.
Example: If users Debra Jones and David Jones are in the same Organizational Unit, only one of 
them can use the login name "djones." However, if they are in different containers, they can use the 
same login name.

- The login name can be up to 64 characters long.
- Any special characters can be used, unless this User needs to log in from a NetWare v2.x or v3.x 

workstation, in which case you should avoid special characters (see below).
Note: If you have workstations using different languages, you should only use characters that appear 
in the code page of all languages. Otherwise, a name entered when creating an object in English, for 
example, will contain unreadable characters when viewed in Japanese because the characters of the 
name are not available on the Japan code page. See your DOS or OS/2 manual for more information 
about code pages.

- Names are displayed in uppercase and lowercase letters as they were first entered, but they are not 
case-sensitive. So DJones and DJONES are considered to be identical names.

- Spaces and underscores can be used, and they will be displayed as they were first entered, but they 
are considered to be the same. So Dave_Jones and Dave Jones are the same.
Note: If you use spaces in an object name, you must always enclose the object name in quotation 
marks when entering it on the command line or in login scripts. For this reason, you may want to 
avoid spaces in object names.

Login Name Restrictions for Bindery Emulation
When creating Users who will log in from a NetWare v2.x or v3.x workstation, the names of User objects 
must match bindery naming rules, or the User will not be able to log in.
- Spaces in object names are replaced by underscores in Bindery Emulation.
- Object names longer than 47 characters are cut off after the 47th character.
- The following characters cannot be used in an object name that must be accessed from a NetWare 

v2.x or v3.x workstation:
/ Slash
\ Backslash
: Colon
, Comma
* Asterisk
? Question mark



Last Name of a User
You must enter a value in the "Last Name" field. This can be any identification information you need.
If you open an Object dialog for this User after creating it, you can enter multiple values in this field. This 
can be very helpful when searching for objects with particular values.
Example: David Jones logs in as "djones." To find him when searching for all users named Jones, enter 
"Jones" in the "Last name" field.



Object Naming Conventions
Although you can use almost anything for an object name, it will simplify network management and 
reduce Users' problems if you use simple, relatively short object names.
The rules below apply to most objects, including Users, Volumes, Organizations, and Organizational 
Units. Special rules apply to Country objects, which can only have a two-character name, and to NetWare
Server objects. More information is also provided elsewhere for User object names (Login Names).

Object Name Restrictions
- The name must be unique in the branch (container) of the Directory tree where the object is located.

Example: If Users Debra Jones and David Jones are in the same Organizational Unit, only one of 
them can use the object name "djones." However, if they are in different containers, they can use the 
same object name.

- The object name can be up to 64 characters long.
- Any special characters can be used, unless this object needs to be accessed from a NetWare v2.x or 

v3.x workstation, in which case you should avoid special characters.
Note: A few special characters like plus (+), equals (=), and period(.) must be preceded in the object 
name by a backslash. Avoid these characters if possible.
Note: If you have workstations using different languages, you should only use characters that appear 
in the code page of all languages. Otherwise, a name entered when creating an object in English, for 
example, will contain unreadable characters when viewed in Japanese because the characters of the 
name are not available on the Japan code page. See your DOS or OS/2 manual for more information 
about code pages.

- Object names are displayed with uppercase and lowercase letters as they were first entered, but they 
are not case-sensitive. So ManagerProfile and MANAGERPROFILE are considered to be identical 
names.

- Spaces and underscores can both be used, and they will be displayed as they were first entered, but 
they are considered to be the same. So Manager_Profile and Manager Profile are the same.
Note: If you use spaces in an object name, you must always enclose the object name in quotation 
marks when entering it on the command line or in login scripts. For this reason, you may want to 
avoid spaces in object names.

Object Name Restrictions for Bindery Emulation
When creating objects that will be accessed from a NetWare v2.x or v3.x workstation through bindery 
emulation, the names of objects must match bindery naming rules, or the NetWare v2.x or v3.x 
workstation cannot see them.
- Spaces in object names are replaced by underscores in Bindery Emulation.
- Object names longer than 47 characters are cut off after the 47th character.
- The following characters cannot be used in an object name that must be accessed from a NetWare 

v2.x or v3.x workstation:
/ Slash
\ Backslash
: Colon
, Comma
* Asterisk
? Question mark



NetWare Server Object Naming Conventions
The general object naming rules allow more flexibility than those for naming a NetWare Server object. 

NetWare Server Name Restrictions
- Every object name must be unique within its container. There cannot be two objects named TEST in 

the same container.
- The first NetWare Server object for a NetWare 4.0 server must be created with the INSTALL.NLM. 

The object will be given the same name as the physical server. Rules for naming physical servers are 
in the <F1> help system of INSTALL.NLM.

- If you create another NetWare Server object that points to the same NetWare 4.0 server, it must have 
the same name as the original NetWare Server object, which was the physical server name. Because 
the objects have the same name, they must be in different containers.

- If you create a NetWare Server for a non-NetWare 4.0 server, you must use the physical server name
as well, because NetWare Directory Services must search for the server on the network to verify its 
existence.

- Because of these restrictions, you can never rename a NetWare Server object, even if you have the 
Supervisor object right to it.

- Naming rules for physical servers



Physical Server Naming Rules
These rules are provided as information only. Every NetWare Server object must be named by an existing
physical server that was created with INSTALL.NLM at the server console. 
You cannot rename a NetWare Server object.
The physical name of a NetWare server:
- Must be 2 to 47 characters long
- Can contain letters A-Z, numbers 0-9, hyphens, periods, and underscores
- Cannot use a period as the first character



Physical Volume Naming Rules
These rules are provided as information only. Every NetWare volume must be installed at the server 
console and given a physical volume name at that time. 
A Volume object that points to this physical volume contains the physical volume name as a property, 
though the Volume object can be named anything that follows the object naming conventions.
The physical name of a NetWare volume:
- Must be 2 to 15 characters long
- Can contain letters A-Z, numbers 0-9, hyphens, periods, and underscores
- Cannot use a period as the first character
- Cannot contain spaces, colons, asterisks, question marks, or backslashes



Create a Volume Object 
A Volume object provides a place in the Directory database to record and view information about a 
physical volume that was installed on a NetWare Server. NetWare 4.0 volumes are created when 
NetWare Servers are installed. You can create other Volume objects that refer to the same physical 
volume as an existing Volume object. You can also create Volume objects for non-NetWare 4.0 volumes, 
if you have created NetWare Server objects for the servers that they are attached to.
By creating a Volume object and "pointing it" to a physical volume, you can see the directories and files 
on the volume from within the NetWare Administrator and other utilities. The Volume object is like a link 
between NetWare Directory Services and the file system of a physical volume. Information about both 
appears when you view a Volume object.
Volume is a leaf object. Directories and files (the file system of the physical volume) are shown under it, 
like leaf objects are shown under container objects.

To create a new Volume object
1. Type a name for this Volume object in the "Volume name" text box.

We recommend that you use the Server_PhysicalVolumeName for Volume names.    For example, 
Reports_sys. The only requirement, however, is that you follow the object naming conventions.

2. Select the "Host server" text box.

3. Choose the "Browser" icon .
4. Select the NetWare Server on which you want to create this Volume object.

The NetWare Server must already exist.
5. Enter the volume's physical name in the "Physical volume name" text box.

You can type the name or choose one from the drop box. The drop box lists the physical volumes that
have been installed on the NetWare server selected in Step 4.

6. (Optional) To define additional information about this Volume right now, select "Define Additional 
Properties."
You cannot select this if you select "Create another Volume."

7. (Optional) To create another Volume immediately after this one, select "Create another Volume."
You cannot select this if you select "Define Additional Properties."

8. Choose "Create."
If you selected "Define Additional Properties," the Volume Object dialog appears.
If you selected "Create another Volume," this dialog appears again.

Screen regions and buttons
"Volume Name" is the name of the Volume as it will appear in the Browser. 

"Host Server" is the name of the NetWare Server to which the physical volume is attached. The 
NetWare Server must already exist.

"Physical Volume Name" is the name of the volume that was recorded when the volume was first 
initialized at the server (for example, SYS:).

"Define Additional Properties" allows you to define more information about this Volume immediately 
after creating it.

"Create another Volume" repeats this dialog rather than returning to the Browser.

"Create" creates the new Volume.

"Cancel" returns to the Browser without creating a Volume.



Create a Volume Object - Naming a Volume Object
This is the name of the Volume object for NetWare Directory Services. It can be any valid object name.
This name can include
- The name of the area where this volume is used
- The server it resides in
- Its physical name
The Volume object name is not the same thing as the physical volume name, although you can use the 
same name for both.
Example: The name of the physical volume is SYS:. You create the new Volume object under the 
MARKETING Organizational Unit. To describe its location, you name the Volume object 
MARKETING_SYS.



Create a NetWare Server Object 
A NetWare Server object provides NetWare Directory Services with a way to refer to a physical server. 
Information is stored in the NetWare Server object's properties about the physical location of the server, 
what services it provides, and how those resources are used and accounted for.
You must use INSTALL.NLM on each NetWare Server to create the first NetWare Server object for each 
physical server. After that, you can create other NetWare Server objects that point to the same physical 
server as the NetWare Server object that was created with INSTALL.NLM. Multiple NetWare Server 
objects pointing to the same physical server cannot be in the same container, however.
You can create a NetWare Server object that points to a NetWare v3.x or NetWare v2.x server at any 
time. NetWare Server is a leaf object.

To create a new NetWare Server object under the selected container
1. Type a name for this NetWare Server in the "Server name" text box.

You must follow the NetWare Server object naming conventions.
2. (Optional) To define additional information about this NetWare Server right now, select "Define 

Additional Properties."
You cannot select this if you select "Create another NetWare Server."

3. (Optional) To create another NetWare Server object immediately after this one, select "Create Another
NetWare Server."
You cannot select this if you select "Define Additional Properties."

4. Choose "Create."
If you selected "Define Additional Properties," the NetWare Server object dialog appears.
If you selected "Create another NetWare Server," this dialog appears again.

Screen regions and buttons
"Server Name" shows the name of the NetWare server.

"Define Additional Properties" allows you to define more information about this NetWare Server 
immediately after creating it, such as which services it provides.

"Create Another NetWare Server" repeats this dialog rather than returning to the Browser.

"Create" creates the new NetWare Server.

"Cancel" returns to the Browser without creating a NetWare Server.



Create an AFP Server Object 
AFP Server is a leaf object.

To create a new AFP Server object
1. Type a name for this AFP Server in the "Server name" text box.

You must follow the object naming conventions.
2. (Optional) To define additional information about this AFP Server object right now, select "Define 

Additional Properties."
You cannot select this if you select "Create another AFP Server."

3. (Optional) To create another AFP Server immediately after this one, select "Create Another Server."
You cannot select this if you select "Define Additional Properties."

4. Choose "Create."
If you selected "Define Additional Properties," the AFP Server object dialog appears.
If you selected "Create another AFP Server," this dialog appears again.

Screen regions and buttons
"Server Name" shows the name of the AFP Server.

"Define Additional Properties" lets you define more information about this AFP Server immediately 
after creating it.

"Create another AFP Server" repeats this dialog rather than returning to the Browser.

"Create" creates the new AFP Server.

"Cancel" returns to the Browser without creating an AFP Server.



Create a Computer Object 
Computer is a leaf object.

To create a new Computer object
1. Type a name for this Computer in the "Computer name" text box.

You must follow the object naming conventions.
2. (Optional) To define additional information about the Computer right now, select "Define Additional 

Properties."
You cannot select this if you select "Create another Computer."

3. (Optional) To create another Computer immediately after this one, select "Create Another Computer."
You cannot select this if you select "Define Additional Properties."

4. Choose "Create."
If you selected "Define Additional Properties," the Computer object dialog appears.
If you selected "Create another Computer," this dialog appears again.

Screen regions and buttons
"Computer name" displays the name for this Computer.

"Define Additional Properties" lets you define more information about this Computer immediately after 
creating it.

"Create another Computer" repeats this dialog rather than returning to the Browser.

"Create" creates the new Computer.

"Cancel" returns to the Browser without creating a Computer.



Create a Country Object 
You must select the [Root] object before creating a Country object. A Country object
- Designates the countries where your network resides
- Organize other NetWare Directory Services objects within the Country object
Country is a container object. You can create a Country object only under the root object. Country is 
higher than Organization and Organizational Unit objects.

To create a new Country object
1. Type the two-letter ISO country code for this Country in the "Country name" text box. 

You should use the appropriate two-letter ISO code; only two characters can be entered as a Country 
name. Use the Description field of the object dialog to enter the country's full name.

2. (Optional) To define additional information about this Country right now, select "Define Additional 
Properties."
You cannot select this if you select "Create another Country."

3. (Optional) To create another Country immediately after this one, select "Create Another Country."
You cannot select this if you select "Define Additional Properties."

4. Choose "Create."
If you selected "Define Additional Properties," the Country object dialog appears.
If you selected "Create another Country," this dialog appears again.

Screen regions and buttons
"Country name" displays the two-letter country code that designates the country. The full name of the 

country can be entered in other properties of the object using the Object dialog.

"Define Additional Properties" allows you to define more information about this Country immediately 
after creating it.

"Create another Country" repeats this dialog rather than returning to the Browser.

"Create" creates the new Country.

"Cancel" returns to the Browser without creating a Country.



Two-Letter Country Codes
Country objects can only use two characters as an object name. You should use the appropriate two-letter
ISO country code below. Use the "Description" field of the object dialog to enter the country's full name.
Some common ISO country codes are:

Argentina - AR
Australia - AU
Austria - AT
Belgium - BE
Brazil - BR
Canada - CA
China - CN
Denmark - DK
Finland - FI
France - FR
Germany - DD
Greece - GR
Hong Kong - HK
Ireland - IE
Israel - IL
Italy - IT
Mexico - MX
Netherlands - NL
Norway - NO
Portugal - PT
Puerto Rico - PR
Singapore - SG
South Africa - ZA
Spain - ES
Sweden - SE
Switzerland - CH
Taiwan - TW
United Kingdom - GB
United States - US
Venezuela - VE



Create a Group Object 
A Group object assigns a name to a list of users located anywhere in the Directory tree. Group is a leaf 
object.
You can grant rights to a Group object, rather than granting rights to all users in the Group individually. 
These rights transfer automatically by security equivalence to the Users listed in the Group.
Use Groups when the membership of the Group will remain fairly constant, but the rights granted to the 
Group need to be updated regularly.

To create a new Group object
1. Type a name for this Group in the "Group name" text box.

You must follow the object naming conventions.
2. (Optional) To define additional information about this Group right now, select "Define Additional 

Properties."
You cannot select this if you select "Create another Group."

3. (Optional) To create another Group immediately after this one, select "Create Another Group."
You cannot select this if you select "Define Additional Properties."

4. Choose "Create."
If you selected "Define Additional Properties," the Group object dialog appears.
If you selected "Create another Group," this dialog appears again.

Screen regions and buttons
"Group name" displays the name of the Group.

"Define Additional Properties" lets you define more information about this Group immediately after 
creating it.

"Create another Group" repeats this dialog rather than returning to the Browser.

"Create" creates the new Group.

"Cancel" returns to the Browser without creating a Group.



Create an Organizational Role Object 
An Organizational Role object defines a position that can be filled by different people, such as Team 
Leader or Printing Manager.
You can grant rights to an Organizational Role object, rather than granting rights to the occupant of the 
Organizational Role. These rights transfer automatically by security equivalence to the Users listed as 
Occupants of the Organizational Role. If the person acting in a role changes, the trustee assignments do 
not have to be changed; only the occupant field of the Organizational Role.
Use Organizational Roles when the occupant of the position may change at times, but the rights granted 
to whoever occupies that position will not change.
Organizational Role is a leaf object.

To create a new Organizational Role object
1. Type a name for this Organizational Role in the "Organizational Role name" text box.

You must follow the object naming conventions.
2. (Optional) To define additional information about this Organizational Role right now, select "Define 

Additional Properties."
You cannot select this if you select "Create another Organizational Role."

3. (Optional) To create another Organizational Role immediately after this one, select "Create Another 
Organizational Role."
You cannot select this if you select "Define Additional Properties."

4. Choose "Create."
If you selected "Define Additional Properties," the Organizational Role object dialog appears.
If you selected "Create another Organizational Role," this dialog appears again.

Screen regions and buttons
"Organizational Role name" accepts the title or position of this role (such as Team Leader).

"Define Additional Properties" allows you to define more information about this Organizational Role 
immediately after creating it.

"Create another Organizational Role" repeats this dialog rather than returning to the Browser.

"Create" creates the new Organizational Role.

"Cancel" returns to the Browser without creating an Organizational Role.



Create an Organizational Unit Object 
Use an Organizational Unit to
- Organize other objects into medium-sized entities such as a department within a company
- Set user defaults for users created in this container
Organizational Unit is a container object and can be created only under an Organization or another 
Organizational Unit.

To create a new Organizational Unit object
1. Type a name for this Organizational Unit in the "Organizational Unit name" text box.

You must follow the object naming conventions.
2. (Optional) To define additional information about this Organizational Unit right now, select "Define 

Additional Properties."
You cannot select this if you select "Create another Organizational Unit."

3. (Optional) To create another Organizational Unit immediately after this one, select "Create Another 
Organizational Unit."
You cannot select this if you select "Define Additional Properties."

4. (Optional) To define user defaults for users that will be created later in this Organizational Unit, select 
"Define User Defaults."

5. Choose "Create."
If you selected "Define Additional Properties," the Organizational Unit object dialog appears.
If you selected "Create another Organizational Unit," this dialog appears again.
If you selected "Define User Template," the object dialog for a new USER_TEMPLATE object 
appears. Enter default information in the pages of this dialog. If a user template exists in the parent 
container, you will be asked if you want to copy that information into this user template. You can then 
change it as needed.

Screen regions and buttons
"Organizational Unit name" is where you enter a name for this Organizational Unit.

"Define Additional Properties" allows you to define more information about this Organizational Unit 
immediately after creating it.

"Create another Organizational Unit" repeats this dialog rather than returning to the Browser.

"Define User Defaults" allows you to enter default information for users that you create later in this 
Organizational Unit. A new object, USER_TEMPLATE, is created, and you enter default 
information in the fields of its object dialog.

"Create" creates the new Organizational Unit.

"Cancel" returns to the Browser without creating a Organizational Unit.



Create an Organization Object 
Use an Organization to organize other objects into large entities such as a company or operating division 
of a company.
Organization is a container object and can be created only under the root object or a Country object. One 
Organization cannot contain another Organization.

To create a new Organization object
1. Type a name for this Organization in the "Organization name" text box.

You must follow the object naming conventions.
2. (Optional) To define additional information about this Organization right now, select "Define Additional 

Properties."
You cannot select this if you select "Create another Organization."

3. (Optional) To create another Organization immediately after this one, select "Create Another 
Organization."
You cannot select this if you select "Define Additional Properties."

4. (Optional) To define user defaults for users that will be created later in this Organization, select 
"Define User Template."

5. Choose "Create."
If you selected "Define Additional Properties," the Organization object dialog appears.
If you selected "Create another Organization," this dialog appears again.
If you selected "Define User Template," the object dialog for a new USER_TEMPLATE object 
appears. Enter default information in the pages of this dialog. If a user template exists in the parent 
container, you will be asked if you want to copy that information into this user template. You can then 
change it as needed.

Screen regions and buttons
"Organization name" is where you enter a name for this Organization.

"Define Additional Properties" allows you to define more information about this Organization 
immediately after creating it.

"Create another Organization" repeats this dialog rather than returning to the Browser.

"Define User Template" allows you to enter default information for users that you create later in this 
Organization. A new object, USER_TEMPLATE, is created, and you enter default information in 
the fields of its object dialog.

"Create" creates the new Organization.

"Cancel" returns to the Browser without creating a Organization.



Create a Directory Map Object 
A Directory Map object refers to a directory path on a volume.You can't look at the directory path from the 
Directory Map, but login scripts can use the MAP command with a Directory Map to record the location of 
frequently used applications. If the application moves, only the Directory Map must be changed; all login 
scripts can remain the same.
Directory map is a leaf object.

To create a new Directory Map
1. Type a name for this Directory Map in the "Directory Map Name" text box.

Use a name that shows what this Directory Map will be used for, such as what application it points to, 
or which volume and path it uses (example object name: SPREADSHEET_PATH). The volume and 
path are entered after the object is created.
You must follow the object naming conventions.

2. Select the Browser button to the right of the "Volume" field and select the volume that this Directory 
Map will point to.

3. In the "Path" field, type a path name for the directory that this Directory Map will point to.
4. (Optional) To define additional information about this Directory Map right now, select "Define 

Additional Properties."
You cannot select this if you select "Create another Directory Map."

5. (Optional) To create another Directory Map immediately after this one, select "Create Another 
Directory Map."
You cannot select this if you select "Define Additional Properties."

6. Choose "Create."
If you selected "Define Additional Properties," the Directory Map Object dialog appears.
If you selected "Create another Directory Map," this dialog appears again.

Screen regions and buttons
"Directory Map Name" shows the name of the Directory Map.

"Volume" specifies the volume that this Directory Map points to.

"Path" specifies the path on the selected volume that this Directory Map refers to.

"Define Additional Properties" lets you define more information about this Directory Map immediately 
after creating it.

"Create another Directory Map" repeats this dialog rather than returning to the Browser.

"Create" creates the new Directory Map.

"Cancel" returns to the Browser without creating a Directory Map.



Create an Alias Object 
An Alias object refers to another object in the Directory tree and makes it appear as if the object that it 
names actually exists in the Directory tree where the Alias is created.
Although an object appears both where it was first created and where an Alias referring to it was created, 
only one copy of the object really exists, and changes made to either object affect what appears in both 
locations.
Alias is a leaf object. The object that the Alias refers to, however, can be a container, so an Alias can 
appear to have objects beneath it.

To create a new Alias object
1. Type a name for this Alias in the "Alias Name" text box.

If you are creating an alias that refers to Accounts, you might name it "Alias of Accounts."
You must follow the object naming conventions.

2. Select the "Aliased object" text box.

3. Choose the "Browser" icon. 
4. Select an object.
5. (Optional) To create another Alias immediately after this one, select "Create Another Alias."

You cannot select "Define Additional Properties" for an Alias. The Alias object consists only of an Alias
name and the name of the object that the Alias points to.

6. Choose "Create."
If you selected "Create another Alias," this dialog appears again.

Screen regions and buttons
"Alias Name" is the name of the Alias.

"Aliased object" is the name of the object that the Alias refers to. This object appears where the Alias 
is created. The Aliased object can be anywhere in the Directory tree. It can be a leaf or a 
container object.

"Create another Alias" repeats this dialog instead of returning to the Browser.

"Create" creates the new Alias.

"Cancel" returns to the Browser without creating an Alias.



Create Alias Object - Naming an Alias
This is the name of the Alias.
An Alias shows another object (named in the "Aliased Object" field) from a different location; it does not 
create a copy of the object.
Rights to the Aliased object will always be inherited from an object's true parent container, and not from 
the parent container of an Alias that points to it.
Example: The CENTRAL Organizational Unit wants access to a Volume object contained by the 
SEATTLE Organizational Unit without changing their context to SEATTLE's part of the Directory tree. 
CENTRAL creates an Alias that refers to the Volume under SEATTLE. (The Volume is the Aliased object.)
Now CENTRAL can see and use the volume in SEATTLE without changing their current context. Any 
changes made by CENTRAL still occur on the Volume object in SEATTLE's area of the Directory tree.



Create Alias Object - Setting an Aliased Object Name
This is the name of the object that the Alias object refers to. It can be a container or a leaf object, 
depending on whether you want to see an entire branch of the Directory tree at this location, or just one 
object.
An Alias looks at the original object from a different location; it does not create a copy of the object. Rights
to the aliased object will always be inherited from an object's true parent container, and not from the 
parent container of an Alias that points to it.
Example: CENTRAL Organizational Unit wants to see information in the ITALY Organizational Unit 
without changing their context. Central office creates an Alias under the Central organizational unit that 
refers to the Milan Sales Organizational Unit object under Italy.
Now Central can see everything under Milan Sales without changing their current context. Any changes 
made by Central office still occur on the "real" objects under ITALY in the Directory tree.



Create a Profile Object 
A Profile object stores a login script that is used by a group of users that need to share common login 
script commands, but who are not necessarily located under the same container in the Directory tree.
If a Profile is listed in the Login Script page of a User object, it is executed after the login script of the 
User's container object, but before the User's individual login script. Users should be careful not to 
overwrite drive mappings from the Profile login script with their individual login script mappings.
Note: A user must have Read rights to the Profile object's login script property for the script to execute.
Profile is a leaf object.

To create a new Profile object
1. Type a name for this Profile object in the "Profile Name" text box.

You must follow the object naming conventions.
2. (Optional) To define additional information about this Profile object right now, select "Define Additional 

Properties."
You cannot select this if you select "Create another Profile."

3. (Optional) To create another Profile object immediately after this one, select "Create Another Profile."
You cannot select this if you select "Define Additional Properties."

4. Choose "Create."
If you selected "Define Additional Properties," the Profile object dialog appears.
If you selected "Create another Profile," this dialog appears again.

Screen regions and buttons
"Profile Name" is the name of the profile object.

"Define Additional Properties" lets you define more information about this Profile immediately after 
creating it

"Create another Profile" repeats this dialog rather than returning to the Browser.

"Create" creates the new Profile.

"Cancel" returns to the Browser without creating a Profile.



Create a Directory 
Directories are not NetWare Directory Services objects. They are part of the file system, which is 
integrated with NetWare Directory Services in the NetWare Administrator utility. You can create a directory
when you select a Volume or another directory.
You can only create directories on a network volume, not on your local hard drive.

To create a new directory
1. Type a name for the directory in the "Name" text box.

The name must follow the rules of the name space that you are using. If you are using DOS, for 
example, the name cannot be more than eight characters, with a three character extension (for 
example, TESTNAME.TXT).

2. (Optional) To define additional information about this directory right now, select "Define Additional 
Properties."
You cannot select this if you select "Create another Directory."

3. (Optional) To create another directory immediately after this one, select "Create Another Directory."
You cannot select this if you select "Define Additional Properties."

4. Choose "Create."
If you selected "Define Additional Properties," the Directory dialog appears.
If you selected "Create another Directory," this dialog appears again.

Screen regions and buttons
"Directory Name" is the name of the directory.

"Define Additional Properties" lets you define more information about this directory immediately after 
creating it.

"Create another Directory" repeats this dialog rather than returning to the Browser.

"Create" creates the new directory.

"Cancel" returns to the Browser without creating a directory.



Create a File 
Use the NetWare Administrator to see information about files that already exist. You must use another 
application, such as a word processor, to create new files.



Create a Message Routing Group Object 
A Message Routing Group object represents a cluster of messaging servers located anywhere in the 
Directory tree. A Message Routing Group object is a leaf object.
You can assign messaging servers to the Message Routing Group. All messaging servers connected to 
the same Message Routing Group may directly send messages among themselves.

To create a new Message Routing Group object
1. Type a name for this Message Routing Group in the "Message Routing Group Name" text box.

You must follow the object naming conventions.
2. Assign a Postmaster General to the Message Routing Group by selecting the Browser icon to the 

right of the "Postmaster General" text box and then selecting a user from the Browser.
3. (Optional) To define additional information about this Group, select "Define Additional Properties."

You cannot select this if you select "Create Another Message Routing Group."
4. (Optional) To create another Message Routing Group immediately after this one, select "Create 

Another Message Routing Group."
You cannot select this if you select "Define Additional Properties."

5. Choose "Create."
If you selected "Define Additional Properties," the Message Routing Group object dialog appears.
If you selected "Create Another Message Routing Group," this dialog appears again.

Screen regions and buttons
"Message Routing Group Name" displays the name of the Message Routing Group (which you type in

the text box).

"Postmaster General" displays the User object that is the owner and administrator of the Message 
Routing Group. (The User object is selected from the Browser.) The Postmaster General has 
rights to modify the Message Routing Group and its attributes.

"Define Additional Properties" lets you define more information about the Message Routing Group 
(such as Location, Department, and Organization) immediately after creating it.

"Create another Message Routing Group" repeats this dialog so that you can create another Message
Routing Group rather than return to the Browser.

"Create" creates the new Message Routing Group.

"Cancel" returns to the Browser without creating a Message Routing Group.



Create an External Entity Object 
An External Entity object represents a non-native NetWare Directory Services object. This object is 
needed to accommodate foreign e-mail users who your e-mail users may want to communicate with. An 
External Entity object is a leaf object.

To create a new External Entity object
1. Type a name for this External Entity in the "External Entity Name" text box.

You must follow the object naming conventions.
2.. (Optional) To define additional information about this Group, select "Define Additional Properties."

You cannot select this if you select "Create Another External Entity."
3. (Optional) To create another External Entity immediately after this one, select "Create Another 

External Entity."
You cannot select this if you select "Define Additional Properties."

4. Choose "Create."
If you selected "Define Additional Properties," the External Entity dialog appears.
If you selected "Create Another External Entity," this dialog appears again.

Screen regions and buttons
"External Entity Name" displays the name of the External Entity (which you type in the text box).

"Define Additional Properties" lets you define more information about the External Entity (such as 
Location, Department, and Organization) immediately after creating it.

"Create another External Entity" repeats this dialog so that you can create another External Entity 
rather than return to the Browser.

"Create" creates the new External Entity.

"Cancel" returns to the Browser without creating an External Entity.



Create a Distribution List Object 
A Distribution List object represents a collection of objects that have mailboxes. You can assign objects 
(Organizational Unit, Group, or User objects for example) to a Distribution List and conveniently send the 
same message to many different recipients by sending it to the Distribution List. A Distribution List object 
is a leaf object.

To create a new Distribution List object
1. Type a name for this Distribution List in the "Distribution List Name" text box.

You must follow the object naming conventions.
2. Assign a mailbox location to the Distribution List by selecting the Browser icon to the right of the 

"Mailbox Location" text box and then selecting a messaging server from the Browser.
3. (Optional) To define additional information about this Distribution List, select "Define Additional 

Properties."
You cannot select this if you select "Create Another Distribution List."

4. (Optional) To create another Distribution List immediately after this one, select "Create Another 
Distribution List."
You cannot select this if you select "Define Additional Properties."

5. Choose "Create."
If you selected "Define Additional Properties," the Distribution List object dialog appears.
If you selected "Create Another Distribution List," this dialog appears again.

Screen regions and buttons
"Distribution List Name" displays the name of the Distribution List (which you type in the text box).

"Mailbox Location" displays the path to the messaging server where the Distribution List's mailbox 
resides.

"Define Additional Properties" lets you define more information about the Distribution List (such as 
Full Name and Owner) immediately after creating it.

"Create another Distribution List" repeats this dialog so that you can create another Distribution List 
rather than return to the Browser.

"Create" creates the new Distribution List.

"Cancel" returns to the Browser without creating a Distribution List.



Using the NetWare Administrator
The NetWare Administrator is similar to a file manager, except that you also manage objects in the 
Directory database instead of only files.
The Browser is the main work area in the NetWare Administrator. It displays the name of each object and 
its corresponding icon. 
To work with an object, select it; then choose the task you want. There are several ways to complete 
tasks:

Use Menu Options
Double-Click on an Object
Click the Right Mouse Button
Drag and Drop Objects

Procedures
Change the Directory Context
Create a New Object
Move    Objects
Move or Copy Files
Include Certain Object Classes in the Browser
Open Multiple Browser Windows
Use Menu Options
View the Current Directory Context

Screen regions and buttons
Menu options let you choose tasks from pull-down menus.

The Browser window displays objects in the Directory database in a tree structure that allows you to 
see their relationships to each other.

The Hint Bar explains menu options as you select them.



Browser Icons
Object icons show what class of object is displayed.

Container objects

Country
Organization
Organizational Unit

Leaf objects

Alias
AFP Server
Bindery object
Computer
Directory Map
Group
NetWare Server
Organizational Role
Printer
Print Server
Profile
Queue
User
Volume



Double-Click on an Object
When you double-click on an object (or press <Enter> after an object is selected), the NetWare 
Administrator performs the most logical action for that object at that place. The action depends on the 
object you choose.
When you double-click on a container object, the Browser lists the objects contained in that object.
When you double-click on a leaf object, the Browser opens an object dialog, unless the leaf object is a 
Volume object.
When you double-click on a Volume object, the Browser lists directories and files in the root directory of 
that Volume.
Example: If you double-click on Organizational Unit SALES, SALES opens and shows the objects it 
contains. If you double-click on User object JORDAN, you see the object dialog for JORDAN. If you 
double-click on Volume MARKETING, you see the root directory of that volume.



Use Menu Options
Menus list all tasks that you can perform. To use most menu options, select the object you want to work 
with, then choose the task from a pull-down menu. 
Example: To create Server SERVER1 under Organizational Unit SALES, select SALES; then choose 
"Create" from the "Object" menu.
If a menu option is grayed, that option is not available (either because you do not have rights to perform 
the action, or the object you selected doesn't allow that option). 
Some menu options have ellipses, indicating that a dialog appears when that option is chosen.
The Hint Bar at the top of the screen explains each menu option when you select it.

Menus
Object
View
Options
Tools
Window
Help



Object Menu Options

Create
Opens a dialog that allows you to select which class of object you want to create under the container you 
selected. If you selected a leaf object or do not have rights to create an object under this container, the 
"Create" option will be grayed. You can use this option to create directories on a Volume as well.

Details
Opens an dialog that allows you to see information about the object, file, or directory. The type of 
information you can view or change varies according to the object you select. The same dialog will open if
you double-click on a leaf object

Trustees of this Object
Opens a dialog that shows which objects have rights to the object you selected. You can also set the 
object's Inherited Rights Filter or see other objects' effective rights to this object.
Use the "Rights to Other Objects" option to see which objects this object has rights to. 

Rights to Other Objects
After you specify which part of the Directory tree to look at, a window opens that shows what the selected 
object has rights to. There is a delay when you choose this option while all objects in the selected part of 
the Directory tree are searched for trustee assignments that include the selected object.
To see who has rights to this object, use the "Trustees of this Object" option.

Move
Allows you to move the selected leaf objects, container objects, or files to another location. You can select
multiple leaf objects, container objects, or files, and select a destination in the dialog that appears when 
this menu item is chosen.

Copy
Allows you to make a copy of a file. You can select multiple files. You select a destination in the dialog that
appears when this menu item is chosen.

Rename
Opens a dialog that allows you to rename any object, file, or directory. If you rename an object, you can 
choose to save the object's old name in the Other Names property for future reference.

Delete
Deletes the selected object. Once you have deleted an object, you cannot recover it. A container can be 
deleted only if it is empty except for the USER_TEMPLATE object. You cannot delete the 
USER_TEMPLATE object; it is deleted when its container is deleted.

User Template
Provides a pattern for User objects created under the selected container. You can change the pattern and 
apply it to new User objects.

Search
Allows you to search a branch of the Directory tree for objects matching a pattern that you specify.

Print
Allows you to print the objects currently listed in the Browser.

Print Setup
Allows you to select and configure your printer and print jobs.

Exit



Closes the NetWare Administrator.



View Menu Options
These settings control how the Browser displays objects.

Set Context
Opens a dialog which allows you to change which part of the Directory tree you are viewing.

Include
Opens a dialog which allows you to limit by name or by object type the objects you see in the Browser, or 
limit by name the files and directories you see when you view a Volume object's files and directories. Use 
this option if you have a large number of items to display.
For example, you could select to see all User, Group, and Printer objects whose names include S and R, 
and select to see files and directories whose names include P, T, and S.

Sort
Opens a dialog which allows you to set the order in which the classes of objects appear in the Browser.
For example, if you want to see users listed first, volumes second, groups third, and so on, move users to 
the top, volumes second, etc. in the Sort dialog.

Expand
Opens the container object that you have selected. The container remains selected.

Collapse
Closes the container that you have selected. The container remains selected.



Options Menu

Save Settings on Exit
Save your current settings, including sort preferences, Browser filters, and the context of your active 
Browser screens.

Get Alias Trustees

Show Hints
If this option is checked, a one-line description of each menu item is displayed at the top of the screen as 
you scroll through each menu. Select this option to turn the hints on or off.

Confirm on Delete
If this option is checked, a confirmation box will appear when you delete an object, file, or directory. You 
cannot recover deleted objects, so you should set this to confirm deletions.
Your choice will apply every time you open the NetWare Administrator until you reset this option.



Tools Menu

Partition Manager
Starts the Partition Manager.

Browse
Opens another Browser window with the selected object as the first object in the new window.

Remote Console
Activates the Remote Console utility from a DOS Box.



Window Menu

Cascade
Arranges all Browser windows in overlapping style (so the title bar of each window can be seen).

Tile
Arranges all Browser windows in tile style, like a checkerboard. Each window is smaller, but none overlap.

Close all
Closes all Browser windows. To open a window to view the Directory tree again, you must choose 
"Browser" from the "Tools" menu.



Help Menu

New Features
Lists and explains the new features available in this version of the NetWare Administrator.

Contents
Lists all topics available in Help. These topics link to procedures and descriptions of all parts of the 
NetWare Administrator.

Glossary
Lists all glossary terms used in the online help.

Error Messages
Shows a description of error messages that can appear in the NetWare Administrator.

About NetWare Administrator
Gives version and copyright information about the NetWare Administrator.



Right-Click on an Object
When you put the pointer on an object and click the right mouse button, a menu appears next to the 
object. The menu lists options for all tasks you can complete with that object at that point. Choose the 
option for the task you want to complete.
If a task is grayed, you cannot perform that task on that object, either because of the object type, or 
because you do not have rights.
To close the menu without selecting anything, click the left mouse button.
Example: You need to work with organizational unit SALES. Select SALES; then click the right mouse 
button. A menu appears listing all the tasks you can do with SALES at that point.

Details
Opens an object dialog for the selected object. (This functions the same as choosing "Details" from the 
"Object" menu.)

Trustees of this Object
Opens the "Trustees" dialog for the selected object, where all objects that have a trustee assignment to 
the selected object are listed. Trustees rights and the Inherited Rights Filter can be changed from this 
dialog. (This functions the same as choosing "Trustees of this Object" from the "Object" menu.)

Rights to Other Objects
After you specify which part of the Directory tree to look at, a window opens that shows what the selected 
object has rights to. There is a delay when you choose this option while all objects in the selected part of 
the Directory tree are searched for trustee assignments that include the selected object.
To see who has rights to this object, use the "Trustees of this Object" option.

Browse
Only valid when a container object is selected. This option opens a new Browser window with the 
selected container as the first object and lists all objects within that container.

Create...
Only valid when a container object, Volume object, or directory is selected. This option opens a dialog that
lets you create a new object or directory below the selected point. (This functions the same as choosing 
"Create" from the "Object" menu.)

Delete
Only valid when a leaf object, file, or empty container or directory is selected. This option Deletes the 
selected object after displaying a confirmation box (if selected in options). (This functions the same as 
choosing "Delete" from the "Object" menu.)



Drag and Drop Operations

Drag and drop objects
If you drag one object onto another object, the NetWare Administrator makes the object that you dragged 
a trustee of the object that you dropped on.
If you have rights to add trustees to the object you landed on, the "Trustees of this Object" dialog for the 
object you landed on opens and the object that you dragged is added as a trustee.

Shift-drag and drop objects
If you hold down the <Shift> key while you drag one object onto another object, the NetWare 
Administrator makes the object that you landed on a trustee of the object that you dragged.
If you have rights to add trustees to the object that you dragged, the "Rights to Other Objects" dialog 
opens for the object you dragged, and the object that you landed on is added as a trustee.

Moving objects
Leaf objects can be moved to a new location in the Directory tree by dragging and dropping the object 
while holding the <Ctrl> key. (You can also select the object and choosing "Move" in the "Object" menu.)

Drag and drop files and directories
If you drag one file or directory onto another directory or volume, the NetWare Administrator will move or 
copy that file or directory to the place where you dropped it.
You must have rights to create a file or directory where you land.
You can drag and drop files or directories to other directories on the same volume, or to directories in 
other volumes in the Directory tree. You can land on the Volume object to copy or move something to the 
root directory of that Volume, even if the Volume object is not "open" to display directories.



Rename an Object
When you rename an object, that name appears in the Browser and in any context in which it is 
referenced.

To rename an object
1. Select an object in the Browser.
2. Choose "Rename" from the "Object" menu.
3. Enter the object's new name in "New name" field.
4. To store the old name in the "Other Names" list, select the "Save Old Name" check box.

Note: If the "Save Old Name" box is not checked, the old name is deleted.
5. Choose "OK."

The object is renamed. If you selected the "Save old name" check box, the old name is stored in the 
"Other names" field of the "Identification" page.

Screen regions and buttons
"New name" is where you enter the object's new name.

"Save old name" stores the previous name (if checked).

"OK" saves changes and closes the "Rename" dialog.

"Cancel" closes the dialog without changing the name.



Search Option
The "Search" option allows you to search for any specific object or object class in the container that you 
choose.
When you search, a new Browser window is opened that lists the objects that match your search 
requirements.
You can search for all objects of a certain class, such as all Users. Or you can search for particular 
objects by telling what class they are, and then defining the values of their properties to match.

To search for an object or object class
1. Select a container in the Directory tree where the search should start.

When you choose "Search," the container that you selected is inserted into the "Start from:" field.

If you want to start from a different container, choose the Browser icon  to select an object for the 
"Start from:" field.

Search looks for objects in the Directory tree below the "Start from:" container.
2. Specify how much of the Directory tree to search.

To search only among objects one level below the object in the "Start from" field, do not select 
"Search entire subtree."
To search everything below the object in the "Start from" field, select "Search entire subtree."

3. Select the drop arrow to the right of the "Search for" field to select an object class to search for.
Notice that there are extra object classes listed here.
If you go to Step 7, Search will list all objects of the selected object class. If you complete Steps 4 
through 7, Search will only list objects of the selected class if their properties match what you select 
below.

4. (Optional) Select the drop arrow to the right of the "Property" field to select which property's values 
will be examined.
If you select "None," then all objects of the class selected above will be listed.

5. (Optional) Select how you want to compare a value to the selected property.
You can select "Equal to," "Greater than," "Less than," or other choices.
If you select "Exists," then objects will be included if they have some value in the selected property.

6. (Optional) Enter a value in the field to the right of the comparison method that you entered in Step 5.
If you selected "Exists" in Step 5, you can leave this field blank.
For example, when searching for a certain Profile object, you might select Other Names property, 
Equal To, and Manger's Profile. Or if you are searching for certain Users, you might select 
Department property, Equal To, and Development.



7. Choose "OK."
Objects that match your selections are displayed in a new Browser window. You can now work with 
these objects.

Screen regions and buttons
"Start From" is where you enter the context, or the place in the Directory tree you want to start the 

search from.

"Search Entire Subtree" is what you mark if you want to search to go from the starting point all the 
way down the tree.    Otherwise, the search will be limited to the current container.

"Search For" is where you select the object you want to look for.

"Property" is where you select the property of the object you want to search on.    When you select a 
property, the field below will list the possible comparisons available for that property.    Depending 
on what comparison you chose, you may need to enter information in the field to the right which 
allows you to enter the value of the property you want to search on.

"OK" saves changes and begins the search.

"Cancel" closes the dialog without searching or saving the changes.

"Save" opens the "Save As" dialog, which allows you to save the information of the search for later 
use.

"Open" brings up a dialog that allows you to select a search information file that you saved previously.
You can then use the search information as it is, or edit it to do a new search.



Search Object Classes
In addition to the standard object classes used to create objects, several other object classes are listed in 
the search dialog to assist in finding objects. They are described below.
- "Device" lists all Computer and Printer objects.
- "Locality" is an object class that may be used by third-party products.
- "Organizational Person" lists all Users.
- "Partition" is used only by the Partition Manager. It indicates which containers are at the top of a 

separate partition.
- "Person" lists all Users.
- "Resource" lists all Printer Queue and Volume objects.
- "Server" lists all NetWare Server, Print Server, and AFP Server objects.
- "Top" lists every object in the container that you are searching.



Save As
This dialog allows you to save your search information as files to be opened and used later.    If you 
regularly search on the same information, save the information as a file, and use it, instead of entering the
information each time.
Example: If you are regularly searching for users whose passwords will expire in the next week, type in 
the information once, save the search query, and each time you do the search use the same file, 
changing the date and time value 

Screen regions and buttons
"File Name" is where you type a new filename to save the search information.    If it is an existing file, 

you can use the current name, or type in a new name. A filename can contain up to eight 
characters and an extension of up to three characters. 

"Drives" allows you select the drive where you want to store the file.

"Directories" allows you to select the directory where you want to store the file.

"Save File As Type" allows you to select the file type to be used to store the information.    Quick 
Search Templates type stores the information for quick and uncomplicated searches.

"Read Only" allows you to lock the file so others can use, but not make changes to the file.

"OK" saves changes and closes the dialog.

"Cancel" closes the dialog without saving the changes.



Open
This dialog allows you open and use search information saved as files.    If you regularly search on the 
same information, save the information as a file, and use it again later, instead of entering the information 
each time.
Example: If you are regularly searching for users whose passwords will expire in the next week, type in 
the information once, save the search query, and each time you do the search open and use the same 
file, changing the date and time value 

Screen regions and buttons
"File Name" is where you select the filename of the search information.

"Drives" allows you select the drive where you stored the file.

"Directories" allows you to select the directory where you stored the file.

"Save File As Type" allows you to select the file type you used to store the information.

"Read Only" shows you whether file has been locked so others can use it, but not make changes to it.

"OK" saves changes and closes the dialog.

"Cancel" closes the dialog without saving the changes.



Set a New Context
Opens a dialog that lets you set the context of the Browser to any location in the Directory tree.
If you don't want to see the entire Directory tree, you can set the context to the object that you want to be 
the root of the Browser you are using to view the tree.
You can also see a NetWare v2.x or v3.x server's file system as a separate Browser, even if no object 
exists for that server. Just enter the servername/volume: in the "New Context" field.
Example: If you want to see only objects under Engineering. Acme.US, you can set the context to that 
object (Engineering) and view only objects that are below it.

To set a new context
1. Choose "Set Context" from the "View" menu.

The current context is displayed.
2. Enter the new context in the "New Context" field.

To make the top of the tree the new context, enter [Root].
Example: Enter a container object's complete name: .ou=servers.ou=npd.o=Novell

3. Choose "OK."
The Browser now displays objects starting from the context you entered.



View the Current Directory Context
To view the current directory context, choose "Set Context" from the "View" menu. This opens a dialog 
that shows the object in the Directory tree that is the root object of the active Browser window.
You can also change the context in this dialog.
Choose "Cancel" to return to the Browser without changing your context.



Create an Object

To create an object
1. Select the container that you want the object created in.

For example, to create an object that is subordinate to "SALES," choose "SALES."
You can also select a Volume object or a directory in a volume to create a new subdirectory.

2. From the "Object" menu, choose "Create."
If "Create" is grayed, you do not have sufficient rights, or you selected a leaf object.

3. From the "Class of New Object" list box, choose the class of object you want to create.
If the class of object you want to create isn't listed, you can't create it in the container you selected. 
For example, a Country object cannot contain a User object.

4. Choose "OK."
5. Enter the information required to create the new object.

Note: Although the object appears in the Browser if you define only the fields shown in the "Create" 
dialog, you will usually select "Define Additional Properties" to add information that will be used later.

6. Choose "Create."



Move Objects

To Move objects
1. Select one or more leaf or container objects in the Browser.

You can select multiple objects by holding down <Shift> or <Ctrl> while selecting objects.
Note: You can only move container objects (that contain objects) in NetWare 4.1. Earlier versions, 
including NetWare 4.02, will not let you move containers.
2. Choose "Move" from the "Object" menu.

A "Move" dialog box appears.
A "From" box that lists the objects that you selected to move and an empty "Destination" box with a 
Browser button next to it appear in the dialog box. If you change your mind about any object in the 
list, you can deselect it and it will not be moved.
A "Create Alias in Place of Moved Container" box appears near the bottom of the dialog box. 

3. (Optional) Select to "Create Alias in Place of Moved Container" if you're moving a container object.
Select this option if you're moving a container object and want to create an alias in place of the object 
you're moving. If you are moving a leaf object, the "Create Alias in Place of Moved Container" box is 
not an option and is greyed out.
If you don't create an alias, users who are unaware of the object's new location will not be able to find 
the object in the Directory tree, since they will look for the object in its original Directory location.

4. Choose the Browser button to the right of the "Destination" box.
The "Directory Context" box appears in the lower-right corner of the screen. Use the Browser in this 
box to view the Directory tree's containers. 
The "Objects" box that appears    in the lower-left corner shows the container(s) that you select in the 
Browser.

5. Select from the "Objects" box a container object (an Organization or Organizational Unit) as the place
to move the listed object(s) to; then choose "OK." 
A "Move" dialog box appears once again.
A "From" box lists the object(s) that you selected to move. A "Destination" box with a Browser button 
next to it lists the name of the destination container you've just chosen.
You must have the Create object right to this container object to complete the Move operation.

5. Choose "OK" in the "Move" dialog box.
The selected objects are moved one by one to the selected destination container.
If one of the objects that you selected to move cannot be moved, the "Move" dialog reappears. 
Objects that have been successfully moved are no longer in the list box. The first object listed is the 
one that could not be moved. You can deselect that object and choose "OK" to try again.



Move or Copy Files
1. Select one or more files from a Volume in the Browser.

You can select multiple files by holding down <Shift> or <Ctrl> while selecting files.
2. Choose "Move" or "Copy" from the "Object" menu.

The "Copy or Move Object" dialog appears.
A button at the top of the dialog indicates whether you are moving or copying the selected files. You 
can change this button if you choose to.
The "From" list box shows all the files that you selected in the Browser. If you change your mind about
any file in the list, you can deselect it and it will not be included in the operation.

3. Choose the Browser button to the right of the "Copy selected objects to:" field.
If this dialog appeared after you dragged-and-dropped files, this field is already filled in. Unless you 
want to change it, you can go to Step 5.

4. Select a directory from a volume Using the "Select Object" dialog that appears.
This is the destination directory. You must have the Create directory right to this directory to complete 
the Move or Copy operation. To move or copy to the root directory, select a Volume object.

5. Choose "OK."
The selected files are Copied or Moved to the selected directory.
If one of the files that you selected cannot be moved or copied, the dialog reappears. Files that have 
been successfully moved are no longer in the list box. The first file listed is the one that could not be 
moved. You can deselect that file and choose "OK" to try again.



Create an Object
Use the "New Object" dialog to create new objects in the Directory tree. You must have the Create object 
right on a container to create objects in that container.
You can also create directories on a volume. You must have the Create directory right to do this.

Procedure
Create a new object

Screen regions and buttons
"Parent Object" shows the object that contains the new object.

"Class of New Object" lists classes of objects that you can create in this container. You can only 
select one object class each time you create an object.

"Context" shows the place in the Directory tree where you are creating this object.

"OK" opens the "Create" dialog for the object class that you selected.

"Cancel" closes this dialog without creating an object.



Set a New Context
Opens a dialog that lets you set the context of the Browser to any location in the Directory tree.
If you don't want to see the entire Directory tree, you can set the context to the object that you want to be 
the root of the Browser you are using to view the tree.
You can also see a NetWare v2.x or v3.x server's file system as a separate Browser, even if no object 
exists for that server. Just enter the servername/volume: in the "New Context" field.
Example: If you want to see only objects under Engineering. Acme.US, you can set the context to that 
object (Engineering) and view only objects that are below it.

To set a new context
1. Enter the new context in the "New Context" field.

To make the top of the tree the new context, enter [Root].
Example: Enter a container object's complete name: .ou=servers.ou=npd.o=Novell

2. Choose "OK."
The Browser now displays objects starting from the context you entered.

Screen regions and buttons
"Current Context" shows the context you are at now.

"New Context" is the field where you enter a new context.

"OK" sets the new context that you entered.

"Cancel" closes this dialog without changing your context.



Server Login
This dialog appears when you attempt to set your context to a NetWare v2.x or v3.x server. Because the 
server you entered does not use NetWare Directory Services, you must have a separate account on that 
server. Use this dialog to log in to that server using that user account.

To log in to a NetWare v2.x or v3.x server
1. In the "Name" field, enter the username of the account that you have on the server listed at the top of 

the dialog under "Server."
2. In the "Password" field, enter the password for the username that you just entered.
3. Choose "OK."

If you entered a valid username and password for the server shown, you are logged in, and the 
NetWare Administrator proceeds with your request.



Set Confirmation
Use this dialog to set whether you see a confirmation box when you delete an object, file, or directory. 
This selection remains in effect every time you start the NetWare Administrator, until you make a change 
in this dialog.
Leave the confirmation on unless you are very comfortable with the operation of the NetWare 
Administrator and will be making many deletions where the confirmation might become a nuisance.
You cannot undo a delete object operation.

Defaults
Confirm on delete: On

Screen regions and buttons
"Confirm on Delete" determines whether you see a confirmation box when you delete an object. You 

cannot recover deleted objects, so you should set this to confirm object deletions.

"OK" closes the dialog and makes the settings effective for this and future sessions of the NetWare 
Administrator.

"Cancel" closes the dialog without making the changes effective.



Including Certain Objects in the Browser
Use the "Include" dialog to define by name and by object classes what you want displayed in the Browser.
Container objects are not affected. You always see all container objects.
Example 1: To see only printing-related objects whose names include a "p" in the active Browser window,
select Print Server, Printer, and Queue in the "Object Types" list and type "p*" in the "Directory Services 
Object Name" field.
Example 2: To see all objects starting with "f" in the active Browser window, select all object types in the 
"Object Types" list, and type "f*" in the "Directory Services Object Name" field.
Example 3: To see only User objects in the active Browser window, select Users in the "Object Types" 
list.

Use the "Include" dialog also to define by name which directories and files you want displayed. If you 
select Volume objects to be displayed, you will see the directories and files on those volumes that match 
the .
Example 1:  To see volumes with files that have .EXE extensions in the active Browser window, select 
Volumes in the "Object Types" list, and type "*.exe" in the "DOS File Name" field.
Example 2:  To see volumes with directories and files that have P and R in their names, select Volumes 
in the "Object Types" list, and type "P*R*" in the "DOS File Name" field.

To choose which objects to display in the Browser
1. From the "Object Types" list, select all object classes that you want included in the Browser display.

Select multiple objects in the list by holding down the <Shift> or <Ctrl> keys while selecting objects. 
The <Shift> key allows you to select multiple objects listed next to each other; The <Ctrl> key allows 
you select multiple objects not next to each other in the list.

2. Choose "OK."
The objects that were selected in the list are the only object classes that are displayed in the Browser.

Screen regions and buttons
"Object Types" lists the classes you can select for display.

"Directory Services Object Name" allows you use wildcard characters to view objects whose names 
include a certain letter or group of letters.

"DOS File Name" allows you to use wildcard characters to view files whose names include a certain 
letter or group of letters or that end with a certain extension.

"Save as Default" allows you to save the options you have set for the next time you use NWADMIN.

"Restore Default" allows you to return to the previous default settings and use them as your current 
default settings.

"OK" closes the dialog and sets the Browser to display only the selected objects the next time you 
expand a container or Volume object in the Browser.

"Cancel" closes the dialog without saving the changes.



Sorting Objects in the Browser
Use the "Sort" dialog to select the order you want objects to display in the Browser.

Example:  To see User objects listed first in the Browser, Group objects second, Volume objects third, 
and Printers fourth, use the arrow buttons (icons) to move the objects in the list.

Screen regions and buttons

"Class Types" lists the classes you can select to set the order in which object classes will appear in 
the Browser.

"Save as Default" allows you to save the options you have set for the next time you use NWADMIN.

"Restore Default" allows you to return to the previous default settings and use them as your current 
default settings.

"OK" closes the dialog and sets the Browser to display objects sorted in the order you set the next 
time you expand a container in the Browser.

"Cancel" closes the dialog without saving the changes.



Open Multiple Browser Windows
You can have several Browser windows open at one time. This is useful if you want to drag and drop 
objects from one window to another, or view different areas in a large Directory tree at the same time.

To open a new Browser window
1. Select the container object that you want to be the first object in the new Browser window.
2. Choose "Browser" from the "Tools" menu.

Another Browser window is opened with the context of the object you selected.
Note: To have a Browser window start at the very top of the Directory tree, set the context of a 
Browser to [Root].



Set Preferred Name Space
Use the "Preferred Name Space" dialog to set the way you want to view file and directory names. From 
this dialog you choose the name space that you want to use from the "Preferred Name Space" box. Files 
and directories in all volumes will be displayed using this name space.
If the name space that you selected is not available on a volume, the DOS name space will be used to 
display files and directories on that volume.

Screen regions and buttons
"Preferred Name Space" lets you select the name space for how you want files and directories 

displayed. Possible options are DOS, Macintosh, NFS, FTAM, and OS/2.

"OK" saves all changes and returns you to the Browser.

"Cancel" closes this dialog without making any changes.



Salvage Option
The Salvage option allows you to recover previously deleted files, or permanently delete them to save 
disk space.

Procedures
Salvage One or More Files
Permanently Delete All Deleted Files in a Directory
Permanently Delete One or More Files
Change Which Files Are Listed in the "File List" Box
Change How the Files in the "File List" Box Are Sorted
Change Which Directory's Files Are Listed

Screen regions and buttons
"Include" allows you to select which files to display.

"List" displays files specified in the "Include" field.

"Sort Options" defines how files are sorted.

"Source" shows which directory the files listed are located in.

"File List box" shows all deleted files in the directory with the pattern chosen in the "Include" field.

"Salvage" recovers the selected files.

"Purge" permanently deletes files.

"Close" closes the "Salvage" dialog and returns you to the Browser.



Permanently Delete All Deleted Files in a Directory
Note: If you are purging from Deleted Directories as your Source Option, a DELETED.SAV directory must
exist in the root directory of this volume; it must be flagged as Hidden.
1. Choose "Purge."

You do not have to choose "List" first.
If you selected any files in the "File List" box, the "Include" field applies and only the selected files are 
purged.
You must be the owner of or have at least the Erase file right to any file that you want to Purge.

2. Choose "Yes."
A count of the files found is displayed, and decreases to zero as they are purged. All deleted files in 
the directory are now permanently deleted.

3 Choose "Close"
You return to the Browser.



Permanently Delete One or More Files
Note: If you are purging from Deleted Directories as your Source Option, a DELETED.SAV directory must
exist in the root directory of this volume; it must be flagged as Hidden.
1. Select the file or files that you want to purge from the "File List" box.

If the files you want are not shown, change the source or select another directory before choosing 
"Salvage." You must be the owner of or have at least the Erase file right to any file that you want to 
Purge.

2. Choose "Purge."
A count of the files found is displayed, and decreases to zero as they are purged. All deleted files in 
the directory are now permanently deleted. Purged files cannot be recovered later.

3. Choose "Close."
You return to the Browser.



Salvage One or More Files
Note: If you are salvaging from Deleted Directories as your Source Option, a DELETED.SAV directory 
must exist in the root directory of this volume; it must be flagged as Hidden.
1. Select the file or files that you want to salvage from the "File List" box.

If the files you want are not shown, change the source or select another directory before choosing 
"Salvage."
You must have the Create right on a file to salvage it.
If you are salvaging a file from a deleted directory, you must have Supervisor right to the root directory
of the volume.

2. Choose "Salvage."
The files disappear from the "File List" box. They will now appear in regular file listings (DIR, NDIR, or
the Browser).

3. Choose "Close."
You return to the Browser.



Change Which Files Are Listed
1. Select the "Include" field.
2. Enter a file pattern that describes the files that you want shown in the "File List" box.

Example: Type *.* to display all files. Type *.DAT to display all data files.
3. Choose "List."

Listing the file can take several minutes for a large directory. You can change the source directory, or 
purge files without first listing them.
The files matching the file specification that you entered are displayed in the "File List" box. These 
files can be permanently deleted or salvaged.



Change How Files Are Sorted
1. Choose the arrow by the "Sort Options" field.
2. Choose the sort option that describes how you want the files in the "File List" box displayed.

You can only select one sort option at a time. The left-to-right order of the fields does not change.
Example: If you want all files organized by when they were deleted, choose "Deletion Date" as the sort 
option. The first file listed is the most recent one deleted, and the last file listed is the one deleted the 
longest time ago.



Change Which Directory's Files Are Listed
1. Choose the arrow by the "Source" drop-down list.
2. Choose a source directory.

2a. To display files from the directory that you selected before choosing "Salvage," choose 
"Current directory."
You must have the Create right to a file or you cannot salvage it.

2b. To display files from directories that have been deleted on this volume, choose "Deleted 
directories." A DELETED.SAV directory must exist in the root directory of this volume.
You must have the Supervisor right to the root directory of the volume in order to salvage files 
from a deleted directory.

Note: If you have selected deleted directories as your source and you are working on a SYS: volume, it 
can take a long time to list the files. You should consider limiting the list with the "Include" field. You can 
select a source directory, and enter a value in the "Include" field before choosing "List."



Salvage - Include Field
The "Include" field defines which files are shown in the "File List" box.
When you have changed the pattern in the "Include" field, choose "List." The list of files changes to show 
those files.
You can enter information in the "Include" field and choose a source directory before listing files. This may
save time. You do not have to choose "List" before purging all files in this directory.
Example: Type *.* to display all files. Type *.DAT to display all data files.



Salvage - List button
Choose "List" to indicate that you have finished entering changes in the "Include" field. The "File List" box 
is updated according to what you entered.
You can enter information in the "Include" field and choose a source directory before listing files. This may
save time. You do not have to choose "List" before purging all files in this directory.
Note: If you have selected deleted directories as your source and you are working on a SYS: volume, it 
can take a long time to list the files. You should consider limiting the list with the "Include" field.



Salvage - Sort Options
The "Sort" option determines how files in the "File List" box are organized.
Organize files to more easily find the files you are looking for. The "Sort" option changes which files are 
listed from first to last; it does not change the left-to-right order of the fields.

Sort Options
"Filename" sorts alphabetically by filename.

"Deletor" sorts alphabetically by name of user who deleted the file.

"Deletion date" sorts numerically by the date that the file was deleted.

"File size" sorts numerically by how large the file is.

"File type" sorts alphabetically by the file's three-letter extension. (for example .EXE or .DAT.) Files 
without extensions (including those used by non-DOS name spaces such as Macintosh) are listed
first in alphabetical order by filename.



Salvage - Source
The "Source" field determines which directories the files listed in the "File List" box are in.
Note: If you have selected deleted directories as your source and you are working on a SYS: volume, it 
can take a long time to list the files. You should consider limiting the list with the "Include" field, but you do
not have to "List" the files until both the source directory and the include field are ready.

Source options
"Current directory" lists deleted files from the directory that you selected. You need the Create right to 

a file to salvage it from the current directory.

"Deleted directories" lists deleted files from directories that have been deleted. You need the 
Supervisor right to the root directory of the volume in order to salvage files from a deleted 
directory. A DELETED.SAV directory must exist in the root directory of this volume.



Salvage - File List Box
The "File List" box shows all files in the selected directory that have been deleted and that can be 
salvaged or purged.
You can change which files are shown with the "Include" file specification and "Source." You can change 
how the list of files is organized with the "Sort Options" can select all three fields before listing the files; 
this may save time in large directories. You also do not have to list the files before purging all files in the 
directory; just choose "Purge."

Screen regions
"Filename" displays the name of the file.

"Deleted Date" displays the date that the file was deleted.

"Deleted Time" displays the time that the file was deleted.

"File Size" displays the size of the file in bytes.

"Deletor Name" displays the name of the user who deleted the file.

"Last Update Date" displays the date that the file was last written to.

"Last Update Time" displays the time that the file was last written to.

"Last Update Name" displays the name of the user who last wrote to this file.

"Creation Date" displays the date that the file was first created in this location.

"Creation Time" displays the time that the file was first created in this location.

"Owner Name" displays the name of the user who created the file.

"Archive Date" displays the date that the file was last backed up.

"Archive Time" displays the time that the file was last backed up.

"Archiver Name" displays the name of the user who last backed up this file.

"Last Access Date" displays the date that the file was last read.



Salvage - Salvage button
Choose "Salvage" to salvage all selected files. You must have the Create right to a file in order to salvage 
it.
Files that are salvaged can be used as if they had never been deleted.
Files that have been permanently deleted (purged) cannot be salvaged or reused.



Salvage - Purge button
Choose "Purge" to permanently delete all selected files. You must be the owner of or have at least the 
Erase right to a file in order to purge it.
If you have not chosen "List" yet, or if no files are selected, all deleted files in the directory that you 
selected will be permanently deleted, not just the deleted files described by the pattern in the "Include" 
field. A confirmation dialog appears before files are purged.
Permanently deleting files can speed up your system and free disk space, but permanently deleted files 
cannot be recovered for use later.



Salvage - File Already Exists
A file already exists in this directory with the same name as the file that you are trying to salvage. You 
must enter a new name for the file that you want to salvage.
1. Enter a new filename in the "Filename" text box.
2. Choose "OK."

The file is salvaged and given the new name you entered in this dialog.
If you choose "Cancel," this file is not salvaged.



Print the Objects in the Browser
You can print the objects listed in the Browser as a one item per line list, in a two column format, or as a 
file that you can manipulate or print later.

Screen regions and buttons

"Printer" lists the printer you are currently connected to.

"Print in Two columns" allows you to choose the format of the printed objects--as a list with each 
object on a separate line, or in two columns.

"Print to File" allows you to save the objects listed in the Browser to a file.

"Print Quality" allows you to elect the dots per inch for the print job.

"OK" saves all changes and returns you to the Browser.

"Cancel" closes this dialog without making any changes.

"Setup" allows you to select the way the information prints on the page, the paper size and source, 
and the printer.



Print Setup
This dialog allows you to choose a printer for the print job, choose the way the information appears on the
page, and choose the paper size and source.

Screen regions and buttons

"Printer" allows you to choose the printer to print to.

"Orientation" allows you to choose layout of the information on the page.

"Paper" allows you to choose the paper size and source for the print job.

"OK" saves all changes and returns you to the Browser.

"Cancel" closes this dialog without making any changes.

"Options" allows you to choose to print to the printer or to a file, change the margins, set the scaling, 
or send a header.



New Features
These are the new features in this version of the NetWare Administrator.

Browser
We removed the limit of 1800 objects that can be displayed. The limitation now is the memory 

available in MS Windows.

We enhanced filtering so you can view objects by name and class. For example, you can view all 
server objects beginning with the letter "T." Use the Include option under the View menu.

You can specify the order that objects are listed in the Browser. For example, you can list User 
objects first, Server objects second, Volume objects third, etc. Use the Sort by Object Class 
option in the View menu.

You can save your settings so the Browsers you have open, or the order you have objects listed in 
will be the same when you open the NetWare Administrator each time. Use the Save Settings On 
Exit option in the Options menu.

You can print the contents of the Browser screen. Use the Print option in the Object menu.

You can find objects more quickly by beginning to type the name. The cursor will be positioned 
automatically to the letters you type in.

You can now distinguish Alias objects from the objects being aliased. Alias objects will have a mask 
as part of the icon. The icon will also show the class of object being aliased.

You can choose to view the trustees of an Alias instead of the trustees of an object being aliased. Use
the Get Alias Trustees option in the Options menu.

Search
You can save and reuse search queries you have created. Use the Save or Open options on the 

Search dialog. The Search option is in the Object menu.

You can search for more properties and values than in previous versions.

Naming Conventions
You no longer are required to include the object type prefix in object names. For example, 

CN=Fred.OU=Marketing.O=Acme would now be displayed and written as Fred.Marketing.Acme.

Files and Directories
You can select a context and view an object's rights to files and directories for all volumes in that 

context, and in subordinate contexts. Use the Find option on the Right to Files and Directories 
page.

Files and directories will now show NFS information for volumes where applicable.

Salvage
Salvage will now show up to 5,000 files.

You can cancel the retrieval of a file while it is being salvaged.

You can filter files by file name and extension.



Setting Up NetWare Print Services
Network printing differs from stand alone printing in that it requires storage, intermediate processing, and 
transmission between processing locations.    NetWare Print Services requires you to create three printing
objects--a Print Server, a Printer, and a Print Queue--to provide these functions .      
After you create the printing objects, Print Servers must be assigned to Printers, and Printers must be 
assigned to Print Queues. 

To create basic NetWare Print Services
1. Select the context or Organizational Unit where you want to create printing objects.
2. Create a Print Queue object.

We recommend that you choose the Volume that has the most free disk space when creating the 
Print Queue.

3. Create a Printer object.
Select "Define Additional Properties" when creating the Printer. The object dialog for the Printer 
appears when you choose "Create."

4. Select the "Assignments" page button.
5. Add the Print Queue object that you created in Step 2 to the "Assignments" page for the Printer.

This assigns the Printer to the Print Queue.
6. Select the "Configuration" page and make any necessary changes.

Note: The default printer configuration is a parallel printer cabled to a NetWare server's LPT1 port 
using a polled interrupt.

7. Choose "OK" to return to the Browser.
8. Create a Print Server object.

Select "Define Additional Properties" when creating the Print Server. The object dialog for the Print 
Server appears when you choose "Create."

9. Select the "Assignments" page of the Print Server object dialog.
10. Add the Printer object that you created in Step 3 to the "Assignments" page for the Print Server.

This assigns the Print Server to the printer.    Each Print Server can support up to 256 printers. 
11. Choose "OK" to return to the Browser.
12. Load the print server software (PSERVER.NLM) at the NetWare Server console.
13. Load the correct network printer driver. Load NPRINTER.EXE for printers cabled to workstations and 

NPRINTER.NLM for printers cabled to NetWare servers.
Users can now send print jobs to the printer or print queue.



Load Print Server Software 
In order for NetWare Print Services to function, you must load a print server module (PSERVER.NLM) on 
your NetWare Server for the Print Server object already created. 
You cannot load multiple copies of PSERVER.NLM on one NetWare server. PSERVER.NLM supports up 
to 256 printers.

To load a print server module
1. Go to the NetWare Server console by using the "Remote Console" option under the "Tools" menu, or 

go to the physical server.
You cannot load PSERVER.NLM from within the NetWare Administrator dialogs.

2. At the NetWare server console prompt, type "LOAD PSERVER."
A text-based Browser appears.

3. Select the context or Organizational Unit where the Print Server object is defined and choose the 
Print Server object.
Example: Choose "PS-Sales" in the "Sales" context.

4. To avoid browsing for the Print Server, type 
LOAD PSERVER .PrintServerName.context
at the NetWare server console.
Example: To load print server PS-SALES in the Sales context of Organization Novell,    type LOAD 
PSERVER .PS-SALES.SALES.NOVELL at the NetWare server console.

5. Load NPRINTER.EXE or NLM for each network printer. 
Note: Only printers cabled to the NetWare server that loads PSERVER.NLM can be configured to 
have their NetWare printer driver (NPRINTER.NLM) loaded automatically ?? how?? when the Print 
Server loads. 



Load Network Printer Software 
NetWare Print Services require you to load a network printer driver for each printer.    The printer 
driver....does what?? 
Where you load the printer driver is determined by how the printer is connected to the network.    Network 
printers can be cabled:
- Directly to the network cabling (NPRINTER software loads at the printer)
- To a DOS workstation (Load NPRINTER.EXE on a DOS or Windows Workstation)
- To an OS/2 workstation (Load NPRINTER.EXE on an OS/2 Workstation)
- To a NetWare server not running PSERVER.NLM (Load NPRINTER.NLM at the NetWare Server 

Console)
- To a NetWare server running PSERVER.NLM (NPRINTER.NLM can be load automatically or 

manually???where to go for autoload vs manual???)



Load NPRINTER.NLM
1. Go to the NetWare Server console by using the "Remote Console" option under the "Tools" menu, or 

go to the physical server.
Note: You cannot load the NPRINTER.NLM from within the NetWare Administrator dialogs.

2. At the NetWare Server console prompt, type
LOAD NPRINTER PrintServerName PrinterNumber
Replace PrintServerName with the advertising name (not the complete object name) of the Print 
Server.
Replace PrinterNumber with the logical printer number (the Print Server object dialog displays the 
advertising name on the "Identification" page and the logical printer number next to the printer name 
on the "Assignments" page). 
Example: To load printer P1 assigned to print server PS-Sales with logical number 0, type LOAD 
NPRINTER P1 PS-SALES 0

Note: NPRINTER.NLM can be loaded automatically if the NetWare server is running PSERVER.NLM.    To
autoload NPRINTER.NLM....??



Load NPRINTER.EXE on a DOS or Windows Workstation
The NetWare printer driver (NPRINTER.EXE) for a DOS or Windows workstation is a terminate-and-stay-
resident program. 
NPRINTER.EXE allows a single workstation to support up to seven printers.    NPRINTER.EXE must be 
loaded one time for each printer; it can be loaded either from a menu or from the command line. 

On a Windows workstation
You must load NPRINTER.EXE before loading Windows v3.0 or v3.1 on the same workstation, and you 
must do one of the two following options:
- Configure the printer to use polled mode ??glossary?? instead of a specific interrupt number, or
- If you want to use a specific interrupt, place the following lines in the Windows SYSTEM.INI file under 

the heading "[386Enh]"
LPT1AutoAssign=0
LPT1irq=-1
Replace LPT1 with the port that the printer is cabled to (LPT2, COM1, COM2, etc.).

To load using the menu option
1. At the DOS prompt, type 

NPRINTER
2. (Optional) Press <F4> to switch to Directory Services mode and then press <Enter> to browse for a 

printer directly. You can then skip the remaining steps.
3. Choose a Print Server.

A list of printers assigned to this Print Server appears.
4. Choose a printer.

If you choose a printer of type "Other/Unknown" instead of a manual load parallel or serial, you must 
now specify if the printer is cabled to a parallel or serial port, the port number, the interrupt, and so 
forth.

To load using the command line option
At the DOS prompt, type NPRINTER PrinterName and specify the full name that includes the directory 
tree. 
Example: To load printer P1 in the Sales context of Organization Novell, type 
NPRINTER .CN=P1.SALES.NOVELL and place the line in AUTOEXEC.BAT file for automatic execution 
each time the workstation boots. NPRINTER.EXE cannot be loaded directly from a login script.

To unload NPRINTER.EXE on a DOS or Windows workstation
Unload Windows if it is running. At the DOS prompt, type NPRINTER /u and the most recently loaded 
NetWare printer driver will unload. You can unload only one printer driver at a time.



Load NPRINTER.EXE on an OS/2 Workstation
The NetWare printer driver for an OS/2 workstation is available as an icon in the Novell icon created when
you install the NetWare OS/2 Requester. 
NPRINTER.EXE can run any printer configured as manual load or type "Other/Unknown."

To load NPRINTER.EXE
1. Choose the NPRINTER icon from the Novell-Icon View window on your desktop.

The NPRINTER window appears. If the printer you want to load is already configured, go to Step 2. 
1a. Choose "Define" from the "Printers" menu.

A list of printers currently defined on this workstation appears in the "Define Printers" dialog.
1b. Choose "Add" to define a printer for NPRINTER to load on this workstation.
1c. Type a printer name in the "Description" field.

We recommend that you use the same name of the printer configured in NetWare Administrator, 
but the name can be different.

1d. Choose a Print Server from the list.
A list of printers now appears in the dialog. These printers were created using NetWare 
Administrator or PCONSOLE.

1e. Select the desired printer.
This specifies the printer for NPRINTER to later load.

1f. (Optional) Select the box for "Load on startup" if you want NPRINTER to load the NetWare 
printer driver for this printer when NPRINTER is loaded.

1g. Choose the arrow box to the right of the "Default OS/2 Print Queue" field and choose and 
OS/2 print queue.
OS/2 print queues are created when you create printers as documented in your OS/2 manual. 
NPRINTER requires that an OS/2 print queue exist on the workstation.

1h. Choose "OK."
This printer now appears in the "Define Printer" dialog box with any other printers currently 
defined on this workstation.

1i. (Optional) Repeat Steps 1a through 1h for each additional printer NPRINTER will load on this
workstation.
You can define as many printers as you desire, but NPRINTER can only run seven concurrently 
on the same workstation.

1j. Choose "Exit" to close the "Define Printers" dialog.
2. Choose "Load" from the "Printers" menu.

The "Load Printers" dialog box appears. If the "Load" option is grayed so that you cannot select it, or 
if the printer you want is not listed, you must configure a printer. See Step 1a.

3. Choose a printer.
NPRINTER loads the NetWare printer driver for this printer. You can unload any or all printer drivers 
by choosing "Unload" from the "Printers" menu. Highlight the printers you want to unload and choose 
the "Unload" button, or unload them all by choosing "Unload All."



Create a Print Server Object 
A Print Server object represents a print server on the network. Print servers direct print jobs from print 
queues to the appropriate printers.
NetWare Print Services require a Print Server object along with a Printer and Print Queue in order for 
network users to share printers.

To create a Print Server object under the selected container
1. Type a name for this Print Server object in the "Name" text box. 

This is both the name of the Print Server object as it appears in the Directory tree and as it is loaded 
at the NetWare server console. You must follow the object naming conventions. 

2. (Optional) To define additional information about this Print Server right now, select "Define Additional 
Properties." 
You cannot select this if you select "Create Another Print Server."

3. (Optional) To create another Print Server immediately after this one, select "Create Another Print 
Server."
You cannot select this if you select "Define Additional Properties."

4. Choose "Create."
If you selected "Define Additional Properties," the Print Server object dialog appears.
If you selected "Create Another Print Server," this dialog appears again.

Screen regions and buttons
"Print Server Name" shows the name of the Print Server as it appears in the Directory tree and as it is

loaded at the NetWare server console.

"Define Additional Properties" lets you define more information about this Print Server (such as which 
printers it services and which users can access it) immediately after creating it.

"Create another Print Server" repeats this dialog rather than returning to the Browser.

"Create" creates the new Print Server object.

"Cancel" returns to the Browser without creating a Print Server.

Related topic
Setting Up NetWare Print Services



Create a Printer Object 
A Printer object represents a physical printer on the network. 
NetWare Print Services requires a Printer object along with a Print Server and Print Queue in order for 
network users to share printers.

To create a Printer object under the selected container
1. Type a name for this Printer object in the "Name" text box. 

This is the name of the Printer object as it appears in the Directory tree. You must follow the object 
naming conventions.

2. (Optional) To define additional information about this Printer right now, select "Define Additional 
Properties."
You cannot select this if you select "Create Another Printer."

3. (Optional) To create another Printer object immediately after this one, select "Create Another Printer."
You cannot select this if you select "Define Additional Properties."

4. Choose "Create."
If you selected "Define Additional Properties," the Printer object dialog appears.
If you selected "Create Another Printer," this dialog appears again.

Screen regions and buttons
"Printer Name" shows the name of the Printer as it appears in the Directory tree.

"Define Additional Properties" lets you define more information about this Printer (such as which 
queues service it and which users have access to it) immediately after creating it.

"Create another Printer" repeats this dialog rather than returning to the Browser.

"Create" creates the new Printer.

"Cancel" returns to the Browser without creating a Printer.

Related topic
Setting Up NetWare Print Services



Create a Print Queue Object 
A Print Queue object represents a network print queue, a subdirectory that stores print jobs. 
NetWare Print Services requires a Print Queue object along with a Printer and Print Server in order for 
network users to share printers.

To create a Print Queue object under the selected container
1. Type a name for this Print Queue object in the "Name" text box. 

This is the name of the Print Queue object as it appears in the Directory tree. You must follow the 
object naming conventions.

2. Type a name for the print queue volume in the "Volume" text box, or choose the Browser button  
to browse.
We recommend that you choose the volume that will usually have the most free disk space.

3. (Optional) To define additional information about this Print Queue right now, select "Define Additional 
Properties."
You cannot select this if you select "Create Another Print Queue."

4. (Optional) To create another Print Queue immediately after this one, select "Create Another Print 
Queue."
You cannot select this if you select "Define Additional Properties."

5. Choose "Create."
If you selected "Define Additional Properties," the Print Queue object dialog appears.
If you selected "Create Another Print Queue," this dialog appears again.

Screen regions and buttons
"Directory Service Queue" allows you to create both a print queue object in your directory tree and a 

physical directory for that print queue on a server.

"Reference a Bindery Queue" allows you to create a print queue object for a print queue that already 
exists outside your directory tree.    This queue is a previously defined directory on a Pre NetWare
4 server or a NetWare 4 server in another directory tree.    Creating a print queue object for this 
queue allows you to manage printing outside of your current directory tree.

"Print Queue Name" shows the name of the Print Queue as it appears in the directory tree.

"Print Queue Volume" shows the name of the volume on which this print queue's print jobs are stored.

"Define Additional Properties" lets you define more information about this Print Queue (such as which 
printers it services and which users can access it) immediately after creating it.

"Create another Print Queue" repeats this dialog rather than returning to the Browser.

"Create" creates the new Print Queue.

"Cancel" returns to the Browser without creating a Print Queue.

Related topic
Setting Up NetWare Print Services



View or Change a Printer Object 
The "Identification" page describes this Printer object. You can use this page to store information such as
- Where the printer is located
- Additional names for the printer
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Setting up NetWare Print Services
See the Status of this Printer
Enter a Description for this Printer
Enter another Name for this Printer

Screen regions and buttons
"Other name" lists identification information associated with this printer that helps you search for and 

identify specific printers.

"Description" describes the function the printer performs (such as print Sales documents).

"Network Address" lists the 16-digit (8-byte) number associated with the NetWare Server or 
workstation that this printer is cabled to???used for what???.

"Location" specifies the printer's physical location (such as a person's office).

"Department" shows the department or division that generally uses the printer.

"Organization" lists the organization that can use the printer.

"Printer Status" allows you to see information such as which print form the printer is using and how 
the printer is servicing print jobs.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



See the Status of this Printer
You must be an operator ??gloss?? or user of a Print Server that services this Printer to be able to see its
status.    (See "Printer Status" a few topics down, info is almost identical)???
1. From the Printer Identification page, choose "Printer Status."

A dialog appears which shows the various status elements for printers.
2. Use the buttons to make any changes to this Printer's status (such as changing forms or sending a 

Form Feed). 
You must be an operator to change the Printer's status.

3. Choose "Close" to return to the "Identification" page of the Printer object dialog.
Changes to status take place ???immediately, after you leave the Printer dialog???

Screen regions and buttons
"Status" shows the current status of this printer, such as "Ready" or "Not connected."

"Mounted Form" shows the number of the form ??gloss??? that is currently mounted in the printer. 
Only print jobs that specify this printer form number can be printed until a new printer form is 
mounted with the "Mount Form" button.

"Service Mode" shows which service mode is being used by this printer and its associated print 
queue. The Service Mode determines how jobs within a print queue are organized for the most 
efficient use of the printer.

"Current Job Information" includes all of the information about the print job that is currently being 
printed on this printer. Most of this information can only be changed by going to the print queue 
and selecting this print job from the list of jobs.

"Print Queue" indicates the print queue that is submitting this print job.

"Job Name" indicates the name of this print job, which is usually the name of the User that submitted 
the print job to the print queue.

"Job Number" is the number representing the position of this print job within the print queue which 
submitted it.

"Form" shows which printer form this print job is using. This print job cannot be printed unless this 
form matches the "Mounted Form" field above the "Current Job Information."

"Copies Requested" indicates the number of copies of this print job that the User who submitted it 
requested to be printed.

"Copies Complete" indicates how many of those copies requested have been printed so far.

"Size of 1 Copy" indicates the size of each copy of this print job. This is like the "File Size" field when 
you see the details of a print job within the print queue.

"Bytes Printed" indicates the total number of bytes sent to the printer for this print job. It will be close 
to the "Size of 1 Copy" multiplied by the "Copies Completed" numbers.

"Percent Complete" indicates how much of this print job is completed, which is determined both by 
the size of one copy and the number of copies requested for this print job.

"Abort Job"    allows you to cancel this print job and immediately stop printing.

"Pause" changes the status of this print job from active to "On hold." Only the User who submitted a 
print job or a print queue operator can perform this action.

"Start" changes the status of this print job from "On hold" to "Active," which will start printing again if 
the correct form is mounted and the printer is active.

"Mount Form" allows you to specify a new printer form that you have mounted on this printer. When 
you use this button, the "Mounted Form" field will change to reflect the newly mounted form, and 



only print jobs that specified the new form can be printed.

"Eject Page" sends a command to this printer to eject the page that is being printed. This is like a 
Form Feed command.

"Close" closes this dialog and returns to the "Identification" page of the Printer object dialog.



Printer Assignments Page 
The "Assignments" page controls which Print Queues are assigned to this Printer object. For example, 
you can use this page to
- Add or delete print queue assignments
- Specify a default print queue for CAPTURE and NPRINT commands that do not specify a printer or 

print queue
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Setting up NetWare Print Services
Add a Print Queue to the List of Queues Assigned to this Printer
Delete a Print Queue from the List of Queues Assigned to this Printer
Change a Print Queue's Priority
Change Which Print Queue is the Default Print Queue

Screen regions and buttons
"Print Server" names the Print Server object that provides print jobs to this printer.

"Print Queues" lists the print queues and the service priority for each print queue that is serviced by 
this printer.

"Add" lets you add a print queue to the list of print queues assigned to this printer.

"Delete" lets you delete the highlighted print queue from the list of Print Queue objects.    If you delete 
a print queue, all its jobs are lost.

"Priority" allows you to define whether the Print Server will send print jobs from one Print Queue to the
printer before or after print jobs in other Print Queues assigned to this printer.

"Default Print Queue" shows which of the print queues in the "Print Queues" list is the default. The 
default queue is used if no queue is specified with a print job.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Add a Print Queue to the List of Print Queues Assigned to this Printer
1. Choose "Add."
2. Choose the Print Queue that you want to add to the list.
3. Choose "OK."

You return to the "Assignments" page, and the new Print Queue object is displayed.
The Print Server assigned to this printer can now take print jobs from the Print Queue that you added 
and send them to this printer.



Delete a Print Queue from the List of Queues Assigned to this Printer
1. Select a Print Queue from the "Print Queue" list box.
2. Choose "Delete."

The Print Queue is deleted from the list. Print jobs sent to that Print Queue will not be printed.



Change a Print Queue's Priority
A Print Queue's priority determines whether the Print Server will send print jobs from this Print Queue to 
the printer before or after print jobs in other Print Queues assigned to this printer.
1. Select a Print Queue from the list of Print Queues.

The priority of the selected Print Queue is shown in the "Priority" field.
2. Enter the new priority for the selected Print Queue in the "Priority" field.

You can select a number from 1 to 10, inclusive. Print Queues with lower priority numbers will be 
serviced before Print Queues with higher numbers.

3. Choose "OK."
The priority is changed, and you return to the Browser.



Change which Print Queue is the Default Print Queue
The Default Print Queue is used for print jobs that do not specify a Print Queue (for example, with the 
CAPTURE command).
1. Choose the arrow to the right of the "Default Print Queue" field.

The Print Queues listed above in the "Print Queues" list appear in the drop-down list box.
2. Select a Print Queue object from the list.

The selected Print Queue appears in the "Default Print Queue" field.



Printer Notification Page 
The "Notification" page controls the objects that are notified when the printer requires servicing (when it is
out of paper, jammed, etc.). You can
- Add or delete User or container objects that receive printer error messages
- Specify how soon and how frequently printer error messages arrive
- Specify that the print job owner receive the printer status messages.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Setting up NetWare Print Services
Add to the List of Users Notified about this Printer
Delete from the List of Users Notified about this Printer
Change the Delays Used between Notifying Users about this Printer

Screen regions and buttons
"Notify" field of the "Notification" list shows objects that are notified about this printer.

"First" field of the "Notification" list shows how long (in minutes) after an event that a notice is sent to 
the object in the "Notify" field.

"Next" field of the "Notification" list shows how long (in minutes) after the first notification of an event 
that a subsequent notices are sent to the object in the "Notify" field.

"Add" lets you add an object to the "Notification" list.

"Delete" lets you delete the selected object from the "Notification" list.

"Notification Settings" allows you to change notification intervals.

"Notify Print Job Owner" enters (Print Job Owner) as an object in the "Notification" list, so that the 
object that sends the print job will receive notifications.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Add to the List of Users Notified about Printer Status
1. Choose "Add."
2. Choose the object that you want to add to the list.
3. Choose "OK."

You return to the "Notifications" page, and the new object is added to the list. All of the objects listed 
will be notified of printer status.



Delete from the List of Users Notified about Printer Status
1. Select an object from the "Notifications" list box.
2. Choose "Delete."

The object is deleted from the list. It will no longer be notified of printer status. Note that if you delete 
the (Print job owner) entry, you can add it to the list by selecting the "Notify Print Job Owner" check 
box.



Change the Delays Used between Notifying Users about Printer Status
1. Select the object from the "Notifications" list for which you want to change the delays for notification of

printer status.
The notification settings for the selected object appear in the "Notification settings" fields.

2. Enter new numbers into the "First" and "Next" fields as desired.
The numbers represent the time in minutes that the Print Server will wait to notify the selected object 
of an event related to this printer. "First" and "Next" represent a first and second notification of the 
event, if the printer status remains unchanged.

3. Choose "OK."
You return to the Browser.



Printer Features Page 
The "Features" page stores additional printer information such as
- Amount of memory
- Supported typefaces
Users can take advantage of this information in searches. For example, a user can search only for 
printers with at least 4 MB (4096 KB) of memory and the Futura font. 
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Page Description Language for this Printer
Add to the List of Supported Typefaces for this Printer

Screen regions and buttons
"Page Description Language" shows the languages supported by the printer. To specify a language, 

choose the "More" button and choose "Add" for each language the printer supports.

"Memory in KB" shows the amount of RAM installed in the printer.

"Supported type faces" shows the fonts that the printer can use. You must enter the correct typefaces;
they are not read from the printer.

"Supported Cartridges" lists the font cartridges that the printer can use. You must enter the correct 
cartridges; they are not read from the printer.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Add a Page Description Language for this Printer
A page description language is a protocol or type of printing that this printer can receive (for example, 
PCL 5 or PostScript).
Enter the page description languages that this printer supports so that Users can use search to locate 
printers that support language that they need.
1. Enter a description of the main page description language used by this printer in the "Page 

Description Language" field.

2. To enter other page description languages for this printer, choose the "More" button  to the right of
the "Page Description Language" field.

3. Add other descriptions in the "Add Value" dialog which appears.
4. Choose "OK."

You return to the "Features" page of the Printer object dialog.



Add to the List of Supported Typefaces for this Printer
A typeface is a collection of fonts in different stroke weights and sizes that this printer can produce (for 
example, Helvetica and Times Roman).
Enter the typefaces that this printer supports so that Users can use search to locate printers that support 
a typeface that they need.
1. Enter the first typeface (the default) used by this printer in the "Supported Typefaces" field.

2. To enter other typefaces (most network printers have many), choose the "More" button  to the 
right of the "Supported Typefaces" field.

3. Add other descriptions in the "Add Value" dialog which appears.
4. Choose "OK."

You return to the "Features" page of the printer object dialog.



Printer Configuration Page 
The "Configuration" page allows you to store or define information about the hardware configuration of 
this printer and how it is used in the network. For example, you can define information such as
- Printer type: Serial, Parallel, AIO, Unix, AppleTalk, or XNP (eXtended NetWare Printer protocol) 

printers
- Communication parameters that vary according to the printer type (this does not apply to printers with

type Other/Unknown or XNP) 
- Frequency that the Print Server checks for print jobs for this printer
Note: The default values are for a parallel printer that is cabled to the LPT1 port of a NetWare Server 
running PSERVER.NLM.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Setting Up NetWare Print Services
Change the Printer Type
Change the Service Mode for Forms Used by this Printer

Screen regions and buttons
"Printer Type" shows the communication protocol used by this printer (for example, parallel or serial).  

Printers that attach to an OS/2 workstation or directly to the network, require type 
"Other/Unknown." 

"Communication Parameters" allows you to see the values defined for the selected printer type. 
Different dialogs are used depending on which printer type is selected. The dialog appears 
automatically whenever you change the printer type.

"Banner Type" shows whether the printer produces banner pages in text or postscript mode.

"Service Interval" shows how often the Print Server checks the Print Queue for print jobs going to this 
printer. The default is every 15 seconds. Values from 1 to 15 are allowed.

"Buffer Size in KB" shows how large each piece of data sent to this printer can be. The default is 3 KB
(3,072 bytes). Values from 1 to 20 are allowed.

"Starting Form" shows the number of the printer form that this printer will service when the NetWare 
printer driver is loaded. Printer forms are defined in the Organization or Organizational Unit object
above this printer. Any Form Number defined there can be used here (values from 0 to 255 are 
possible).

"Network Address Restrictions" shows the network addresses that this printer can use. The "Set" 
button is used to add an IPX    network address to this field.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Change Printer Type
1. Choose the down arrow to the right of the "Printer Type" field.
2. Choose the correct printer type from the communication protocols listed.

For printers that attach to an OS/2 workstation or directly to the network, select type 
"Other/Unknown." (For example, HP IIIsi or 4, Compaq PageMarq 20, GENICOM 7170, or Talaris 
1794 Printstation.)
A dialog appears where you must check the communication values for the selected printer type. 
(Other/Unknown and XNP do not have a dialog; they are configured elsewhere.)

3. Make any changes in the communication parameters dialog for this printer type.
4. Choose "OK."

You return to the "Configuration" page.



Change the Service Mode for Forms Used by this Printer
The service mode determines how the Print Server services print jobs within a Print Queue according to 
printer form. A printer form is defined in the container object.
Print forms specify the length and width of different types of paper used in your printer. You can designate
printer forms for print jobs to prevent your printer from printing a print job on the wrong paper.
When the print server detects a print job that requests a printer form other than the form currently 
mounted in the printer, the print job will not be serviced until the new form is mounted in the printer. You 
can also mount printer forms at the NetWare Server console in the print server console.
The service mode options determine how often the print server will require you to change printer forms.

To select a service mode for this Printer
1. Choose the arrow to the right of the "Service Mode for Forms" field.
2. Choose the desired service mode from the list that appears.
3. Choose "OK."

You return to the Browser.
Service mode options include:

"Change forms as needed" to send all print jobs as they arrive, without considering how the printer 
form currently in use compares with the printer form of the next print job. You may have to change
printer forms often.

"Minimize form changes across print queues" indicates that the print server will service print jobs in 
print queues with lower priorities before it will require you to mount a new form for a print job in a 
higher priority print queue.

"Minimize form changes within print queues" indicates that the print server will require you to mount a 
new form for a print job before servicing print jobs with the currently mounted form in a print 
queue with a lower priority.

"Service only currently mounted forms" holds any print jobs that specify a printer form other than the 
one currently in use on this printer. In this mode, the printer will never request a form change. If 
no print job requiring the current form is available, it will not print anything.



AIO Printer Communication 
This printer uses Asynchronous Input/Output. Use this type for printers cabled to a special network board.
These boards allow a workstation or NetWare Server to support more than seven printers.

To modify this printer type
1. Make the changes to the fields so that the correct values are specified.
2. Choose "OK."
Screen regions and buttons

"Port" indicates the hardware port that this printer is attached to.

"Hardware type" indicates the type of hardware that this printer is using.

"Board number" indicates the number coded into the board that this printer is using.

"Connection type" describes how this printer is connected to the network or a computer on the 
network.

"Line Control" defines the parameters for serial printer communication.



Unix Printer Communication 
This printer is cabled to a Unix network.

To modify this printer type
1. Make the changes to the fields so that the correct values are specified.
2. Choose "OK."
Screen regions and buttons

"Host Name" indicates the name of the host of this printer within Unix.

"Printer Name" indicates the name of this printer within Unix.



AppleTalk Printer Communication 
This printer is cabled to an AppleTalk network. (For more information, see Print Services.)

To modify this printer type
1. Make the changes to the fields so that the correct values are specified.
2. Choose "OK."
Screen regions and buttons

"Name" specifies the name of this printer as it is known through the Macintosh system.

"Type" specifies which type of printer this is. The possible Macintosh compatible printers are listed in 
the drop box.

"Zone" refers to the AppleTalk zone that the printer resides in. The zone is a name that is assigned to 
a group of computers and printers.

"Print Error Messages" shows whether or not this printer will print error messages on a banner page.

"Hide Printer" shows whether or not this printer will be hidden from the view of AppleTalk users. You 
should hide the printer to prevent Macintosh users from submitting their print jobs directly to the 
printer and possibly conflicting with NetWare print jobs. 



Serial Printer Communication 
This printer is cabled to a serial port of a workstation or NetWare Server.

To modify this printer type
1. Make the changes to the fields so that the correct values are specified.
2. Choose "OK."
Screen regions and buttons

"Port" specifies which hardware serial port this printer is using. Possible values that can be selected 
from the drop-down list are COM1, COM2, COM3, and COM4.

"Interrupts" specify which type of interrupts this printer will use to communicate with the computer to 
which it is attached. 

"Connection type" describes how this printer is connected to the network or a computer on the 
network.

"Line Control" defines the parameters for serial printer communication.



Parallel Printer Communication 
This printer is cabled to a parallel port of a workstation or NetWare Server.

To modify this printer type
1. Make the changes to the fields so that the correct values are specified.
2. Choose "OK."
Screen regions and buttons

"Port" specifies which hardware parallel port this printer is using. Possible values that can be selected
from the drop-down list are LPT1, LPT2, and LPT3.

"Interrupts" specify which type of interrupts this printer will use to communicate with the computer to 
which it is attached. 

"Connection type" describes how this printer is connected to the network or a computer on the 
network.



Interrupts for a Printer
Interrupts specify which type of interrupts this printer will use to communicate with the computer to which 
it is attached. 
An interrupt is the signal to a processor that temporarily suspends (interrupts) the current sequence of 
instructions in order to perform others. PC processors use an interrupt to communicate with attached 
printers. The NetWare printer configuration interrupt setting must match the interrupt of the port that the 
printer uses.
Polled mode is a method of printing that does not directly use interrupts. Printing is fastest when the exact
interrupt is specified. Depending on the PC and printer hardware, the greater speed can be slight or very 
noticeable.
Many printer port manufacturers do not implement printer port interrupts correctly because most printing 
applications use polled mode and do not allow you to specify an interrupt.
If your parallel or serial port does not function correctly with an interrupt specified, switch to polled mode.
NetWare Print Services support the use of interrupts 3, 4, 5, 7, 10, and 11. These interrupts correspond to
the IRQ (Interrupt ReQuest) levels. Parallel printer ports generally use the following interrupts: 

LPT1: interrupt 7
LPT2: interrupt 5
LPT3: interrupt 5
COM1: interrupt 4
COM2: interrupt 3
COM3: interrupt 3
COM4: interrupt 3

Ports generally require unique interrupts. Some interrupt numbers are repeated in the list above because 
many ports use polled mode.

Screen regions and buttons
"Use Interrupts" indicates to use a specific interrupt, rather than polled mode.

"Interrupt" allows you to select an interrupt number if "Use Interrupts" is selected.

"Polled" indicates to use polled mode. In polled mode, the PC uses the timer interrupt instead of a 
specific interrupt number to gauge signals to the printer.



Connection Type of a Printer
Connection Type specifies how the printer driver (NPRINTER.EXE/NLM) will load. 
Only printers cabled to the NetWare Server that loads the print server (PSERVER.NLM) can have the 
printer driver (NPRINTER.NLM) loaded.
Each NPRINTER.NLM displays a status screen on the NetWare Server console only if it is manually 
loaded.

Screen regions and buttons
"Manual Load" indicates that the printer driver will be manually loaded. You can select this option for a

printer cabled to any PC on your network. If the printer is cabled to a workstation, you must load 
NPRINTER.EXE from the command line or AUTOEXEC.BAT file. If the printer is cabled to a 
NetWare Server, you must load NPRINTER.NLM from the NetWare Server console or 
AUTOEXEC.NCF file.

"Auto Load" indicates that the printer driver will be automatically loaded. You can select this option 
only for printers cabled to a NetWare Server running PSERVER.NLM. With this option, 
NPRINTER.NLM is automatically loaded by PSERVER.NLM when it is loaded. 



Line Control for a Printer
Line control defines the parameters for serial printer communication.

Screen regions and buttons
"Baud Rate" is the number of bits per second that are sent over the serial communication line. 

Common values range from 300 baud (very slow) to 38400 baud. 1200, 2400, or 9600 are 
common settings.

"Data Bits" specifies the number of bits of data in each byte sent. Values are normally 7 or 8.

"Stop Bits" specifies the number of bits used to signal the end of one byte. Values are normally 0, 1, 
or 2.

"Parity" specifies the error checking mechanism used to ensure that the correct bits were received. 
Values are None for no parity checking, or Even or Odd, for even or odd parity checking.

"Use X-On/X-Off" indicates to use the X-On X-Off protocol with the serial communication for this 
printer.



Printer Status 
This dialog shows the various elements about the status of this Printer. You must be an operator or user 
of a Print Server that services this Printer to be able to see its status.

To change the status of this printer
1. Use the buttons to make any changes to this printer's status (such as changing printer forms or 

sending a Form Feed). 
You must be an operator to change the printer's status.

2. Choose "Close" to return to the "Identification" page of the Printer object dialog.
Screen regions and buttons

"Status" shows the current status of this printer, such as "Ready" or "Not connected."

"Mounted Form" shows the number of the form that is currently mounted in the printer. Only print jobs 
that specify this printer form number can be printed until a new printer form is mounted with the 
"Mount Form" button.

"Service Mode" shows which service mode is being used by this printer and its associated print 
queue. The Service Mode determines how jobs within a print queue are serviced for the most 
efficient use of the printer and printer forms.

"Current Job Information" includes all of the information about the print job that is currently being 
printed on this printer. Most of this information can only be changed by going to the print queue 
and selecting this print job from the list of jobs.

"Print Queue" indicates the Print queue that is submitting this print job.

"Job Name" indicates the name of this print job, which is usually the name of the User that submitted 
the print job to the print queue.

"Job Number" is the number representing the position of this print job within the print queue which 
submitted it.

"Form" shows which printer form this print job is using. This print job cannot be printed unless this 
Form matches the "Mounted Form" field above the "Current Job Information."

"Copies Requested" indicates the number of copies of this print job that the User who submitted it 
requested to be printed.

"Copies Complete" indicates how many of those copies requested have been printed so far.

"Size of 1 Copy" indicates the size of each copy of this print job. This is like the "File Size" field when 
you see the details of a print job within the Print Queue.

"Bytes Printed" indicates the total number of bytes sent to the printer for this print job. It will be close 
to the "Size of 1 Copy" multiplied by the "Copies Completed" numbers.

"Percent Complete" indicates how much of this print job is completed, which is determined both by 
the size of one copy and the number of copies requested for this print job.

"Abort Job"    allows you to cancel this print job and immediately stop printing.

"Pause" changes the status of this print job from active to "On hold." Only a print queue operator or 
the User who submitted a print job or can perform this action.

"Start" changes the status of this print job from "On hold" to "Active," which will start printing again if 
the correct form is mounted and the printer is active.

"Mount Form" allows you to specify a new printer form that you have mounted on this printer. When 
you use this button, the "Mounted Form" field will change to reflect the newly mounted form, and 
only print jobs that specified the new form can be printed.



"Eject Page" sends a command to this printer to eject the page that is being printed. This is like a 
Form Feed command.

"Close" closes this dialog and returns to the "Identification" page of the Printer object dialog.



Mount Printer Form 
This dialog allows you to control the printer forms used by this printer. Printer forms can be designated for
print jobs to prevent them from printing on the wrong paper. When the print server detects a print job that 
requests a printer form other than the form currently mounted in the printer, the print job will not be 
serviced until a new form is mounted in the printer.

To mount printer form
1. Choose a name or number of the desired printer form.

To select a form in a different container, choose the Browser button .
The Select Object dialog appears. Choose the container where the desired printer form is defined.
2. Choose "OK."

"Cancel" returns to the "Printer Status" dialog without modifying the printer form.



View or Change a Print Server Object 
The "Identification" page describes this Print Server object. You can use this page to store information 
such as
- Additional names for the print server
- Where the print server is located
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.
To change the object's name, select the object and choose "Rename" from the Object menu.

Procedures
How to Use the Object Dialog
Setting Up NetWare Print Services
Enter a Description for this Print Server
Enter another Name for this Print Server
Change the Password of this Print Server
Down this Print Server

Screen regions and buttons
"Name" is the name of this Print Server object.

"Advertising Name" shows the name the print server uses in network communications. This is the 
name needed when loading PSERVER.NLM at a NetWare server.

"Other name" lists identification information associated with this print server that helps you search for 
and identify specific print servers.

"Network Address" lists the 16 digit (8 byte) number associated with the NetWare server that runs this
print server (PSERVER.NLM).

"Description" describes the function the print server performs (such as routing Sales print jobs).

"Location" shows the print server's physical location (where the NetWare server running 
PSERVER.NLM is located, such as a room number).

"Department" shows the department or division that generally uses the print server.

"Organization" shows the company that is using the Print Server.

"Version" shows the version of the PSERVER.NLM that is being used with this Print Server object to 
control Print Services.

"Status" shows the status of the print server as "Down" or "Up."

"Unload" allows you to take down an active print server.

"Change Password" allows you to set a password to secure the Print Server object.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Print Server Assignments Page 
The "Assignments" page controls the Printers assigned to this Print Server object. You can use this page 
to add or delete printer assignments. 
At least one Printer object must be assigned to a Print Server in order for NetWare Print Services to 
function properly.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Printer to the List of Printers Serviced by this Print Server
Delete a Printer from the List of Printers Services by this Print Server

Screen regions and buttons
"Printer" shows the name of a Printer object that is serviced by this Print Server.

"Number" shows the number of each Printer object in the list of printers services by this Print Server.

"Add" lets you add a Printer to the list of Printer objects assigned to be serviced by this Print Server.

"Delete" removes the selected Printer from the list of Printer objects serviced by this Print Server.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Change the Printer Number
This dialog allows you to modify the logical printer number. A logical number is assigned to each printer 
when it is created. You may want to change this number to match existing batch files, etc.
NPRINTER.NLM requires and NPRINTER.EXE allows you to load a printer driver by specifying the print 
server name and logical printer number.    



Unload Print Server Software 
You must be an operator of this Print Server to unload Print Server software.

To unload a print server
1. Select one of the two options for unloading Print Server software.

You can cancel current print jobs and unload Print Server software now, or finish the print jobs that 
are in progress before unloading Print Server software. You normally should allow current print jobs to
finish (choose the second option).

2. Choose "OK."
The Print Server software is unloaded and you return to the object dialog. No print jobs serviced by 
this Print Server will be printed until the Print Server software is reloaded.

Screen regions and buttons
"Unload Print Server Immediately" stops printing right now and unloads the print server software. 

Other print jobs serviced by this Print Server will not be printed until the Print Server is reloaded.

"Unload Print Server After Current Jobs" finishes the current print jobs in Print Queues serviced by 
this Print Server. The Print Server software is then unloaded and no new print jobs are started 
until the Print Server software is reloaded.

"OK" unloads the Print Server software as you have specified and returns to the object dialog.

"Cancel" closes this dialog without unloading the Print Server software and returns to the object 
dialog.



Add a Printer to the List of Printers Serviced by this Print Server
1. Choose the "Add" button below the "Printers" list box.
2. Choose the printer that you want to add to the list.
3. Choose "OK."

You return to the "Assignments" page, and the new Printer object is displayed.
The printer that you added can now receive print jobs from Print Queues serviced by this Print Server.
You must also list a Print Queue in a Printer's "Assignments" page, however.



Delete a Printer from the List of Printers Serviced by this Print Server
1. Select a printer from the "Printers" list box.
2. Choose "Delete."

The printer is deleted from the list. Print jobs sent to a Print Queue serviced by this Print Server can 
no longer be sent to the deleted printer.



View or Change the List of Print Server Operators
Operators of a Print Server are allowed by Queue Management Services to manage the Print Server and 
Printers serviced by this server. This includes downing the Print Server, seeing its status, and controlling 
Printers that it services. 
Use the "Operators" page to record operators of this Print Server. For example, you can
- See which objects are listed as operators
- Add or delete objects from the list of operators
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add an Operator
Delete an Operator

Screen regions and buttons
"Operators" lists objects that are operators of this Print Server.

"OK" saves the changes specified in all pages of the object dialog and returns you to the Browser.

"Cancel" closes the dialog box without saving the changes entered in any page.



Add an Operator
1. Choose "Add"
2. Select objects that you want to add as operators.
3. Choose "OK."

The objects you selected are listed as operators. These objects can manage this Print Server and the
Printers that it services.



Delete a Print Server Operator
1. Select an operator from the "Operators" list.
2. Choose "Delete."

The operator is removed from the list.



View or Change the List of Users for a Print Server
Objects that are listed as users of this Print Server are allowed by Queue Management Services to see 
the status of this Print Server.
The "Users" page lists users of this Print Server. This list is created and maintained by the network 
supervisor. For example, you can
- View users who access this Print Server
- Add or delete a user of this Print Server
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add an User
Delete a User

Screen regions and buttons
"Users" lists all objects that are users of this Print Server and are allowed to see its status.

"OK" returns to the Browser and saves any changes you have made.

"Cancel" returns to the Browser without saving any changes that you have made.



Add a User
1. Choose the "Add" button below the "User" list box.
2. Choose the object that you want to add to the list.
3. Choose "OK."

You return to the "Users" page, and the new object is displayed.



Delete a Print Server User
1. Select a User from the "Users" list box.
2. Choose "Delete."

The User is removed from the list.



View or Change a Print Queue Object 
The "Identification" page describes this Print Queue object. You can use this page to store information 
such as
- Additional names for this Print Queue
- Where this Print Queue is located
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.
To change the object's name, select the object and choose "Rename" from the Object menu.

Procedures
How to Use the Object Dialog
Setting up NetWare Print Services
Enter a Description for this Computer
Enter another Name for this Computer

Screen regions and buttons
"Name" shows the name of this Print Queue object.

"Volume" shows the name of the NetWare Volume that contains the directory where this Print Queue 
stores print jobs in progress.

"Other Names" lists other names of this Print Queue object (such as names that it was previously 
known by).

"Description" describes the function the print queue performs (such as hold Sales print jobs).

"Location" shows the print queue's physical location (where the NetWare server with the print queue 
volume is located, such as a room number).

"Department" shows the department or division that generally uses the print server

"Organization" lists the organization that can use the print queue.

"Print Job List" opens the "Print Job dialog," which allows you to see a list of print jobs that are in this 
Print Queue.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Print Jobs in this Print Queue    
This dialog lists the print jobs that are currently in this Print Queue. Information about each print job is 
shown in the table.
You must be an operator of this Print Queue to change the status of a print job that you did not submit.

Screen regions and buttons
"Print Queue" shows the name of the Print Queue object for which you are viewing print jobs that 

have been submitted.

"Print Jobs" shows the number of print jobs that are currently in this Print Queue.

"Seq" (sequence) shows the position in line of each job to be sent to the printer.

"Job Name" for each print job in the Print Queue, shows the name of the User who submitted the print
job to the Print Queue.

"Description" for each print job in the Print Queue, shows a description of the print job that was 
submitted.

"Form" for each print job in the Print Queue, shows which of the available printer forms is to be used 
for this print job.

"Status" for each print job in the Print Queue, shows the status of the print job. For example, on hold, 
printing, waiting, ready, etc.

"Job ID" shows the code for each print job that the Print Queue used to identify the print job.

"OK" saves changes in this dialog and returns to the Print Queue "Identification" page.

"Cancel" closes this dialog without saving changes and returns to the Print Queue "Identification" 
page.



Details of a Print Job in this Print Queue 
This dialog shows the details of one of the print jobs that is currently in this Print Queue.
You must be an operator of this Print Queue to change a print job that you did not submit. If you are an 
operator, or you submitted the print job that you are viewing, you can change any of the fields that are not 
grayed.

Procedures
Setting Up NetWare Print Services

Screen regions and buttons
"Print Job" shows the job number of this print job.

"File Size" shows the file size, in bytes, of this print job.

"Client" shows the name of the User that submitted this print job.

"Description" shows a description that was entered for this print job.

"Status" shows the status of this print job. For example, ready and waiting, on hold, etc.

"User Hold" indicates that the print job has been put on hold by the User who submitted the print job.

"Operator Hold" indicates that the print job has been put on hold by the Queue operator.

"Service Sequence" shows this print job's position in line to be printed.

"Number of Copies" shows how many copies of this print job the print server will sent to the printer.

"File Contents" shows the type of file that was sent for this print job.

"Byte Stream" indicates that this print job consists of a byte stream file, such as a graphic, or 
postscript file.

"Text" indicates that this print job consists of a text file, containing only ASCII characters.

"Tab Size" is used only with text files, and indicates how many spaces are sent to the printer each 
time a Tab character is received as part of the print job.

"Form Feed" shows whether or not a form feed character is sent to the printer at the end of this print 
job.

"Notify When Job is Printed" shows whether Users are notified when this print job has been 
completed.

"Entry Date" shows the date that this print job was submitted to the Queue.

"Entry Time" shows the time that this print job was submitted to the Queue.

"Form" shows which printer form will be used to print this print job. You can select from available 
printer forms using the drop-down box.

"Print Banner" shows whether or not a banner page with identification information will be printed as 
the first page of this print job.

"Name" indicates what will be printed as the name of the User who sent this print job. This is only 
valid if a banner page is printed.

"Banner Name" indicates what will be printed as the name of the print job. This is only valid if a 
banner page is printed.

"Defer Printing" indicates that the printing of this job is to be delayed until a later date and time.

"Target Date" shows the date that this print job will be printed. This field is valid only if "Defer Printing"
is selected.



"Target Time" shows the time that this print job will be printed. This field is only valid if "Defer Printing"
is selected.

"OK" saves changes in this dialog and returns to the list of print jobs in this Print Queue.

"Cancel" closes this dialog without saving changes and returns to the list of print jobs in this Print 
Queue.



Print Queue Assignments Page 
The "Assignments" page views the Printers assigned to this Print Queue object and the Print Servers 
assigned to the Printer objects. You cannot change these assignments here, only view them.
To change assignments between a Print Server and Printer objects, use the Print Server object dialog. To 
change assignments between a Printer and Print Queue objects, use the Printer object dialog.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Setting Up NetWare Print Services

Screen regions and buttons
"Authorized Print Servers" shows the Print Server objects that are servicing this Print Queue object. 

You must use the Print Server object dialog to change these assignments by changing which 
Printer objects a Print Server is servicing.

"Printers Servicing Print Queue" shows the Printers that are receiving print jobs from this Print Queue.
You must use the Printer object dialog to change these queue assignments.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



View or Change the List of Print Queue Operators
Operators of a Print Queue are allowed by Queue Management Services to manage the print jobs in the 
Print Queue. This includes activities such as deleting print jobs, or changing their order. Use the 
"Operators" page to record operators of this Print Queue. For example, you can
- See which objects are listed as operators
- Add or delete objects from the list of operators
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add an Operator
Delete an Operator

Screen regions and buttons
"Operators" lists objects that are operators of this Print Queue.

"OK" saves the changes specified in all pages of the object dialog and returns you to the Browser.

"Cancel" closes the dialog without saving the changes entered in any page.



Add an Operator
1. Choose "Add."
2. Select select objects that you want to add as operators.
3. Choose "OK."

The objects you selected are listed as operators. These objects can manage the print jobs in this Print
Queue.



Delete an Operator
1. Select an operator from the "Operators" list.
2. Choose "Delete."

The operator is removed from the list.



View or Change the List of Users for a Print Queue
Objects that are listed as users of this Print Queue are allowed by Queue Management Services to 
submit print jobs to this Print Queue, and to manage jobs that they submit.
The "Users" page lists users of this Print Queue. This list is created and maintained by the network 
supervisor. For example, you can
- View users who access this print queue
- Add or delete a user of this print queue
Important: "OK" and "Cancel" affect the entire object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add an User
Delete an User

Screen regions and buttons
"Users" lists all objects that are users of this Print Queue and are allowed to submit print jobs to it.

"OK" returns to the Browser and saves any changes you have made.

"Cancel" returns to the Browser without saving any changes that you have made.



Add a Print Queue User
1. Choose "Add."
2. Choose the object that you want to add to the list.
3. Choose "OK."

You return to the "Users" page, and the new object is displayed. This object can now submit print jobs
to this Print Queue.



Delete a Print Queue User
1. Select a User from the "Users" list box.
2. Choose "Delete."

The User is deleted from the list.



Log in to a Server
Server Login allows you to connect to a NetWare server that is not in your current directory tree so that 
you can access its print queues.
Enter your username and password for the server, then choose OK.



Reference a Bindery Queue
Allows you to browse for an existing print queue outside of your directory tree so that you can create a 
Print Queue object for that queue.    
Creating a Print Queue object allows you to manage printing in an environment that is running multiple 
versions of NetWare or that has more than one directory tree.
You can locate print queues on any server you have an account on.

To locate a print queue
1. From the Network Servers list, select a server. 

To access a print queue on a server you are not attached to, unmark "List Only Attached Servers."
2. From the Queues list select the print queue that you want to appear in the directory tree.
3. Choose OK.

You can now create a print queue object in the directory tree.
Screen regions and buttons

"Network Server/Queue" displays the queue that will appear in the directory tree and the queue's 
bindery server.

"List Only Attached Servers" allows you to limit the list of bindery servers to only those you are 
currently attached to or expand the list to all bindery servers in the network.    If your network is 
large, building a list of all servers can take some time.

"Network Servers" lists servers outside of your directory tree from which you may want to access 
queues.

"Queues" lists queues available on the server highlighted in the Network Servers list.    

"OK" transfers the information listed in the Network Sever/Queue field to the appropriate fields in the 
Create Print Queue dialog.

"Cancel" returns you to the Create Print Queue dialog without changing any of its information.

Related Topics
Setting Up NetWare Print Services



View Print Layout
Print layout shows a map of your printing set up.    You can see which print objects are assigned to each 
other and each object's status. This information can help you quickly determine if printing is up or which 
print objects may have problems.    
Double clicking on a print object in the print layout expands or contracts the tree of objects below.
"Icon" indicates printing problems.    Expand the print layout tree completely to see exactly which object 
not functioning 
A dashed line between objects means the connection is established for the current print server session 
only rather than configured to connect everytime the print server is loaded.    

Screen regions and buttons
"Update" refreshed the print layout tree to reflect any changes with the print objects.

"Status" provides a brief summary of the selected print object's details.    For complete detail 
information, select the object in the Browser Directory Tree and choose Details.    

Status for print jobs is not available in print layout.    Manage print jobs from the queue object the 
job is stored in.



Audit Print Jobs
The audit log is a file created by the print server that allows you to track print jobs.    The log stores 
information such as which printer the job was sent to, how large the job was, and how long it took to print.
By default, no audit log is created.    When you enable the audit log feature you can

View the log: Use the scroll bars to browse through the current log.
Limit the log size: By default, the log has no size limitations.    The log's current size is displayed in the
dialog.    To set a size limit, mark this and adjust that???
Delete the log: Deleting an audit log destroys the current log and, if auditing is enabled, starts a new 
log by the same name in the same directory. 

The location of the audit log is ???.    This location is not configurable.

Related topics
Managing a Print Server
Managing Print Jobs



How to Use the Object Dialog
Use the object dialog to set or change information about an object. There are many ways to open an 
object dialog.
The object dialog has two areas: an information area, where you work with that object, and a page area. 
Each page contains information about the object. To open other pages, choose a page button. The 
information area changes when you open a page.
All pages are part of the object dialog. When you open a page, you're still in the same object dialog.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Screen regions and buttons

"More"  allows multiple entries in a field.

"Browser"  appears next to fields that require the complete name of an object. Lets you browse and 
select an object.
Page buttons change information you can edit.
"OK" saves the changes in all pages of the dialog and returns you to the Browser.
"Cancel" closes the dialog without saving the changes entered in any page.



Enter a Title
"Title" is one of several properties of this object that are shown on the "Identification" page of the object 
dialog. 
Use this procedure as an example for entering values for any of the properties on the "Identification" page
with a similar field style.

To enter a title
1. Select the "Title" field.

Note: If this is not the first value in the "Title" property, you must choose the "More" button to the right 
of the "Title" field and use the dialog that appears to enter other values. Choose "Help" in that dialog 
for more information.

2. Type the title that you want recorded as a property of this object.
3. Choose "OK."

The information is not saved to NetWare Directory Services until you choose "OK."



Enter another Name for this Object
The "Other names" field can record any identification information that you think will be useful for this 
object. You can add several alternative names for this object. Any of these names can be referred to in a 
search to locate this object.
Use this procedure as an example for entering values for any of the properties on the "Identification" page
with a similar field style.

To enter another name for this object
1. Select the "Other name" field.

Note: If this is not the first value in the "Other Names" property, choose the "More" button to the right 
of the "Other Names" field and use the dialog that appears to enter other values. Choose "Help" in 
that dialog for more information.

2. Type the name that you want recorded as a property of this object.
3. Choose "OK."

The information is not saved to NetWare Directory Services until you choose "OK."



Enter a Location for this Object
The "Location" field can record any information that you think will be useful for this object. It is generally 
used to record the physical location of the object, such as where your office complex is located.
Use this procedure as an example for entering values for any of the properties on the "Identification" page
with a similar field style.

To enter a location
1. Select the "Location" field.

Note: If this is not the first value in the "Location" property, choose the "More" button to the right of the
"Location" field and use the dialog that appears to enter other values. Choose "Help" in that dialog for 
more information.

2. Type the location that you want recorded for this object.
3. Choose "OK."

The information is not saved to NetWare Directory Services until you choose "OK."



Enter a Description of this Object
The "Description" field can record any information that you think will be useful. 
You can enter up to 30 lines of 37 characters each. 
"Description" is a property of most objects in NetWare Directory Services.

To enter a description
1. Select the "Description" field.
2. Type the information that you want recorded for this object.

The information scrolls as you type. Use the scroll bar to the right of the field to scroll through the text 
that you have entered. Choose "Help" in that dialog for more information.

3. Choose "OK."
The information is not saved to NetWare Directory Services until you choose "OK."



Enter a Serial Number for this Object
The "Serial Number" field can be used to record the unique serial number of this object. This number 
uniquely identifies every piece of equipment that you own. 
This field can be very useful when searching for information about a specific piece of equipment.

To enter a serial number
1. Select the "Serial Number" field.
2. Type the serial number of the piece of equipment that is represented by this object.
3. Choose "OK."

Note: The information is not saved to NetWare Directory Services until you choose "OK."



Enter a Fax or Phone Number for this Object
"Fax" and "Telephone Number" record numbers where the people or places represented by this object 
can be reached. 
You can enter several fax numbers and several phone numbers.
Use this procedure as an example for entering values for any of the properties on the "Identification" page
with a similar field style.

To enter a fax or phone number
1. Select the "Fax" or "Telephone Number" field.

Note: If this is not the first value in the "Fax" or "Telephone Number" property, choose the "More" 
button to the right of the field and use the dialog that appears to enter other values. Choose "Help" in 
that dialog for more information.

2. Type the number that you want recorded as a property of this object.
You can use any characters or symbols you want.

3. Choose "OK."
Note: The information is not saved to NetWare Directory Services until you choose "OK."



See What Name Spaces Are Used on this Volume
To see what name spaces are available (or installed) on the volume where this file or directory is stored, 
look at the times that this file or directory is listed in the "Names" list.
Every file or directory on a volume must have a name in every name space that is installed on that 
volume.
For example, if your file has a name shown for DOS, OS/2, and Macintosh name spaces, those name 
spaces are available to every file on that volume, and every file must have a name in each of those name 
spaces.



See the Name of this File or Directory in Each Available Name Space
The name of each file or directory is listed with all of the available name spaces in the table on the 
"Identification" page of the object dialog for the file or directory. Look at the table to see what the file's or 
directory's name is in each of the available name spaces.



Printer Forms
The "Printer Forms" page lists the different forms that can be used when printing to a Printer object in this 
container.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Create a New Printer Form
Modify a Printer Form
Delete a Printer Form

Screen regions and buttons
"Number/Form" lists the number and name of each printer form that is defined for this container 

object.

"Create" opens the "Create Printer Form" dialog, where you can enter values for a new printer form.

"Modify" opens the "Modify Printer Form" dialog with the values of the selected printer forms 
displayed. You can then change any of these values.

"Delete" opens the "Delete Printer Form" dialog that displays the values of the selected printer forms. 
This allows you to see what you are deleting when you choose "OK."

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Create a New Printer Form
1. Choose "Create."

The "Create Printer Form" dialog appears.
2. Enter a name in the "Name" field.

The name must begin with a letter, and must be unique. It can be up to 8 characters long. Spaces will 
be converted to underscores (_).

3. Enter a number from 0 to 255 in the "Number" field.
4. Enter a number from 1 to 255 in the "Length" field.

This is the length of the printer form you are defining, measured in lines of text.
5. Enter a number from 1 to 999 in the "Width" field.

This is the width of the printer form you are defining, measured in characters.
6. Choose "OK."

A printer form with the name that you entered is listed in the "Printer Forms:" list box. Any time that 
printer form is used, the values that you entered with that printer form name are used.



Modify a Printer Form
1. Select a printer form from the "Printer Forms" list box.
2. Choose "Modify."

The "Modify Printer Form" dialog appears. The values for the printer form that you selected appear in 
the fields of the dialog. You can change any of the fields.

3. (Optional) Enter a new name in the "Name" field.
The name must begin with a letter, and must be unique. It can be up to 8 characters long. Spaces will 
be converted to underscores (_).

4. (Optional) Enter a number from 0 to 255 in the "Number" field.
5. (Optional) Enter a number from 1 to 255 in the "Length" field.

This is the length of the printer form you are redefining, measured in lines of text.
6. (Optional) Enter a number from 1 to 999 in the "Width" field.

This is the width of the printer form you are redefining, measured in characters.
7. Choose "OK."

The form is now modified. You do not have to choose "OK" in the object dialog to complete the action.
You return to the Printer Forms list. The printer form that you selected in Step 1 is still selected. It may
appear with a different name if you changed the "Name" field in Step 3.



Delete a Printer Form
1. Select a printer form from the "Printer Forms" list box.
2. Choose "Delete."

The "Delete Printer Form" dialog appears. The values for the printer form that you selected appear in 
the fields, but are grayed. You can see what values you are deleting as part of this printer form, but 
you cannot change them here.

3. Choose "OK."
You return to the "Printer Forms" list box.The printer form that you selected is deleted from the list of 
printer forms. You do not have to choose "OK" in the object dialog to complete the action. The Delete 
operation cannot be undone. You must "Add" a new printer form with the deleted values.



Print devices
The "Print devices" page lists the names of different types of print devices that can be used as printers in 
this container. You can add new definitions for print devices, or modify the definitions of existing print 
devices. Use "Import" and "Export" to avoid reentering information for the same device in different 
containers.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Create a New Print device Definition
View or Modify a Print device Definition
Delete a Print device Definition
Import a Print device Definition
Export a Print device Definition

Screen regions and buttons
"Print devices" lists the names of the print devices that are defined for use in this container object.

"Create" opens the "Create Print device" dialog, where you can enter the name for a new print device.
Functions and modes are added using "Modify."

"Modify" opens the "Modify Print device" dialog, where you can view or add functions and modes for 
the selected print device.

"Delete" opens the "Delete Print device" dialog, where you can see the name of the selected print 
device definition before deleting it. You cannot examine functions and modes from this dialog.

"Import" opens the "Import Print device" dialog, which allows you to use an existing definition without 
re-entering the information.

"Export" opens the "Export Print device" dialog, where you can enter the name of a file that the 
selected print device definition should be saved as.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Create a Print device
This dialog allows you to create a new print device that can be used by objects in this container. 
A definition consists of a name, functions, and modes, but you enter a name in the "Create" dialog only. 
Use "Modify" to enter functions and modes.

To create a new print device definition
1. Enter a print device name in the "Name" field.

You can use up to 32 characters for the name. It must begin with a letter; spaces are allowed.
2. Choose "OK."

The name of the print device that you entered is added to the list. You should use "Modify" to define 
functions and modes for this print device before using it.



Delete a Print device
This dialog allows you to delete the definition of a print device that was previously entered. The definition 
can then no longer be used by objects in this container. All functions and modes are deleted at the same 
time.

To delete this print device definition
1. Select a print device name from the "Print devices" list box.
2. Choose "Delete."

The "Delete Print device" dialog appears with the "Name" field and the "Functions" and "Modes" 
buttons grayed. You cannot modify the definition here; you can only see what you are deleting.

3. Choose "OK."
You return to the "Print devices" dialog. The print device that was listed in the "Name" field is deleted 
from the "Print devices" list box and is no longer available to objects in this container.



Import a Print device
This dialog allows you to import a definition for a new print device that can be used by objects in this 
container. A definition consists of a name, functions, and modes.
"Import" allows you to use a definition that was created for another container without re-entering all of the 
functions and modes. To import a print device in this dialog, it must have been saved using the "Export" 
button in this dialog.

To import a print device definition
1. Choose "Import" below the "Print devices" list box.
2. Use the file selection dialog to locate the file for the print device definition that you want to import.

The file extension .PDF is used for print device definition files.
3. Choose "OK."

The print device is added to the "Print devices" list box, and the definition contained in the file can 
now be used by objects in this container.



Export a Print device
This dialog allows you to export a definition for a print device listed in this dialog. The print device 
definition can then be imported for use in other containers without re-entering all functions and modes.

To export a print device definition
1. Select a print device from the "Print devices" list box.
2. Choose "Export" below the "Print devices" list box.
3. Find the directory where you want to create a file containing this print device definition.

The file extension .PDF is used for print device definition files.
The name of the print device is used as the filename when you export a definition. All spaces are 
removed and the first eight characters of the print device are used.

4. Choose "OK."
The print device definition is saved with the same filename as the print device is listed. All functions 
and modes are included in the definition. The definition can be imported by using this dialog on any 
container object. The print device is unchanged in this dialog.



Modify a Print device
This dialog allows you to modify the definition of a print device that was previously entered by adding, 
changing, or deleting the functions and modes that are defined for this device. The definition can be used 
by objects in this container.
You can change a print device name, or any of its functions or modes.
A function is an action that the print device can perform, such as bold text or proportional spacing. 
A mode is a combination of functions that you define to prepare the print device for specific printing 
needs. For example, you might define a print mode called "Title" that includes functions for bold, double 
wide, and letter-quality printing.

Procedures
Change the Name of this Print device
Add a Function to this Print device
Modify a Function
Delete a Function
Add a Mode to this Print device
Modify a Mode
Delete a Mode 

Screen regions and buttons
"Name" shows the name of this print device.

"Functions" shows the functions that have been entered for this print device. These include all of the 
capabilities of this print device, such as compressed or letter-quality printing.

"Modes" shows the modes that have been entered for this print device. A mode is a combination of 
functions that you define to serve a specific printing need.

"Create Function" allows you to add a function to the "Functions" list.

"Create Mode" allows you to define a new mode and add it to the "Modes" list.

"Modify" button allows you to change the selected mode or function by adding or removing functions 
or control sequences, respectively, from its definition.

"Delete" button deletes the selected mode or function. The functions that were a part of a selected 
mode are not affected; they are still part of the print device definition.



Change the Name of this Print device
1. Enter a new name in the "Name" field.
2. Choose "OK."

You return to the list of print devices. The new name appears in the list.



Add a Function to this Print device
1. Choose "Create Function."

The "Create Function" dialog appears. The name of the print device is at the top of the dialog.
2. Enter a name for the new function in the "Function Name" field.
3. Enter the characters used by this printer as a control sequence to engage this function.

You can use characters with values from 32 to 126. This includes all numbers and letters. If you need 
to enter a value below 32 or above 126, you must enter the value of the character as three digits 
between angle brackets. For example, to enter the escape character, which has a value of 27, 
followed by a capital N, you would enter the following in the "Control Sequence" field.
<027>N
Note: Each function can have a control sequence of up to 255 bytes. One byte is used by each letter 
or number that you enter in the "Control Sequence" field. One byte is also used by each control 
character value that you enter, such as the escape    character (<027>) For example, entering <027>N
uses two bytes, and entering <027>UB<004><246> uses 5 bytes.

4. Choose "OK."
You return to the "Modify Print device" dialog. The function that you entered is listed in the "Functions"
list.



Modify a Function
1. Select a function from the "Functions" list.

You cannot select a function and a mode at the same time in this dialog.
2. Choose "Modify."

The "Modify Function" dialog appears. The name of the print device is shown at the top of the dialog 
for your reference.

3. (Optional) Enter a new name for the function in the "Function Name" field.
4. Enter the characters used by this printer as a control sequence to engage this function.

You can use characters with values from 32 to 126. This includes all numbers and letters. If you need 
to enter a value below 32 or above 126, you must enter the value of the character as three digits 
between angle brackets. For example, to enter the escape character, which has a value of 27, 
followed by a capital N, you would enter the following in the "Control Sequence" field.
<027>N
Note: Each function can have a control sequence of up to 255 bytes. One byte is used by each letter 
or number that you enter in the "Control Sequence" field. One byte is also used by each control 
character value that you enter, such as the escape    character (<027>) For example, entering <027>N
uses two bytes, and entering <027>UB<004><246> uses 5 bytes.

5. Choose "OK."
You return to the "Modify Print device" dialog.



Delete a Function
1. Select a function from the "Functions" list.

You cannot select a function and a mode at the same time in this dialog.
2. Choose "Delete."

The "Delete Function" dialog appears. The name of the print device is at the top of the dialog. All 
fields are grayed. You cannot change anything; you can only see what you are deleting.

3. Choose "OK."
You return to the "Modify Print device" dialog.



Add a Mode to this Print device
To create a mode, you select some functions that have been defined for this print device. You can repeat 
a function in a mode definition. Functions are executed in the order listed.
1. Choose "Create Mode."

The "Create Mode" dialog appears. The name of the print device is shown at the top of the dialog for 
your reference.
All of the functions defined for this printer are listed in the "Device Functions" list box.

2. Enter a name for the new mode in the "Mode Name" field.
3. Select the function that you want to be executed first from the "Device Functions" list.
4. Choose "Add Below."
5. Select the function that you want to be executed next from the "Device Functions" list.

You can select the same function more than once if the mode requires it.
6. Repeat Steps 4 and 5 until all of the functions that you want as part of this mode are listed in correct 

order in the "Mode Functions" list box.
If you make a mistake, use "Delete" or "Add Above" to rearrange the functions listed in "Mode 
Functions."

7. Choose "OK."
You return to the "Modify Print device" dialog.



Modify a Mode
1. Select a mode from the "Modes" list in the "Modify Print devices" dialog.

You cannot select both a function and a mode in this dialog.
2. Choose "Modify."

The "Modify Mode" dialog appears. The name of the print device is shown at the top of the dialog for 
your reference.
All of the functions defined for this printer are listed in the "Device Functions" list box.

3. (Optional) Enter a new name for the mode in the "Mode Name" field.
4. Select the function that you want to add to the mode from the "Device Functions" list.
5. Select the function in the "Mode Functions" list next to where you want to insert the new function.
6. Choose "Add Below" or "Add Above" to insert the selected device function in the correct place in the 

"Mode Functions" list.
7. Select any mode function that you want to delete from the definition of this mode.
8. Choose "Delete."

The selected function is no longer a part of this mode definition. The function is still a part of this 
device definition, but is not used for this mode.

9. Repeat Steps 4 through 8 for modes you want to modify.
10. Choose "OK."

You return to the "Modify Print device" dialog.



Delete a Mode 
1. Select a mode from the "Modes" list.

Note: You cannot delete the [Reinitialization] mode from the list, even if it has no functions defined. 
You should add functions to the [Reinitialization] mode to restart your printer and create the correct 
settings.
You cannot select a function and a mode at the same time in this dialog.

2. Choose "Delete."
The "Delete Mode" dialog appears. The name of the print device is shown at the top of the dialog for 
your reference. All fields are grayed. You cannot change anything; you can only see what you are 
deleting.

3. Choose "OK."
You return to the "Modify Print device" dialog.



Create a Function for a Print device
This dialog allows you to enter a name and the necessary control sequences to define a print device 
function. The necessary control sequences (also called control codes, or escape codes) are described in 
the operator's manual of your print device.
A function is an action that the print device can perform, such as bold text or proportional spacing. You 
cause the print device to perform the function by sending control codes to the print device.

To create a new function definition
1. Enter a function name in the "Function" field.

You can use any name that you want to, but you should choose names that represent the printer's 
actions.
You can use up to 8 characters for the name. It must begin with a letter.

2. Enter a control sequence in the "Control Sequence" field by typing the characters that the printer uses
to set that function.
See the operator's manual for your print device to find the correct control sequences for print device 
functions.
You can use characters with values from 32 to 126. This includes all numbers and letters. If you need 
to enter a value below 32 or above 126, you must enter the value of the character as three digits 
between angle brackets. For example, to enter the escape character, which has a value of 27, 
followed by a capital N, you would enter the following in the "Control Sequence" field.
<027>N
Note: Each function can have a control sequence of up to 255 bytes. One byte is used by each letter 
or number that you enter in the "Control Sequence" field. One byte is also used by each control 
character value that you enter, such as the escape    character (<027>) For example, entering <027>N
uses two bytes, and entering <027>UB<004><246> uses 5 bytes.

3. Choose "OK."
The name of the function definition that you entered is added to the "Functions" list. The function can 
now be used by the print device or by any mode you define for this print device.



Modify a Function for a Print device
This dialog displays and allows you to modify the name and control sequence for the function that you 
selected in the "Functions" dialog box. 
A function is an action that the print device can perform, such as bold text or proportional spacing. You 
cause the print device to perform the function by sending control codes to the print device.

To modify a function definition
1. (Optional) Enter a new function name in the "Function" field.

You can use any name that you want, but you should choose names that represent the printer's 
actions.
You can use up to 8 characters for the name. It must begin with a letter.

2. (Optional) Enter or edit the control sequence in the "Control Sequence" field by typing the characters 
that the printer uses to set that function.
See the operator's manual for your print device to find the correct control sequences for print device 
functions.
You can use characters with values from 32 to 126. This includes all numbers and letters. If you need 
to enter a value below 32 or above 126, you must enter the value of the character as three digits 
between angle brackets. For example, to enter the escape character, which has a value of 27, 
followed by a capital N, you would enter the following in the "Control Sequence" field.
<027>N
Note: Each function can have a control sequence of up to 255 bytes. One byte is used by each letter 
or number that you enter in the "Control Sequence" field. One byte is also used by each control 
character value that you enter, such as the escape    character (<027>) For example, entering <027>N
uses two bytes, and entering <027>UB<004><246> uses 5 bytes.

3. Choose "OK."
Any changes that you made are retained in the print device definition. If you changed the function 
name, the name changes in the "Functions" list box.



Delete a Function for a Print device
This dialog allows you to delete the function that you selected in the "Modify Print device" dialog box. All 
fields are grayed; you can only the function that you are deleting.
To delete the selected function definition, choose "OK."
You return to the "Modify Print device" dialog. The selected function is deleted from the list and cannot be 
used by the print device definition or any of its modes.



Create a Mode Definition for a Print device
This dialog allows you to enter a name and a list of functions to define a printer mode.
A mode is a combination of functions that you define to prepare the print device for specific printing 
needs. For example, you might define a print mode called "Title" that includes functions for bold, double 
wide, and letter-quality printing.

To create a new mode definition
1. Enter a name for the new mode in the "Mode name" field.

You can choose any 8-character name that begins with a letter. You should use names that reflect the
purpose of the printer mode.
Example: You might have modes for different types of documents like memos or reports, or for 
different user's    preferred settings, or for the requirements of different papers or forms that you use.

2. Select the function that you want to be executed first from the "Device Functions" list.
3. Choose "Add Below."
4. Select the function that you want to be executed next from the "Device Functions" list.

You can select the same function more than once if the mode requires it.
5. Repeat Steps 3 and 4 until all of the functions that you want as part of this mode are list in the correct 

order in the "Mode Functions" list box.
If you make a mistake, use "Delete" or "Add Above" to rearrange the functions listed in "Mode 
Functions."

6. Choose "OK."
You return to the "Modify Print device" dialog.



Modify a Mode Definition for a Print device
This dialog allows you to modify a mode definition that you previously entered.
From this dialog, you can change the name of the mode or which functions are executed to enter this 
mode.
A mode is a combination of functions that you define to prepare the print device for specific printing 
needs. For example, you might define a print mode called "Title" that includes functions for bold, double 
wide, and letter-quality printing.

To modify an existing mode definition
1. (Optional) Enter a new name for the mode in the "Mode Name" field.
2. Select the function that you want to add to the mode from the "Device Functions" list.
3. Select the function in the "Mode Functions" list next to where you want to insert the new function.
4. Choose "Add Below" or "Add Above" to insert the selected device function in the correct place in the 

"Mode Functions" list.
5. Select any mode function that you want to delete from the definition of this mode.
6. Choose "Delete."

The selected function is no longer part of this mode definition. The function is still a part of this device 
definition, but is not used for this mode.

7. Repeat Steps 2 through 6 as needed.
8. Choose "OK."

You return to the "Modify Print device" dialog.



Delete a Mode Definition for a Print device
This dialog allows you to delete a mode definition. All fields are grayed; you can only see what you are 
deleting.
To delete the selected mode definition, choose "OK."
The mode name that you selected is removed from the "Modes" list box. That mode can no longer be 
used by this print device. The functions that the deleted mode used are not affected by this operation.



View or Modify Print Job Configurations
The "Job Configuration" page lists the names of different print job configurations that can be used. You 
can add new job configurations or modify the parameters of existing configurations.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Change Which Print Job Configuration Is the Default
Create a New Print Job Configuration
View or Modify a Print Job Configuration
Delete a Print Job Configuration

Screen regions and buttons
"Name/Owner" lists the names of the print job configurations that can be used, and the object at 

which the configuration was defined. Print job configurations that were defined in any 
Organization or Organizational Unit above this object are included in this list.

"New" opens the "Create Print Job Configuration" dialog, where you can enter a name and 
parameters for a new print job configuration.

"Modify" opens the "Modify Print Job Configuration" dialog, where you can view and modify the 
parameters of any of the print job configurations that are listed.

"Delete" removes the selected print job configuration from the list. It can no longer be used.

"Default" marks the selected print job configuration as the default configuration, as noted by the 
printer icon.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Change Which Print Job Configuration is the Default

To change to a new default print job configuration
1. Select the print job configuration that you want to make the default configuration from the "Print Job 

Configurations" list box.
2. Choose "Default."

The printer icon to the left of the configuration names moves to the selected configuration. That 
configuration is now the default.



Create a Print Job Configuration

To create a new print job configuration
1. Complete each of the applicable fields in the dialog.
2. Choose "OK."

The name of the new print job configuration is added to the list.
Screen regions and buttons

Print Job Configuration fields



View or Modify a Print Job Configuration

To view or modify a print job configuration
1. Change any fields in the dialog.

You cannot change the name of the print job configuration. You must create a new print job 
configuration.

2. Choose "OK."
The print job configuration is saved with any new values that you entered.

Screen regions and buttons
Print Job Configuration fields



Delete a Print Job Configuration

To delete a print job configuration
1. Select a print job configuration from the "Name/Owner" list box.
2. Choose "Delete."

The selected print job configuration is removed from the list.



Print Job Configuration Fields
"Print Job Name" lists the name of this print job configuration (as listed in the "Job Configuration" list 

box) that a User specifies to be used for a printing job. This field is entered when you create a 
new job configuration, but it cannot be changed when you modify other fields later.

"Number of Copies" indicates how many copies of the file to print. The number of copies can range 
from 1 to 65,000.

"File Contents" can be a byte stream or text. If text is selected, then tabs are recognized and "Tab 
Size" can be set.

"Tab Size" is the width in characters that each tab character should be expanded to. This field is only 
available if you select "File contents."

"Suppress Form Feed" determines whether a form feed is sent when a job is completed.

"Notify When Done" determines whether a message is sent to the workstation of the print job 
originator when the job has finished printing.

"Local Printer" specifies which parallel port of your computer print jobs should be sent to. The values 
listed are LPT1 through LPT9.

"Auto end cap" determines if the CAPTURE command automatically ends when a print job is 
completed.

"Printer/Queue" allows you to select the Printer or Queue object that the print job configuration should
use. The "Select Object" dialog appears when the Browser button is selected.

"Device" allows you to select which print device this print job configuration uses.

"Mode" allows you to select the mode this print job configuration uses. The modes listed are defined 
by the device you selected.

"Form Name" allows you to select which printer form this print job configuration uses.

"Print Banner" determines if this print job configuration includes a banner page at the beginning of 
each print job. If this check box is selected, the next two fields are available.

"Name" is part of the banner page that is printed at the beginning of a print job that uses this 
configuration. If this field is left blank, the name of the user who originated the print job is used. 
This field can only be entered if "Print Banner" is selected.

"Banner Name" is part of the banner page that is printed at the beginning of a print job that uses this 
configuration. If this field is left blank, the name of the file being printed is used. This field can only
be entered if "Print Banner" was selected.

"Enable timeout" determines if each print job will time out after a specified period of time. If this is 
selected, "Timeout Count" can be set.

"Timeout Count" field is the number of seconds that each print job takes to time out if the printer does 
not respond. You must select "Enable timeout" to enter a value here. Timeout can range from 1 to
1000 seconds.



View or Change an Object's Rights to Files and Directories
The "Rights to Files and Directories" page shows all trustee assignments that this object has to files and 
directories on a volume. For example, you can
- See trustee assignments that this object has to a directory
- Change this object's trustee assignment to any directory or file
- See the effective rights of this object to any directory or file
You can view trustee assignments to files and directories on volumes that are listed in the "Volumes" list. 
To see trustees on a volume other than those listed, you must add that volume to the list.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
View Trustee Assignments to a Directory or File
Change Trustee Assignments to a Directory or File
Grant this Object a Trustee Assignment to a Directory or File
View Effective Rights to a Directory or File
Add a Volume to the Volume List
Remove a Volume from the Volume List

Screen regions and buttons
"Volumes" lists Volume objects. Any trustee assignment that this object has to a directory or file on a 

Volume is listed in "Files and Directories" when you select that Volume.

"Find" allows you to search for a Volume object from a context you specify.

"Show" lets you to add a Volume object to the "Volumes" list.

"Hide" lets you remove a Volume object from the "Volumes" list.

"Files and Directories" lists files and directories that this object has a trustee assignment to. If you do 
not have rights to change the trustee assignment to that file or directory, the names of the rights 
are grayed.

"Add" lets you create a new trustee assignment for this object to a directory or file.

"Delete" lets you delete this object's trustee assignment to the directory or file.

"Rights" displays the rights that make up the trustee assignment to the directory or file.

"Effective rights" lets you see this object's effective rights to a directory or file.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.

Related topics
Trustees and Trustee Paths
Concepts Manual: Rights



Search Context
This dialog allows you to search for Volume objects from a point you specify in the Directory tree.



View Trustee Assignments to a Directory or File
1. From the "Volumes" list, select the volume that contains the directory or file for which you want to 

view this object's trustee assignment.
2. From the "Directories and files" list, select the directory or file.

If you don't have rights to change this trustee assignment, the name of the file and all rights will be 
grayed.
The directory or file's trustee assignment appears in the "Rights" area.
Note: If you have multiple Browser windows open, the Volume name shown for this file may not be 
the one that you selected it from. This has no affect on operation, as the same physical file is simply 
being viewed from different objects or views.



Change Trustee Assignments to a Directory or File
1. From the "Volumes" list, select the volume that contains the directory or file.
2. From the "Directories and files" list, select the directory or file.

Note: If you don't have rights to change this trustee assignment, the name of the file and all rights will
be grayed.
The rights that make up this object's trustee assignment to the file or directory appear in the rights 
area.
Note: If you have multiple Browser windows open, the Volume name shown for this file may not be 
the one that you selected it from. This has no affect on operation, as the same physical file is simply 
being viewed from different objects or views.

3. Select the check boxes by rights that you want to change.
Note: If the names of the rights are grayed, you don't have rights to change this trustee assignment. 
You must have the Access Control right to the file or directory.

4. Choose "OK."
The new trustee assignment is now effective for this object.



Grant this Object a Trustee Assignment to a Directory or File
1. Choose "Add."

The "Select Object" dialog appears.
2. Select the directory or file that you want to grant rights to for this object.
3. Choose "OK."

If you don't have rights to change this trustee assignment, the name of the file and all rights will be 
grayed.
You return to the object dialog. If you have sufficient rights, the Read and File Scan rights are granted 
by default. The rights that make up this object's trustee assignment to the file or directory appear in 
the rights area.
Note: If you have multiple Browser windows open, the Volume name shown for this file may not be 
the one that you selected it from. This has no affect on operation, as the same physical file is simply 
being viewed from different objects or views.

4. Select the check boxes by rights that you want to change.
Note: If the names of the rights are grayed, you don't have rights to change this trustee assignment. 
You must have the Access Control right to the file or directory.

5. Choose "OK."
You return to the Browser. The new trustee assignment is now effective for this object.



Add a Volume to the Volume List
Note: The "Rights to Files and Directories" dialog lists Volumes on which this object is a trustee. Being on
this list does not affect the Volumes.
1. Choose "Add."
2. Select Volume objects that you want listed in the "Rights to Files and Directories" dialog.

You can view or change trustee assignments only to files and directories located on Volumes listed 
here.

3. Choose "OK."
The Volumes you selected are added to the "Volumes" list.



Remove a Volume from the Volume List
Note: The "Rights to Files and Directories" dialog lists Volumes on which this object is a trustee. Being on
this list does not affect the Volumes.
1. Select a Volume from the list at the top of the dialog.
2. Choose "Hide."

The Volume is removed from the list.



View this Object's Effective Rights to a Directory or File
1. Select a file or directory in the "Files and Directories" list.

Note: If you have multiple Browser windows open, the Volume name shown for this file may not be 
the one that you selected it from. This has no affect on operation, as the same physical file is simply 
being viewed from different objects or views.

2. Choose "Effective rights..."
This object's effective rights to the object you selected are shown below the "Object name" field.
Effective rights are bold; non-effective rights are grayed.
Choose a property from the list to see effective rights to specific properties.

3. Choose "Close."
Note: If you have made changes to this dialog, they will not be reflected in "Effective Rights" until you 
exit this dialog with "OK." When you return to this dialog, any previous changes are reflected in 
"Effective Rights."

Related topics
More about Effective Rights



Add or Delete Values

To add a value
1. Choose "Add."
2. Enter a value.

2a. If the property that you are adding a value to requires an object as a value, select an object.
2b. If the property that you are adding a value to requires text or a number as a value, enter text .

3. Choose "OK."
The value is added to the list.

To delete a value
1. Select the value that you want to delete from the box above the buttons in this dialog.
2. Choose "Delete."

The value is removed from the list.
Screen regions and buttons

"Add" lets you add values.

"Delete" lets you delete values.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Select an Object

To choose an object
1. Choose objects from the right-side list box below "Directory Context" to move through the Directory 

tree until the desired object is shown on the left side of the dialog.
Use the right side to browse up and down the Directory tree. The up-arrow key moves back up the 
Directory tree.

2. Select the object you want from the left-side list box once it shown.
Only certain classes of objects are listed here for you to select, depending on the active field in the 
previous dialog. 

3. Choose "OK."
The object that you selected is entered into the active field in the previous dialog.

Screen regions and buttons
"Selected Object" shows the object that you have selected from the left-side list box.

"Current Context" shows where you are in the Directory tree (the position in the Directory tree of the 
object that you are working with at the moment).

"Name Filter" allows you to limit the objects that appear in the left-side list box by using wildcard 
characters or object names. For example, if you wanted only objects that start with the letter P to 
appear in the left-side list box, you could type P* in this field. If you wanted only an object named 
Computer1 to appear in the left-side list box, you would type Computer1 in this field.

"Directory Context Filter" allows you to limit the containers that appear in the right-side list box by 
using wildcard characters or container names. For example, if you wanted only containers that 
start with the letter N to appear in the right-side list box, you could type N* in this field. If you 
wanted only a container named OrgUnitA to appear in the right-side list box, you would type 
OrgUnitA in this field.

"Object" shows the objects that you can select. Only certain types of objects are listed here, 
depending on the dialog you are entering information for. Choose the desired object to select it 
and return to the previous dialog. A maximum of 4,600 objects can be listed.

"Directory Context" shows objects at the next level down the Directory tree. Choose an object to open
it and display its contents in the left-side list box. The up-arrow key moves back up the Directory 
tree. A maximum of 8,192 objects can be listed.

"Change Context" allows you to enter a new context to begin searching for an object in, without using 
the "Directory Context" list to browse all over the Directory tree.

"OK" returns to the previous dialog, inserting the object that you have selected in the active field. You 
must select an object in the "Objects" list before "OK" is available.

"Cancel" returns to the previous dialog without any object selected.



Select One or More Objects

To choose an object
1. Choose (double-click) objects from the right-side list under "Directory Context" to move through the 

Directory tree until the desired object is shown on the left side of the dialog.
Use the right side to browse up and down the Directory tree. The up-arrow moves back up the 
Directory tree.

2. Select the object you want from the "Object" list box.
Only certain classes of objects are listed here for you to select, depending on the active field in the 
previous dialog.
To select multiple objects that are next to each other in the list, hold down the <Shift> key as you 
select objects. To select multiple objects that are not next to each other in the list, hold down the 
<Ctrl> key as you select objects.

3. Choose "OK."
The object that you selected is entered into the active field in the previous dialog.

Screen regions and buttons
"Selected Object" shows the objects that you have opened to reach the list of objects in the "Objects" 

list.

"Current Context" shows where you are in the Directory tree (the position in the Directory tree of the 
object that you are working with at the moment).

"Object" shows the objects that you can select. Only certain types of objects are listed here, 
depending on the dialog you are entering information for. Choose the desired object to select it 
and return to the previous dialog. A maximum of 4,600 objects can be listed.

"Directory Context" shows objects at the next level down the Directory tree. Choose an object to open
it and display its contents in the "Objects" list. The up-arrow key moves back up the Directory 
tree. A maximum of 8,192 objects can be listed.

"Change Context" allows you to enter a new context to begin searching for an object without using the
"Directory Context" list to browse up and down the Directory tree.

"OK" returns to the previous dialog, inserting the object that you have selected in the active field. You 
must select an object in the "Objects" list before "OK" is available.

"Cancel" returns to the previous dialog without any object selected.



Change Context to Select an Object
This dialog allows you to change the context that you are viewing in this dialog.
By changing your context, you can view other parts of the Directory tree that you have rights to browse, 
without being blocked by upper areas of the Directory tree that you do not have rights to browse.



Select an Object from a Bindery
Use this dialog to select an object that exists in the bindery of a NetWare v3.x server. This allows you to 
do limited management tasks on NetWare v3.x servers, such as changing the owner of a file, or making 
trustee assignments to a file or directory.
To select an object from a bindery
1. Select the User or Group from the list shown.
2. Choose "OK."

The object that you selected is shown in the field that you were in before entering this dialog.



Enter a Property Value

To enter a value for a property
1. Type the value that you want to add to the property field.

You can only enter one item in this dialog. Any characters can be used, up to 64 characters.
2. Choose "OK."

The value appears in the "Selected property" field.



Set a Network Address
The "Network Addresses" page shows the address of the object you selected in all network protocols 
through which it can be accessed. These addresses tell NetWare Directory Services how to locate the 
physical object, depending on which protocol is being used. For example, you can
- See the address of the object (for different protocols)
- Add or delete addresses
Note: There is also a "Network Address Restrictions" page that lists network addresses that a User is 
allowed to log in from.
Because many different protocols can be active on the network at one time, an object can have an 
address for each protocol.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add a Network Address
Delete a Network Address

Screen regions and buttons
"Network Protocol" lists the protocol for the new address. Complete the fields in the dialog with values

appropriate for the protocol you use.

"Add..." lets you add another network address to the "Network Addresses" list.

"Delete" removes the selected network address from the "Network Addresses" list.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Add a Network Address
1. Choose the protocol of the address by choosing a protocol button.
2. Choose "Add..."
3. Fill in all fields for the new address.
4. Choose "OK" on the dialog for the protocol that you selected.

The new network address is added to the "Network addresses" list.



Delete a Network Address
1. Select a network address from the "Network Addresses" list.
2. Choose "Delete."

The network address is deleted from the list. The object can no longer be found at that address. If that
was the only address using a certain protocol, then no one using that protocol can find the object.



IPX SPX Protocol Dialog
Enter a value for each field shown here to define a network address in this protocol. See your hardware 
documentation for more information on each field if necessary.

The "Network" number is assigned arbitrarily to a cable segment when the network is set up.

The "Node" number is unique to each computer, and is determined by the network board in the 
computer. For Ethernet boards, the number is set at the factory; for Token-Ring and ArcNet 
boards, the number can be selected by jumpers on the board.



SDLC Protocol Dialog
Enter a value for each field shown here to define a network address in this protocol. See your hardware 
documentation for more information on each field if necessary.
SDLC stands for Synchronous Data Link Control. It is a protocol used to receive from or transmit data to 
SNA networks (Systems Network Architecture).



Token Ring and Ethernet Protocol Dialog
Enter a value for each field shown here to define a network address in this protocol. See your hardware 
documentation for more information on each field if necessary.



TCP/IP Protocol Dialog
Enter a value for each field shown here to define a network address in this protocol. See your hardware 
documentation for more information on each field if necessary.
TCP/IP stands for Transmission Control Protocol/Internet Protocol. An address consists of four one-byte 
numbers. The left part tells which part of the network the computer is on. The right part tells which 
computer is referred to.



OSI Protocol Dialog
Enter a value for each field shown here to define a network address in this protocol. See your hardware 
documentation for more information on each field if necessary.
OSI stands for Open Systems Interconnection. It is a higher-level protocol used with TCP/IP.



AppleTalk Protocol Dialog
Enter a value for each field shown here to define a network address in this protocol. See your hardware 
documentation for more information on each field if necessary.



Clear Button
Choose "Clear" to make all rights above the "Clear" button undefined. This means that none of these 
rights are explicitly granted to this trustee, but rights to this object can still be inherited.
Note: You are deleting an entry from the ACL property.
All check boxes in front of the rights become grayed.
Example: You don't want this user to have explicit object rights anymore, so you choose "Clear" under 
the list of object rights. All boxes become grayed.



Using the See Also Page
The "See Also" page gives you a place to list the names of objects that are related to the object you 
selected. A supervisor or manager can use it to record information about this object.
Note: This list is for your reference only. NetWare does not access this information.
You can list the complete name of related objects. You cannot enter text to describe the relationship of 
other objects to this object. For example, you can
- See which objects are listed as having information related to the selected object
- Add objects to or delete objects from the list
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog Box
Add a New Object to the "See Also" Page
Delete an Existing from the "See Also" Page

Screen regions and buttons
"See Also" lists the names of related objects.

"Add" opens a dialog where you choose an object to add to this list.

"Delete" removes the selected object from the list.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Add a New Object to the "See Also" Page
1 Choose "Add..."
2. Select objects that you want to add to the "See Also" page.
3. Choose "OK."

The objects you selected are added to the page.



Delete an Object from the "See Also" Page
1. Select the object that you want to delete from the "See Also" list.
2. Choose "Delete."

The object is deleted from the list.
3. Choose "OK" to return to the Browser.



View or Change the List of Operators
Use the "Operators" page to record operators of an object. For example, you can
- See which objects are listed as operators
- Add objects to or delete objects from the list of operators
Note: This list is for your reference only and doesn't affect who can use the object. Some utilities may use
this list to validate who can access statistical information about a NetWare server.
A supervisor or manager can use it to record information about this object.
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Add a New Operator
Delete an Operator

Screen regions and buttons
"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Add a New Operator
1. Choose "Add..."
2. Select select objects that you want to add as operators.
3. Choose "OK."

The objects you selected are listed as operators.



Delete an Operator
1. Select an operator from the "Operators" list.
2. Choose "Delete."

The operator is removed from the list.
3. Choose "OK" to return to the Browser.



Set Address Information
The "Address" page shows the postal address of the object you selected. For example, you can
- See the address of this object
- Set the mailing address to match the address in the object's container with "Copy to Label"
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.
You can search on individual fields in the top half of the page. The bottom half cannot be searched.

Procedures
How to Use the Object Dialog

Screen regions and buttons
"Copy to Label" applies the information entered at the top of the dialog to the bottom part of the 

dialog.

"Street address" contains the number and street name.

"Post office box" contains the post office box for this object.

"City" shows for the name of the town.

"State or province" shows the state or province that this object is located in.

"Postal (Zip) code" (for USA) is where you enter the zip code. For other countries, enter the 
appropriate information.

"Copy to Label" copies the information entered at the top into the fields in the "Postal Address" area.

"Postal Address" contains fields that can be edited (but not searched). This area can be customized 
for mailing labels.

Note: If you enter Street address and Post office box information in the fields at the top of the page, 
only the Post office box information will appear in the bottom section in Postal Address.
"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.



Create or Change a Login Script
Use the "Login Script" page to specify commands that automatically execute when a user logs in. For 
example, you can
- Add a drive mapping to a login script
- Add a command to run a program automatically when the user logs in
Important: "OK" and "Cancel" affect the entire Object dialog, not just this page. Do not choose "OK" until 
you've entered all changes you need to this page and other pages. If you choose "Cancel" you will lose all
changes in every page of this dialog.

Procedures
How to Use the Object Dialog
Edit a Login Script
Copy a Login Script from another Location
Determine What Scripts Will Be Executed at Login

Screen regions and buttons
"Edit box" is where you view of change the login script.

"OK" saves changes in all pages of this dialog.

"Cancel" closes this dialog without saving changes in any page.

Related topics
Login Script Syntax and Commands



Determine What Scripts Will Be Executed at Login
Use the following list to determine which scripts will be executed when a User logs in to NetWare 
Directory Services.
1. Is there a login script entered in the container immediately above the User object?

If so, it is executed first.
2. Is there a Profile object listed for the User? (see the Login Script page of the User's object dialog).

If so, the script in the Profile object is executed next.
3. Is there a login script entered for the User?

If so, it is executed third.
4. If none of these scripts exists, a default login script is used to map a drive to the \PUBLIC directory so

that this User can use NetWare utilities.



Login Script Syntax and Commands
Each login script command must be written on its own line. Blank lines are ignored. This list shows 
commonly used login script commands. There are other commands described in "Supervising the 
Network."

Commands
# Executes an external command and returns to the next line of the login script.

Example: #DIR

ATTACH Connects to a NetWare Server in a different Directory tree. 
Example: ATTACH Acctserver/John

BREAK [on l off] Allows the use of <Ctrl><Break> or <Ctrl><C> to stop the login script. Default is OFF.
Example: BREAK ON

CLS Clears the display screen.
Example: CLS

CONTEXT Changes to a specified context.
Example: CONTEXT users.sales

DISPLAY filename Displays a text file to the display screen.
Example: DISPLAY NOTICE.TXT

DRIVE Specifies the default drive.
Example: DRIVE F:

EXIT (filename) Terminates execution of a login script.
Example: EXIT "Menu Account"

FDISPLAY Filters out control characters and display only ASCII character values 1 to 126.
Example: FDISPLAY README.DOC

FIRE PHASERS Makes a sound to alert you to certain conditions.
Example: FIRE PHASERS 3 times

GOTO label Skips part of the script and jump to another label. Usually used with an IF conditional.
Example: Loop:
Set X=<X>+ "1"
Write <X>
IF <X> is less than value "10"
GOTO loop

IF ... THEN Tests conditions to execute or skip parts of a login script.
Example: IF day_of_week="friday" THEN
Write "It's the Weekend!"

END

INCLUDE Executes another file of login script commands before continuing with this login script.
Example: INCLUDE sys:public\script.fil

MACHINE Sets the machine name in the DOS environment.
Example: MACHINE = "IBM_PC"

MAP Sets drive mappings during login using a Volume or Directory Map object.
Example: MAP g:=.SALES_Vol.Novell:Apps\WP



PAUSE Temporarily stops the login script.
Example: IF hour24="23" then PAUSE

REMARK Puts comments in the login script or prevents commands from being executed.
Example: REM temporary drive mapping, delete 10/93

SET name = "value" Set or change DOS or OS/2 environment variables.
Example: SET prompt = "$p$g"

SET TIME [ON l OFF] Synchronize a workstation with the servers (SET TIME ON). SET TIME ON is the 
default.

Example: SET TIME OFF

WRITE Print messages to the screen.
Example: WRITE "Hello World"



Defining Additional Properties
In the "Create" dialog, you enter only enough information to name the object. 
Choose "Define additional properties" to enter values for other properties associated with the object.

To define additional properties
1. In the "Create" dialog, select "Define additional properties."
2. Choose "Create."
3. Enter needed information in the various pages of the object dialog.
4. Choose "OK."

The new object appears in the Browser.
Note: You can change an object's property values by opening the object's dialog and making 
changes.



Opening an Object Dialog
There are several ways to open an object's dialog.
- Double-click on the object (leaf objects only).

Double-clicking on a container object displays the objects it holds.
- Right-click the mouse on the object and select "Details" from the menu that appears.
- Single-click the object and choose "Details" from the "Object" menu.
- When creating a new object in the "Create" dialog, select "Define additional properties" and choose 

"Create."
Related topics

How to Use the Object Dialog



Effective Rights to an Object
Effective rights are the rights that an object can use to access information about another object.
In this diagram, if User ESMITH wants to access Profile MANAGERS, User ESMITH's effective rights to 
do so can come from several places:

 
- Trustee assignments on Profile MANAGERS that list User ESMITH (explicit rights are granted)
- Trustee assignments on Profile MANAGERS that list Organizational Unit SALES PV (inherited from 

trustee's container)
Trustee assignments on Org. Unit SALES LA    that list User ESMITH; rights must pass through Profile
MANAGERS' Inherited Rights Filter before becoming effective (inherited from object's container)

- Trustee assignments on Org. Unit SALES LA    that list Org. Unit SALES PV; rights must pass through
Profile MANAGERS' Inherited Rights Filter before becoming effective (inherited from object's 
container and trustee's container)

- Trustee assignments to any object listed in the Security equivalences list of User ESMITH, such as a 
Group object (only valid when the object requesting rights is a User object)

Note: Every object is security equivalent to all objects in its complete name, that is, all of the objects 
directly above it to the root of the Directory tree. This security equivalence cannot be changed, but none 
of those objects are listed in the "Security Equivalences" list.
If User ESMITH has a trustee assignment to Organizational Unit SALES LA    and to Profile MANAGERS, 
the Trustee assignment on Profile MANAGERS overrides the trustee assignment on Organizational Unit 
SALES LA. Trustee assignments to Group, however, are added to previous trustee assignment for user 
objects.
You cannot change effective rights directly. You must locate the trustee assignments where the rights 
were granted and change it, or add an Inherited Rights Filter to block rights.
If you selected one trustee before choosing the Effective Rights button, the effective rights of that trustee 

will be displayed. Otherwise, you can use the Browser button to the right of the "Name" field     to 
choose whose effective rights you want to view.
You must have the Write or Supervisor property right to an object's ACL property to view other object's 
effective rights to the object.
Note: If you have made changes anywhere in the Trustees dialog, those changes will not be reflected in 
the "Effective Rights" dialog until you exit the "Trustees" dialog with "OK." When you return to the 
"Trustees" dialog, any previous changes are reflected in the effective rights of an object.



Effective Rights Paths to an Object
Effective rights are the rights that an object can actually use to access information about another object. 
Effective rights are determined each time one object tries to access another object.
In this diagram, User ESMITH's effective rights to Profile MANAGERS can come from several places:

 
- Trustee assignments on Profile MANAGERS that list User ESMITH (explicit rights are granted)
- Trustee assignments on Profile MANAGERS that list Organizational Unit SALES PV (rights are 

inherited from trustee's container)
- Trustee assignments on Organizational Unit SALES LA    that list User ESMITH; rights must pass 

through Profile MANAGERS' Inherited Rights Filter before becoming effective (rights are inherited 
from object's container)

- Trustee assignments on Organizational Unit SALES LA    that list Organizational Unit SALES PV; 
rights must pass through Profile MANAGERS' Inherited Rights Filter before becoming effective (rights
are inherited from object's container and trustee's container)

- Trustee assignments to any object listed in the Security equivalences list of User ESMITH, such as a 
Group object (valid only when the object requesting rights is a User object)

Note: Every object is security equivalent to all of the objects in its complete name, that is, all of the 
objects directly above it to the root of the Directory tree. This security equivalence cannot be changed, but
none of those objects are listed in the "Security Equivalences" list.
If User ESMITH has a trustee assignment to Organizational Unit SALES LA    and to Profile MANAGERS, 
the Trustee assignment on Profile MANAGERS overrides the trustee assignment on Organizational Unit 
SALES LA. Trustee assignments to Groups, however, are added to previous trustee assignment for User 
objects.
You cannot change effective rights directly. You must locate the trustee assignments where the right was 
granted and change it, or add an Inherited Rights Filter to block rights.
If you select one trustee before choosing "Effective Rights," the effective rights of that trustee will be 

displayed. Otherwise, you can use the Browser button to the right of the "Name" field  to choose the 
object whose effective rights you want to view.
You need the Write or Supervisor property right to an object's ACL property to view other object's effective
rights to the object.
Note: If you have made changes anywhere in the "Trustees" dialog, those changes will not be reflected in
the "Effective Rights" dialog until you exit the "Trustees" dialog with "OK." When you return to the 
"Trustees" dialog, any previous changes are reflected in the effective rights of an object.



Inherited Rights Filter
An Inherited Rights Filter blocks rights that would otherwise be inherited by objects who had rights 
granted higher in the Directory tree. In other words, the Inherited Rights Filter filters out the rights that 
other objects have on you, not the rights that you have on other objects.
The rights that you have because you are in a container are because you are security equivalent to that 
container and not because you inherit rights from that container.
Note: The Inherited Rights Filter cannot give rights to anyone; it can only take rights away from a User or 
Group that has more rights than you want it to have.

 
If User ESMITH has a trustee assignment to Org. Unit SALES LA, User ESMITH also inherits rights to 
Profile MANAGERS. Those rights can be blocked by an Inherited Rights Filter on Profile MANAGERS.
If User ESMITH also has a trustee assignment to Profile MANAGERS, then that trustee assignment 
grants User ESMITH certain rights which are not affected by the Inherited Rights Filter for Profile 
MANAGERS.
If a check box in the Inherited Rights Filter dialog for Profile MANAGERS is selected, User ESMITH can 
inherit that right. If a check box is not selected, User ESMITH or Organizational Unit SALES PV must 
have a trustee assignment to Profile MANAGERS.
An Inherited Rights Filter can block any of the trustee assignment rights, including rights for specific 
properties.
Object rights and Property rights are inherited separately. An Inherited Rights Filter can block certain 
property rights without affecting any object rights.
Note: For objects in NetWare Directory Services, the Supervisor object right can be blocked by the 
Inherited Rights Filter. For directories and files, the Supervisor right cannot be blocked by the Inherited 
Rights Filter.



Effective Rights in Files and Directories
An    object's effective rights to a directory or file are the rights that they can actually use on the directory 
or file.
Effective rights are determined each time someone tries to access a directory or file. They are determined
by:
- Trustee assignments to the directory or file
- Inherited rights from trustee assignments to a parent directory
- Trustee assignments to objects listed in a User's security equivalences list, such as Group objects.
Any rights granted to a trustee for a directory above this directory or file must pass through the Inherited 
Rights Filter before becoming part of the effective rights.
Note: If a user has a trustee assignment to a directory that is higher in the directory structure as well as 
an assignment to this directory or file, the current trustee assignment overrides the previous one.
You cannot change effective rights directly. You must locate the trustee assignments where the rights 
were granted and change it, or add an Inherited Rights Filter to block some rights.
If you select a trustee before choosing "Effective Rights," the effective rights of that trustee will be 

displayed. Otherwise, you can use the Browser button to the right of the "Name" field  to choose 
which User's effective rights to this directory or file you want to view.
You must have the Access Control right to a directory or file to view other User's effective rights to it. 
However, if the directory or file is on a NetWare v2.x or v3.x NetWare volume, you can only see your own 
effective rights.
Note: If you have made changes anywhere in the "Trustees" dialog, those changes will not be reflected in
the "Effective Rights" dialog until you exit the "Trustees" dialog with "OK." When you return to the 
"Trustees" dialog, any previous changes are reflected in the effective rights of a User or Group.



Inherited Rights Filter for Files and Directories
An Inherited Rights Filter blocks rights that would otherwise be inherited by users who had rights granted 
by a trustee assignment higher in the directory structure.
If a User or Group has a trustee assignment to a directory or file, that assignment will override the 
Inherited Rights Filter on the same directory or file. But if a User or Group only has rights to a directory or 
file by inheriting rights from a directory higher in the directory structure, those rights can be blocked by the
Inherited Rights Filter.
An Inherited Rights Filter can block any of the rights that can be specified in a trustee assignment.
The Inherited Rights Filter cannot give rights to anyone, it can only take rights away from a User or Group
that has more rights than you want it to have.
If a check box in the Inherited Rights Filter dialog is selected, Users can inherit that right for this directory 
or file. If the check box is not selected, only Users and Groups with a trustee assignment on this directory 
or file are allowed to have that right.
Note: For directories and files, the Supervisor right cannot be blocked by the Inherited Rights Filter. For 
other objects, the Supervisor object right can be blocked by the Inherited Rights Filter.
Example: Users in Group SALES have Create and Erase rights for your PROJECTS directory; however, 
you don't want anyone to have rights to the JANUARY subdirectory under PROJECTS. Create an 
Inherited Rights Filter for JANUARY that doesn't have any check boxes selected. Rights given for 
PROJECTS cannot be inherited by JANUARY (except the Supervisor right). The Inherited Rights Filter 
blocks all rights that are not given to trustees of JANUARY.



Trustees of this Object and Rights to Other Objects
You can view both NetWare Directory Services objects and file system files and directories. This means 
that you sometimes view object and property rights, and other times view file/directory rights, and the 
attributes of files or directories.
You can use several access control and security features:
- Select an object and choose "Trustees of this Object" from the "Object" menu. You can see trustees 

of the object you selected, its object and property rights, and view and change its Inherited Rights 
Filter.

- Select an object and choose "Rights to Other Objects" from the "Object" menu. You see where the 
object you selected has a trustee assignment. You also see object and property rights that this object 
has to other objects. You can't change the Inherited Rights Filter here.

- Select an object and choose "Details" from the "Object" menu. Select the "Rights to File System" 
page in the object dialog. You see which files and directories the object has rights to (by a trustee 
assignment). You see file and directory rights.

- Select a file or directory in a volume and choose "Details" from the "Object" menu. Then select the 
"Trustees of this file or directory" page in the object dialog. The objects that have rights granted to the 
file or directory through a trustee assignment are listed. You see file and directory rights. You can also
view and change the file or directory's Inherited Rights Filter.

- Volume is a NetWare Directory Services object that allows you to work with the file system as well. If 
you select a Volume and choose "Trustees of this Object" from the "Object" menu, you see a 
"Trustees" dialog showing who has rights to see or change the Volume object. Object and Property 
rights are shown. If you select a Volume and choose "Details" from the "Object" menu and then the 
"Trustees of the Root Directory" page, you see the file and directory rights that apply to the first level 
of directories on that volume. File and directory rights are shown.



Trustees of the Root Object
Certain rules control trustees of the root object (the object above the highest Country or Organization 
object) in the Directory tree.
- When the Directory tree is created, User ADMIN is given the Supervisor object right to the root object.

You can change the name of User ADMIN, and User ADMIN can grant the Supervisor object right to 
the root object to other objects.

- At least one User must be a trustee of the root object with the Supervisor object right. If only one 
trustee of the root object has the Supervisor object right, you cannot delete that trustee from the 
"Trustees" list, and you cannot remove the Supervisor object right for that trustee.
Because the Supervisor object right can be blocked by the Inherited Rights Filter on objects below the
root object, if you could remove the Supervisor object right from the last trustee, you would cut 
yourself off from part of the Directory tree.
The NetWare Administrator prevents you from deleting the last trustee with Supervisor object right or 
changing the Inherited Rights Filter when there is no Supervisor. But you could still delete the User 
that is listed as a trustee with Supervisor object right. Then no one would have the Supervisor object 
right to part of the Directory tree. 
Important: Keep track of the Users that have Supervisor object right at the root of the Directory tree 
or at container objects in the tree so that you do not cut yourself off from any valuable information.



The Root Object in the Directory Tree
The root object of the Directory tree contains no information. Its purpose is to
- Provide the highest point to access different Country and Organization objects
- Allow trustee assignments granting rights to the entire Directory tree



User Object ADMIN
The User ADMIN is created when you create the Directory tree. ADMIN is granted a trustee assignment to
the root object of the Directory tree with the Supervisor object right. This allows a network administrator to
log in to the network as ADMIN, and have sufficient rights to set up the rest of the network.
Once the network has been set up and other objects (including users) have been created, ADMIN should 
grant a trustee assignment to the user chosen to supervise the entire Directory tree. After another user 
has the Supervisor object right to the root object, consider deleting the User object ADMIN.
ADMIN only has rights granted by trustee assignments. Logging in as ADMIN does not grant access to 
everything, like User SUPERVISOR had in previous versions of NetWare.



The Root Directory of a Volume    -    Assigning Rights
The File and Directory rights for the root directory of each volume are recorded in each volume object. 
These are separate from the Object and Property rights that control access to the Volume object.
When a NetWare Server and its volumes are installed, the User installing the server and its volumes is 
granted the Supervisor object right to the NetWare Server object. This grants that User supervisor-level 
access to the file systems of all volumes attached to that server. As in previous versions of NetWare, the 
supervisor right on files and directories cannot be blocked by an Inherited Rights Filter.
The trustee who installed the NetWare Server and volumes must make other trustee assignments to the 
directories and files, using the FILER or NetWare Administrator utilities. 



Public as a Trustee
PUBLIC can be listed in the Trustees list of any object to indicate the rights that any object requesting 
access receives if no other rights are effective.
A person can use all of the rights granted to PUBLIC before logging in. Because of this, no audit trail is 
created. Restrict the use of PUBLIC as a trustee to non-secure areas.
You can add PUBLIC as a trustee whenever you are defining an object's or file's trustees. You can also 
delete PUBLIC as a trustee of any object or file.
PUBLIC is granted the Browse object right to the root object when NetWare v4.0 is installed. This allows 
all objects to see all other objects until other trustee assignments or Inherited Rights Filters are put in 
place by a network administrator.



Supervisor Object Right Restrictions
The Supervisor object right allows unlimited access to an object. Because a Directory tree can span many
divisions or organizations, the Supervisor object right can be blocked from part of the tree by the Inherited
Rights Filter.
If the Supervisor object right is blocked at a container object with an Inherited Rights Filter and no other 
object has the Supervisor object right to that object, you can lose access to part of the tree.
The NETADMIN and NetWare Administrator utilities prevent this problem by restricting when you can 
grant or remove the Supervisor object right.
- You can't create an Inherited Rights Filter that blocks the Supervisor object right or adds the 

Supervisor object right to an existing Inherited Rights Filter if a trustee doesn't already exist on that 
object with the Supervisor object right.

- You can't delete the last trustee of an object with the Supervisor object right or remove the Supervisor
object right for that trustee if the Inherited Rights Filter of that object blocks the Supervisor object 
right.



Inheriting Object Rights    -    Inheriting Property Rights
Object rights and All property rights are inherited separately. Specific property rights are not inherited 
(because different object classes have different properties).
An object's effective object rights to a container object flow down to objects below. An object's effective All
property rights to a container object flow down to objects below. Once the effective object rights and the 
effective All property rights are determined for a leaf object, they are combined to determine the total 
effective rights to the object. 



Select Multiple Objects or Trustees
To select more than one object at the same time, hold down the <Shift> key (to select from a previous 
selection to the current position) or the <Ctrl> key, (to select only the additional object at the current 
position) while selecting objects.
If you select more than one object at once, the changes you make affect this object's rights to all selected 
objects.






